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Section 1 Notes about this User Manual 

 Example of a Fully Configured Workspace 

In this section you will find a typical Workspace screen for a Superintendent as configured during the 

implementation process.  This workspace contains dashboards, saved searches, and favorites which make 

navigation and access to the data simple and effective for the Superintendent. 

 

This Superintendent’s workspace is divided into multiple panes which are described below: 

1. Message – Inbox contains internal NS Enterprise messages set by other users to the buyer.  These 

messages can be opened, and the associate documents accessed and subsequently processed directly 

from the message. 

2. Favorites contains direct links to various task that the buyer does on a repetitive basis some examples 

are Search Standard Jobs, Create Purchase Orders, and Search Work Orders.  These provide the 

Superintendent with a one-click ability to conduct searches and create documents without using the 

system menus.  Users can utilize a search criteria 'Reschedule Declined' on Work Order Search screen 

to filter out the Work Orders whose reschedule requests were declined. 

3. Saved Searches provide a direct link to documents in various stages of the purchasing and maintenance 

processes.  In this example the Superintendent would get lists of various documents in the stages that 

may require the attention of a Superintendent for example Outstanding Requisitions and Projects to be 

approved.  This allows the user to enter the workflow at any point in the process and process the 

documents quickly, so they can move to the next process step. 
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4. Critical Spares below Policy Level dashboard gives the Superintendent an overview of the number of 

spaces for each vessel in the fleet that are below the required inventory level and allows the user to drill 

down to get a list of the spares.  From the list the Superintendent may proceed to create requisitions for 

replenishment to correct inventory levels. 

5. Overdue Jobs by Type dashboard is a bar chart that shows the number of overdue maintenance jobs 

by vessel and is subdivided by job type.  Superintendent can click to get a list of the overdue job lists 

for each vessel and take actions appropriate to bring the vessels up to date. 

6. Open Corrective Actions by Status dashboard provides the Superintendent with a view of the 

corrective actions created in the HQSE module that remain in a status that needs further processing.  

The Superintendent can drill down to a list and then process or assign the Corrective Action processing 

as tasks for other users. 

7. PM Work Orders Pending Defer Request Approval dashboard allows the Superintendent to see how 

many PM work order deferral requests are pending approval by vessel.  Through this dashboard the 

Superintendent can get a list and process the approvals directly as appropriate. 

8. Requisitions Outstanding by Ship dashboard provide the Superintendent with a single click list of the 

requisitions that have not been fulfilled for the vessel in the Superintendent’s fleet.  From the list action 

can be taken to ensure the purchasing process moves forward to provide needed materials and services 

onboard. 

9. Tasks dashboard provides a list of documents assigned to the logged-in user.  Users can open a 

document and take the necessary action.  Documents may have multiple approvers in a chain, but it is 

assigned to only one user at a given time.  Task list includes: 

• RFQ(s) to be approved. 

• Purchase Order(s) to be approved 

• JSA(s) to be approved 

• Work Order(s) deferral requests to be approved 

• Ship screen – Inventory Tab 

o Users can add location(s) and required inventory to be recorded along with the interval the 

task will be completed.   The task will show up on the NS mobile app task list for the crew 

to complete.  

o Configuration required on the Ship Details Screen to add the Equipment for which running 

hours will be captured as part of a task, along with the requested interval (example, weekly).     

The task will show up on the NS mobile app task list for the crew to complete 
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GENERAL NOTES:     

NS Maintenance Search List Windows 

• If any document is edited, the document is marked with a Red color to indicate that it has been edited. 

• If any document is edited and that document screen is closed, the row for that document will remain 

highlighted. 

• The edited documents indicator will be reset on Search button click. 

  

Adding File Attachments  

• Users can use a drag and drop functionality on any of the File Attachment Tabs. 

 

 

Messages 

• If the message was sent to multiple users, the message window has a “Reply to All” option. 
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Section 2 Introduction 

The two main concepts in maintenance are planned and corrective maintenance.  

Planned maintenance can be scheduled in consideration of calendar dates or accumulation of running hours. By 

using NS Enterprise, sea staff can consolidate all the planning and record-keeping related to planned 

maintenance with all interrelated information linked and accessible. 

Corrective maintenance can be considered repairs. NS Enterprise provides the ability to schedule and record 

information related to corrective maintenance. More importantly, it provides a mechanism to record and analyze 

failures at both the vessel and fleet levels to make informed decisions about maintenance intervals and 

equipment manufacturers, as well as vessel and process design. 

Event based maintenance consists of standard jobs that are neither calendar nor counter based, but must be 

carried out when certain operations occur, such as port calls.   
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The maintenance module records, schedules, and manages the data pertaining to the work performed on a vessel 

by the crew or outside contractors. It includes maintenance management facilities to handle: 

• Order processing  

• Maintenance plans  

• Projects and claims  

• Planned and unplanned maintenance events  

• Maintenance history  

• Contractors  

• Cost analysis 

• Preventive maintenance standard job processing 

• Machinery running hour tracking  

• Reliability Centered Maintenance 

• Condition Based Monitoring 

• Serialized Inventory 

• Landing Orders 

 

The hierarchy system used by NS Enterprise is an organized way to view and categorize equipment and parts. 

Creating the hierarchy by setting up the equipment and parts is covered in the Hierarchy section of this manual. 

Equipment and parts can be created in NS Enterprise from the fleet level or the ship level. 
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 Repairs 
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 Standard Jobs 

 Overview 

NS uses the Standard Job for planned maintenance. Each Standard Job behaves just like a pop-up reminder in 

a calendar.   When considered collectively at ship level, the Standard Jobs are the maintenance plan.   

Maintenance plan philosophy may vary some between managing companies but plans typically will be on a 

five-year repeating cycle.   

There are three primary sources for Standard Jobs, The ship’s Survey Status Report, the equipment 

manufacturer’s recommendations, and the technical department of the managing company.  When developing 

a maintenance plan, it is good practice to load level the effort reacquired over the five years by avoiding periods 

with fluctuating levels of effort.  The level of effort should be designed to be as constant as possible month to 

month.  And keep in mind a straight job count does not determine the level of effort.   

 

A standard job is composed of several elements: 

• A job description 

• A maintenance interval, either calendar or counter based 

• A job size (is a category used to describe machinery jobs using a Job Size Index and Job Size indicator.) 
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The standard job has resources defined (who should perform the work), materials required, and various other 

information connected. Ships are not authorized to create standard jobs, but an understanding of the philosophy 

behind them will help maintain the vessel. 

The standard job is linked to equipment and appears in the maintenance schedule.  Users can create a work 

order based on the standard job and record the maintenance performed. The work order is connected to the 

maintenance history of both the equipment and the standard job. 

 Creating/Edit Standard Jobs 

There are seven (7) different types of Standard Jobs: 

1. Machinery Jobs 

These jobs are based on the ship’s-maintained machinery equipment contained on the ship’s 

hierarchy. The machinery equipment PM standard job combines the equipment name with an index 

term indicating the job size. The job schedule is based on either a calendar or running hour interval. 

2. Spaces Jobs 

Spaces on the ship that are listed in the classification society and other regulatory body requirements 

need to be maintained. These spaces include cargo holds, service tanks and cabins. A standard job is 

created to perform this maintenance. The standard job name is a combination of the space name and 

an index term indicating the job size. The job schedule can only be based on a calendar interval. 

3. Surveys/Certificates Jobs 

Regulatory requirements defined by organizations such as government agencies, coast guard and 

classification societies are another job type for standard jobs. These jobs are based on a survey index 

term and the job schedule can only be based on a calendar interval. 

4. Services Jobs 

These are services provided to the ship to facilitate other work. For example, dry-dock services such 

as compressed air, shore power, tugs, dry-dock days and others. The dry-dock services are a 

significant portion of the overall dry-dock cost. The job schedule can only be based on a calendar 

interval. 

5. Condition Monitoring Jobs 

These are jobs that monitor the condition of selected equipment according the condition monitoring 

types associated with the equipment. The job schedule is based on either a calendar or running hour 

interval. 

6. Miscellaneous Jobs 

This is work of a general nature such as painting, sandblasting or anode replacement that is not 

associated with a specifically identifiable item on the ship like a piece of equipment or space. 

However, miscellaneous work can be cross-referenced with multiple items such as equipment or 

space so that when the standard job is completed these areas are automatically updated with 

maintenance history. The job schedule can only be based on calendar interval. 
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 Structures Jobs 

Structures within compartments on the ship that are listed in the classification society and other regulatory body 

requirements need to be maintained. These structures include girders, brackets, and stiffeners. A standard job 

is created to perform this maintenance. The standard job name is a combination of the structure name and an 

index term indicating the job size. The job schedule can only be based on a calendar interval.   

 Corrective Maintenance 

Corrective maintenance is additional work performed to prevent / mitigate failures or breakdowns during 

operation; or when an unanticipated breakdown or failure occurs. Sometimes the work can be performed 

immediately; often it must wait for a suitable time or for a spare part to be received, or it might be outside of 

the resources of the crew. 

NS Enterprise uses the Work Order to capture what maintenance must be performed, what materials are 

required and allows crewmen to schedule the work at a suitable time. This will ensure that, despite changes in 

personnel and/or the passing of time, important work does not get lost or fall through the cracks. 
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 Service Contractors 

Some work must be done by service contractors. This may be due to specialized skill requirements, knowledge 

or equipment, regulatory requirements, for warranty service or for some other reason.  There are also surveys 

and inspections which must be carried out by certified individuals. 

NS Enterprise uses the service requisition to capture what maintenance must be performed and what materials 

are required.  It also allows crewmen to liaise with vendors, schedule the work and to record the findings for 

the maintenance history. 
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Section 3 ABS Survey Status 

The purpose of the NS Enterprise – ABS SafeNet/Freedom Survey Status Interface is to allow survey status 

information, which is recorded by ABS personnel in the Freedom Survey Status system, to be systematically 

available in the NS Enterprise Maintenance module.  In this way, the ship operator can obtain up-to-date and 

authoritative survey status information in an efficient and timely manner. 
 

The following types of data will be sent from the ABS Freedom Survey Status database to the NS Enterprise 

database:  The NS Enterprise Maintenance module is used to store and maintain: 

 

• Surveys 

• Class Item Inspections including Machinery, Structural, Hull and Outfitting 

• Certificates – Class, Statutory, ISM and DOC 

• Findings – Class Recommendations, Statutory Deficiencies, and ISM CARS 

o These are the condition of class items that must be fixed by a given Survey or a date. 

• Comments to Owner - These are typically the less-serious items that do not need to be fixed e.g., a dent.  In 

the ABS Freedom Survey Status system, these are known as “Comments to Owner”. 

 General Information 

In addition to giving the user access/authorizations for the tasks associated to ABS Survey Status and NS 

Enterprise systems, certain configurations are required for a successful synchronization of the two systems.   

 

The authorization Update ABS Survey Status at the ship level in the NS Enterprise application controls 

downloading ABS Survey Status. It enables one office to download the ABS Survey Status and propagate the 

changes to other offices via replication process. 

NOTE:    The process of authentication and authorization assumes that the NS Enterprise users requesting 

ABS Class information also has access to ABS Freedom. 

 

NS Enterprise users requesting ABS Class information will be required to enter the User ID/Password that was 

provided by ABS Freedom. This User ID/Password along with the Ship’s Class Number is sent to the ABS 

Survey Status Web Service module. ABS Survey Status Web Service module authenticates the user’s 

credentials. The authorization process involving accesses to a particular ship is also handled by the ABS Survey 

Status Web Service module. 

Clients may have a fleet classed by different class societies. The Class Society identified on the Ship record 

Admin Info Tab must also be flagged as a company type of “Class Society ABS”. 
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Although the various types of surveys, certificates and class item inspections listed are treated separately by the 

ABS Survey Status system, the NS Enterprise Maintenance module documents the task information as a 

Standard Job. 
 

 

The table below documents how the two systems map the Survey /Certificate /Class Item Inspection items: 

 ABS Survey Status/NS Enterprise Mapping 

 

Data 
ABS Survey Status ID (as 

present in the XML file) 

NS Enterprise Screen/field Name 

(Maintenance Module) 

Ship ABS Class Number Ship screen of Maintenance module 

Survey Survey Type ID Survey/Cert. Standard Job screen 
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Data 
ABS Survey Status ID (as 

present in the XML file) 

NS Enterprise Screen/field Name 

(Maintenance Module) 

Class Item Inspection  Item ID + Inspection Type ID 
Standard Job screen of Maintenance 

module 

Certificate Certificate Type ID 
Survey/Cert. Standard Job screen of 

Maintenance module 

Findings Findings unique ID 
Findings are always attached to a Ship or 

an Item.  

Comments to Owner Comments unique ID 
Comments to Owner are attached to a 

Ship.  

 System Administration Module 

 

In the NS Enterprise application, System Administration module, an authorized user will click on 

Application Configuration→ABS Account Configuration to open the ABS Account Configuration 

window. 
 

 

1. Enter in the URL or path for each of the modules that support the ABS Survey Interface. 

2. Enter in the UserID and password to be used when running the Interface. 

3. Click the OK button to save the configuration. 

 Ship Record 

When logging into NS Enterprise, the default is set to open the application at the fleet level.  After logging 

into the application, click on the dropdown menu in the upper left-hand portion of the window to open the 

Available Ships window. 

 

 
 

1. Highlight the vessel name and click on the open folder icon on the tool bar menu to open the ship record. 
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2. On the Ship window verify or enter the information needed for synchronization on the Ship→Admin 

Info Tab. 

3. Enter in the Class Number for the Vessel. 

4. Select the Classification Society for the Vessel by clicking the dropdown menu at the end of the 

Classification Society field.  This opens the Classification Society window.  Enter in search criteria 

and click the Search button. 

5. Double click to select the company identified as a Classification Society to close the Classification 

Society search navigator and return to the Ship record. 

 

 

6. Choose the Synchronization Method Option B. 

 
7. Click the Save button to save any changes made to the Ship record. 
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 Maintenance Module 

Both tasks: the synchronization of the Fleet from ABS Survey Status software to NS Enterprise and utilizing 

the Survey Certificate Manager at ship level to view and process the list of survey data are completed in the 

NS Enterprise Maintenance module. 

Synchronize Fleet to NS Enterprise 

1. In the NS Enterprise application at fleet level, from the Maintenance module, click on Maintenance 

gadget→Class Information→Synchronize with ABS Surveys to open the Synchronize window. 

 

 
 

 

2. Click on the dropdown menu to open the Ship Fleet/Trade List window to select which fleet to 

synchronize with NS Enterprise.  Highlight the fleet and click the Select button to close the window 

and return to the Synchronize with ABS Surveys field. 
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3. Click the OK button to start the integration process for the selected fleet. 

4. While importing a fleet of vessels, a progress bar displays the Ship Name and downloading progress of 

“X” of “Y” ship(s). 

5. On completion of the import process, an exception report displays if any errors are present e.g., if the 

ABS unique identifier does not match any of the NS Enterprise Standard Jobs set up for the ship. 

6. This process is repeated if performing the synchronization for multiple fleets. 

7. Exception Report Format includes detailed information about the issue and the vessel name. 

 

Issue Ship Name 

  

 

Survey/Certificate Manager 

Once the synchronization (import) of the fleet has completed, the users can view the list using the 

Survey/Certificate Manager at the Ship level.   

 

In the NS Enterprise Application, at Ship Level→Maintenance and Purchasing Module→Maintenance 

gadget, click on the Class Information→ Survey/Certificate Manager to open the Survey/Certificate 

Manager window. 
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For those users who are classed through ABS, the Survey/Certificate Manager window in the NS Enterprise 

Maintenance module displays detailed survey information on the ship to include: 

 

▪ ABS Survey Planning Tab (Survey/Certificate Status color indicators, Job Title, Due Date, Date 

Range, Extended, Completion Date, Last visit Date, What type of Job (WO, SJ) and Document 

number) 

o Scheduled/Unscheduled/Complete Sub Tab 

o Incomplete Sub Tab 

o History Sub Tab 

▪ ABS Survey Findings Tab (all findings recorded by the attending surveyors) 

▪ ABS Survey Certificates Tab (certificates issued by ABS and viewable PDF links) 

▪ ABS Survey Timeline Tab (graphical display of the survey dates over time) 

▪ Other Survey Certificates Tab (editable list, for updating USCG certs.) 

For those users who are not classed through ABS, the Survey/Certificate window is slightly different as it 

contains the information depicted in the Other Surveys Certificate tab.  More details on the Other Surveys 

Certificate tab is covered in the next section. 
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 Survey/Certificate Manager Window 

At Ship level, to start processing the surveys, click on the Process menu option→Synchronize with ABS 

Surveys on the Survey/Certificate Manager window. 

ABS Survey Planning Tab 

The Scheduled/Unscheduled/Complete Sub Tab includes: 

• ABS list of surveys status scheduled, unscheduled, commenced, or complete 

• NS standard jobs assigned 

• Filter options (Show All instances, Scheduled with 3 options for Overdue, Unscheduled, Completed 

with 2 options for those pending review and those completed) 
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The ABS Survey Planning ➔ Incomplete Sub Tab includes those surveys where status has commenced but 

not yet completed. 
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The ABS Survey Planning ➔ History Sub Tab includes a list of completed surveys. 

 
 

ABS Survey Findings Tab 

The ABS Survey Findings tab displays all the findings found during the survey.  It also has filter options by 

Status, Service, Type, and Due Date. 
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From the Process menu, users can make a query or create work orders, corrective action (CARs), generate 

resolution report and synchronize with ABS Surveys. 

 
 

Double-clicking on a record in the list opens the ABS Survey Finding Detail window to record resolutions by 

crew. 
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ABS Survey Certificates Tab 

The ABS Survey Certificates tab displays the status of the ABS certificates with an option to view a copy of 

the certificate. 

NOTE:    The view certificate link becomes active when connected to the web. 

 

ABS Survey Timeline Tab 

The ABS Survey Timeline tab displays a static image of the survey timeline.  Clicking on the details link 

displays the interactive view of the timeline. 
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Other Surveys Certificates Tab 

The Other Surveys Certificates Tab displays an editable list of certificates and status issued by other 

organizations, e.g. U.S. Coast Guard. 

 

 
 

 

Double-clicking on a row in the list opens the Standard Job. 
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 ABS Survey Planning Work Packs 

Download Work Pack 

From the Maintenance and Purchase module at ship level → Maintenance gadget → Class Information  

→ Survey/Certificate Manager window - ABS Survey Planning→Scheduled/Unscheduled/Complete sub 

tab review the surveys on the list.   

 

1. Tick the check box (es) for those that need a work pack. 

 

2. On the Process menu, click Download Workpack. 

3. Type in the name of the file and location to save the workpack. 
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4. Click the Save button. 

5. A progress bar will display showing the progress of the download. 

 

 

6. The downloaded work pack zip file contains: 

• Pre-survey Checklist 

• Pre-survey Checklist Recommendations 

NOTE:  Upon requesting for the survey the program/plan required needs to be imported online. 

 Completed documents need to be stored on the ship survey file as part of the IMO/Flag compliance. 

 

Work Pack Pre-Survey Checklist 

The Work Pack ESP Program is an editable pdf file to assist the ship staff in preparing for surveys.  A 

completed checklist can be reviewed by the Port Engineer/Vessel Superintendent prior to requesting the survey.  

A completed checklist can be attached to the NS Enterprise Work Order, when required and can be 

exported/uploaded to ABS via online request for the attending surveyor review. 
 

Work Pack Pre-Survey Recommendations 

The Work Pack Pre-Survey Recommendations is a read only PDF.  It lists all the open findings and 

recommendations to assist the ship staff prepare for the survey. 

 

 

Create NS Enterprise Work Order 

From the ABS Survey/Certificate Manager window, ABS Survey/Certificate Planning Tab: 

 

1. Tick the check box(es) of the survey that needs to be included in the new work order. 
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2. Click on the Process menu→Pre-Survey Activities—Download Work Pack and Create WO link. 

 
 
 

3. The option to synchronize with ABS will display.  Click No button to create a work order in NS 

Enterprise. 

 

 

• A message will display with the work order number and an option to open the work order.   

 

4. Click the Yes button to open the work order. 
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• The work order will include the work pack as well as populate the Title field.  The work order lists 

the selected surveys and has the ability to upload completed documents and replicate to 

vessel/central. 

 

 
 

5. The work order now follows the normal workflow for this type of work. 

 

Create NS Enterprise Service Order 

From the ABS Survey/Certificate Manager window, ABS Survey/Certificate Planning Tab, tick the check 

box(es) of the surveys that will need to have a service order. 

1. Click on the Process menu from the Pre-Survey Work Order→Create SO to create a service order. 

2. All information is prepopulated from the work order. 

3. Approval for the service order follows the client workflow 

 

Request for Survey – NS Enterprise 

From the ABS Survey/Certificate Manager window, ABS Survey/Certificate Planning Tab, check the check 

box (es) of the surveys that will need a survey request. 

 

1. Once the service order is approved and becomes a Service Purchase Order.  Search for the Purchase 

Order using the PO search navigator screen. 

2. On the PO Documents tab, click on the work order number to open the work order window. 

3. From the work order window, click on the Process menu→Request for Survey. 

4. A service order is created to request the Survey.  All information is prepopulated on the work order 
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5. Approval for the Request for Survey Service Order follows the client workflow. 

Request for Survey – ABS Eagle 

Authentication is completed via the ABS Eagle portal. 

1. Using the ABS Eagle Portal→ABS Survey Manager→Place order to open the online place order 

screen. 

2. Enter the date in the text fields. 

3. Saved documents can be uploaded onto the order. 

4. Click on the Place New order button to submit the request 

5. The order will be sent to ABS office with return reply e-mail to the NS Point of Contact. 
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Section 4 Survey / Certificates 

A ship has many certificates which must be kept current.  NS provides a way to track and organize the 

certificates that any single ship maintains with a convenient interface for viewing and updating the database 

records.  

 The Survey / Certificate Interface 

This functionality is found in the Maintenance and Purchasing module. From the Maintenance gadget → Class 

Information → Survey/Certificate Manager. 

The Survey and Certificates window opens. 

 

All an individual ship’s certificates, along with their associated information, are listed on the Other Surveys 

Certificates tab. 

Each certificate is connected to a standard job. NS automatically creates and completes work orders for each 

certificate when information is updated. 

Click the Edit Survey button to view the standard job connected to the highlighted certificate. 

Choose the Work Orders tab to view the history of this certificate. 
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 Updating Certificates 

It is strongly recommended to update the certificates using the Surveys and Certificates interface even though 

the standard job connected to a certificate can be changed from the Maintenance Plan. 

1. Open the Surveys and Certificates window by selecting Class Information → Survey/Certificate 

Manager from the Maintenance gadget on the Navigator. 

2. Find the certificate needs to be updated by scrolling through the list of certificates.  

3. Click the Last Issued date box of the certificate to be updated.  Enter the new Issued date and choose 

the Select button.  NS enters the date into the database and the Next Due and Schedule dates are updated 

after the Maintenance Plan is recalculated. 

The Next Due date is calculated based on the job interval, while the Scheduled date is when the job 

appears in the Maintenance Plan. If, for instance, the user connects the certificate WO to an event, the 

Scheduled date changes to the date of the event. 

4. An error warning opens if users try to enter a date earlier than the current Last Issued date. 

 Attaching a Scanned Copy of the Certificate 

Users can attach an image or PDF of the certificate to the certificate record. 

1. Highlight the certificate in the Surveys and Certificate window. 

2. Click the Edit Last button. The Work Order window for this certificate opens. 

3. Attach the PDF file on the File Attachments tab. 

 Correcting Errors 

Do not just enter the correct date in the Last Issued column if an incorrect date was entered accidentally for 

one of the certificates. 

NOTES:      

• This is very important, as the standard job connected to the certificate has its schedule               

based on Due Date, not Completion Date as is typical for most maintenance items. 

• In order to view the Process menu options, ensure that the Classification Society field in 

the Ship screen is blank. 

 

NS treats this as if a new certificate were issued if users just enter a new date in the Last Issued column. The 

calculation for the Next Due date will be incorrect. 
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To correct errors:  

1. Highlight the certificate in the Surveys and Certificate window. 

2. Click the Edit Last button.  The Work Order window for this certificate opens. 

 

 
 

3. Go to the Message tab. Right click and choose New Message.  Address this message to the Technical 

Supervisor and ask to update the certificate with the correct information 

 Certificate Jobs 

Jobs pertaining to certificates are now included in the Maintenance Time Plan. This can be configured from 

the user’s account settings. 
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Section 5 Equipment Certificates 

There are many items onboard a ship which have a certificate that needs to be stored and traced besides the ones 

described in the Surveys and Certificates section. NS has the ability to attach a copy of any certificate to the 

equipment detail for easy retrieval in the future. This proves to be beneficial during surveys, audits, etc. in which 

certificates are requested to be presented for inspection. 

The process involves making a digital copy of the certificate, attaching it to the relevant equipment detail and 

then designating a term in the subject index on the Admin Info tab to allow for targeted searches. 

 Attaching Surveys / Certificates to Equipment 

The first step in attaching an equipment survey / certificate is to make a digital copy.  This is then attached to 

the relevant equipment detail. 

1. Scan the survey / certificate. Save the PDF in a convenient location on user’s computer.  Name the PDF 

file as follows:  DATE_EQUIPMENT.pdf. 

This is important as it allows users to quickly find the most recent survey / certificate. 

2. Go to Maintenance gadget ➔ Equipment Explorer. Drill down through the hierarchy and highlight 

the relevant equipment.  
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3 Click the Open Left Pane Item button. The Equipment Detail opens. 

 

4. Right click on the File Attachments tab and choose Attach.  Attach the PDF file that was created in 

step one.   
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 Using the Subject Index 

The next step is to connect the CERTIFICATION label to the Subject Index so that all equipment details with 

a survey / certificate attached can be easily searched for. 

1. Go to the Admin Info tab on the equipment detail. Click the dropdown menu at the end of the Subject 

Index field. The Subject Index Selection window opens. 

  

2. Highlight the CERTIFICATION and click the Right Arrow button to move CERTIFICATION to the 

right side of the window.  Click OK. 

 

• The Subject Index is now searchable for Surveys and Certificates. 
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 Performing a Survey / Certificate search 

Users can search for equipment with a survey / certificate attached by using the Equipment Query and filtering 

for CERTIFICATION in the Subject Index. 

1. Choose Equipment Explorer from the Maintenance gadget on the Navigator.  The Equipment 

Explorer window opens. 

2. Click the Equipment Query button. A search window opens. 

 

3. Select the CERTIFICATION in the Subject Index field – this is under the Index Term group. 

4. Click the Search button at the bottom of the Search tab to return a filtered list of equipment with survey 

/ certificates attached. 

 

5. Double click on the desired piece of equipment to open the equipment detail. The relevant survey / 

certificate is listed on the File Attachments tab. 
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Section 6 Hierarchy 

The NS Enterprise hierarchy organizes machinery equipment, consumables, and jobs according to functional 

and physical relationships. The hierarchy is displayed in the form of the Equipment Explorer. The hierarchy 

is the organizational representation of the systems, equipment, parts, and consumables on board a vessel. 

Machinery and stores are located quickly by “drilling-down” through the various levels. The system hierarchy 

is defined by the company using the software.  

Machinery equipment, consumables and jobs are displayed in the hierarchical structure corresponding to their 

actual physical interrelationships. This method provides comprehensive cross-referencing among machinery 

items and stores without requiring specialized code numbering systems. However, code numbering systems can 

be accommodated, if desired. As a result, the user has the capability to search for an item by location in the 

hierarchy or its physical location on the vessel. For example, engineers on a vessel are more adept at finding 

items by equipment and parts than by equipment identification numbers. This design results in a rapid initial 

learning curve, enhances the ability of the office staff and shipboard crew to perform data maintenance and 

eases the task of finding materials to be purchased or used in maintenance events. It provides a self-contained 

system, almost eliminating the need for reference manuals to access the data. 

The hierarchical system is used in both the maintenance and purchasing processes of the module, but in different 

ways. The maintenance side uses the hierarchy to list systems and equipment that are maintained. The 

purchasing side uses the hierarchy to track materials included in inventory. Some items listed in the purchasing 

view are not visible in the maintenance view because all items need to be accounted for inventory, but not all 

of them are maintained items. 

There are two reports on the ship level regarding the hierarchy. These are the Equipment Hierarchy report and 

the Equipment Particulars report. Select Reports gadget → Inventory Reports on the Navigator pane of the 

Maintenance and Purchasing window.  

A message box opens when the Equipment Particulars report is selected advising that it may take a long time 

to create the report. Click the Yes button to close the message box and open the Report Option window. The 

Equipment Particulars report prints the details about each piece of equipment listed in the hierarchy. This 

report also includes the names of the systems with all equipment within that system listed below it. All the 

information about the equipment that is included on the Equipment window are listed on this report. This 

includes the storage locations, cross referenced equipment and any other information listed on the tabs on the 

Equipment window. 

The Equipment Hierarchy report is a condensed version of the Equipment Particulars report. This report 

only lists the systems, the equipment in those systems, descriptions, bar code, ID code, model number, serial 

number, and manufacturer. 

A hierarchy can be imported into or exported out of NS Enterprise from an Excel spreadsheet or copied from 

an identical or similar ship. 
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 Maintenance Hierarchy 

Ship

Systems

Unit

Unit

Unit

Component

Component

Maintained Part

Maintained Part

Maintained Part

 

The hierarchy on the maintenance side is used to classify equipment, access machinery records, and organize 

jobs. It breaks down a Machinery System into units and components. A system is an assembly of mechanical 

or electronic components that function together as a unified whole. Units and components represent machinery 

equipment records such as a main engine, turbocharger #1 or cargo pump #1. They also represent physical 

relationships between machinery equipment. For example, the “Propulsion and Steering” system has a unit 

called “Main Engine” with its related units and components such as the “Turbocharger Aft”, “Governor” and 

“Pneumatic Controls”. This creates a parent-child relationship between the system, units, and components. A 

unit does NOT always operate together with the upper unit or system it is associated with. A unit that is a child 

of a parent system or unit does NOT receive the running hours of the parent because it is not running the whole 
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time that the parent is running, but these units are still related. A component operates for the same amount of 

time together with the top-level unit. That means that each component that is a child of a parent unit receives 

the same running hours as the parent unit for purposes of scheduling planned maintenance.  

Units and components can be subdivided further into parts.  However, these parts must be specified as 

maintained parts to be visible on the Maintenance hierarchy.  

When the system preference "Display Hierarchy with Equipment Codes" is set to "Yes", the hierarchy will 

display with the Equipment Code followed by two spaces followed by the equipment name, and sorting will be 

based first on the equipment code and then on the equipment name.  

If this preference is set to "No" the hierarchy display will be unchanged from the current standard. 

NOTE:  Consumable Categories, Consumable Types and Groups are visible in the Maintenance hierarchy 

view because they are main category titles. These are NOT considered maintainable items. 

  Equipment Explorer 

The Equipment Explorer is the center of the Maintenance and Purchasing modules hierarchy. All items that 

are maintained, purchased, or stored are listed on the Equipment Explorer. The Equipment Explorer window 

can be viewed from the fleet level or the ship level. 

Equipment Explorer now has a relog menu option on the equipment document.  Relog allows the user to 

replicate this document to all applicable remote sites for either a missing document or inconsistent data between 

sites. 

  NOTE:  This manual focuses on the maintenance portion of the Equipment Explorer. 

 

1. Click the Equipment Explorer button on the Navigator pane of the NS Enterprise Maintenance and 

Purchasing window. 

   

OR 
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The Equipment Explorer window opens. The Equipment Explorer window differs depending on the view. 

All ships in the fleet are listed in the left pane of the window when the fleet view is used. Click the + sign 

preceding each ship for the hierarchy of systems for each ship. The items defined in the hierarchy below these 

systems can be viewed by clicking the + sign preceding each item. Items within the hierarchy can be easily 

found through the Search functionality. 

 

Fleet Level 

 

Ship Level 
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All systems that have been defined on the ship are listed in the left pane of the window when the ship view is 

used. Equipment defined under these systems can be viewed by clicking the + sign preceding each system or in 

the right pane of the window. 

 
 

2. Select View → Maintenance from the Equipment Explorer window menu option to switch from 

Purchasing to the maintenance view. Jobs associated with the highlighted equipment or maintained part 

in the left pane of the window are displayed in the right pane of the window when the Maintenance 

view is selected. 
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Option Description 

File→ 

 

The File menu contains options to manipulate a file.  

      New →  

New 

Equipment 

 

New Part 

 
 

Select the New option / button to create new equipment or part. 

 

NOTE: New parts can be created while in the 

Maintenance view, however they are NOT visible 

under the equipment unless the view is changed to 

Purchasing.  

Only maintained parts are visible under the 

equipment while in the Maintenance view. See 

Maintained Parts Tab in this section for details. 
 

      Delete 

 

Select the Delete option / button to delete the selection 

highlighted in the left column of the Equipment Explorer 

window. 

A confirmation message box opens for verification of the item 

to be deleted. 

 

NOTE: BE CAREFUL! Deleting a parent item also 

deletes all child items in the hierarchy beneath it. 
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Option Description 

      Close Select the Close option to close the Equipment Explorer 

window. 

Open→  

 

The Open menu contains options to open specific windows.  

Open Left Pane 

Item 
 

Select the Open Left Pane Item option / button to open the 

window for the item highlighted in the left pane of the 

Equipment Explorer window. 

Open Right Pane 

Item 
 

Select the Open Right Pane Item option / button to open the 

window for the item highlighted in the right pane of the 

Equipment Explorer window. 

Find→ 

 

The Find menu contains the option to find a part. 

 

NOTE: Do not confuse a part with equipment. This 

option ONLY searches for parts. 
 

 Find Part 

 

Select the Find Part option / button to open the Search 

Companion window in the left pane of the Equipment 

Explorer window to find a part. 

See Find Part in the Search for Equipment or Parts portion 

of this section for details. 

View→ 

 

The View menu contains options to change what is displayed in 

the Equipment Explorer window.  The View is defaulted to 

Purchasing.  
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Option Description 

 Equipment Tree Select the Equipment Tree option to display the equipment 

hierarchy in the left pane of the Equipment Explorer window.  

 Equipment Query 

 

Select the Equipment Query option / button to display the 

Search Companion window to search for equipment in the left 

pane of the Equipment Explorer window.  

 Purchasing Select the Purchasing option to display equipment and parts 

that are contained in the inventory. Purchasing is the default 

view of the Equipment Explorer window.  

The left pane of the window contains the Purchasing hierarchy 

and the right pane of the window contains items in the hierarchy 

below the selected item in the left pane.   

             Maintenance Select the Maintenance option to display maintained 

equipment and parts.  

The maintenance hierarchy is displayed in the left pane of the 

Equipment Explorer window and the jobs associated with the 

equipment or part highlighted in the left pane are listed in the 

right pane of the window. The items included in the maintenance 

hierarchy are: 

• Machinery systems 

• Units 

• Components 

• Maintained Parts 

 

NOTE: Consumables Category and Consumables 

Type are visible in the Maintenance view. These are 

included because they are main headings NOT 

because they are maintained. 
 

ABS Class View 
Displays only the ABS classed equipment.  This is only 

applicable if hierarchy was loaded via ABS Class Integration. 

Voyage & Energy Related 
Displays only the equipment that has consumption and usage 

being tracked via Voyage Manager module. 
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Option Description 

UN/CP etc. Designation 

 

Select the UN/CP etc. Designation option to view the 

designation of each item in the hierarchy.  

 

This includes: 

• SY – System 

• CC – Consumables Category 

• UN – Unit 

• CP – Component 

• PT – Part 

• MPT – Maintained Part 

• CT – Consumable Type 

• AS – Assembly 

• SA – Sub-assembly 

• GR – Group 

• SG – Sub-Group 

• IT - Item 

               Sub-Items 

 

Select the Sub-Items option / button to view the sub-items in 

the right pane of the window under the item highlighted in the 

left pane of the window. This is selected by default. 

For example, the parts listed under highlighted equipment, sub-

parts listed under a highlighted part or sub-assemblies listed 

under a highlighted assembly are listed in the right pane of the 

window.  

                Item Particulars 

 

Select the Item Particulars option / button to view the details 

in the right pane of the window of the item highlighted in the 

left pane of the window. 

Show Details button 

 

Click the Show Details button to toggle open / close the right 

pane of the window. 

Help 

 

The option in the Help menu is Help. Select this option to open 

the online help. 
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 Add or Edit Equipment 

Equipment can be added or edited from the fleet view or the ship view. The procedure is the same whether 

equipment is added or information on the Equipment window is changed. The fleet view allows the central 

office to add equipment to any or all ships in the fleet at one sitting.  A ship can only add equipment to itself in 

the ship view. 

Edit equipment by opening the Equipment window and editing the fields that need to be edited.  

 A hierarchy can be copied, modified, and then imported into a new vessel using the import hierarchy 

procedure. 
 

1.   Open the Equipment Explorer window. 

2.   Click the New Equipment button on the Equipment Explorer toolbar to open the Equipment – New 

window. The name of the ship is displayed on the first line of the window. The name of the ship and 

the name of the item that the new equipment is subordinate to are listed if this new item is not at the top 

level of the hierarchy.  

 

--OR-- 

 

Click to select the equipment from the left side of the Equipment Explorer window to edit equipment that has 

already been created. Click the Open Left Pane Item button on the Equipment Explorer toolbar.  

 

NOTE:   Hierarchy for a new vessel can be copied from an established hierarchy using the Copy Ship 

Materials Classification in the fleet level view of the Maintenance and Purchasing window. 
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There are a number of fields and tabs on the Equipment – New window. The menu bar, toolbar, fields, and 

tabs are explained in the following sections. 

 

Equipment Window  

The options on the Equipment window menu bar and toolbar are: 

Option Description 

File→ The File menu contains options to manipulate a file.  

          Save 

 

Select the Save option / button to save any changes made on the 

Equipment window. 

          Relog Relog allows the user to replicate this document to all applicable remote 

sites for either a missing document or inconsistent data between sites. 

Requisitioning→ The Requisition menu contains options to create requisitions to replenish 

parts listed below the specified equipment in the hierarchy to the 

maximum, minimum or reorder level. 

Reports→  

 

  

The Reports menu contains options to create different kinds of reports. 

 
NOTE: Only the reports associated with Maintenance are 

listed. Reports associated with Purchasing are in the NS 

Enterprise Purchasing module manual.   

Any report selected opens the Report Options window. Click the radio 

button to select where this report should be sent. The options are: 

• Screen – displays the formatted report on the screen. Click the 

OK button to generate the report. The report displays on the 

monitor when it is complete. 

• Printer/Fax – sends the report to the assigned printer. The Print 

window opens when the report is complete to select the printer. 

• File – the field next to the File radio button opens when this option 

is selected. Click on the dropdown menu to select the type of 

format for the saved report. Click the OK button. The Save As 

window opens to select the directory where the report is to be 

saved. 

• Email - The Email option allows the user to attach the report to a 

MS Outlook message. 
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Option Description 

Spares List by 

Equipment Report 
The Spares List by Equipment report is available under the Unit, 

Consumable Type and Component designations. 

The Spares List by Equipment report displays all the assemblies and 

parts contained within the specified unit or component. This does NOT 

include other units or components listed beneath this specified unit in the 

hierarchy. 

Two additional options are available on the Report Option window for 

this report. These options are: 

•  Include quantity on order – two columns are added to the report 

to display the quantity listed on a purchase order and the quantity 

listed on a requisition. 

•  Print critical parts only – only parts designated as critical on the 

Part window are listed on this report.  

The information contained on this report is: 

• Maximum level of this part 

• Part description 

• Part number 

• Location of part 

• Reorder level 

• Quantity on hand 

• Unit of measure 

• Price at the referenced currency 
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Option Description 

Parts Manual of 

Equipment 

Report→ 
 

The Parts Manual of Equipment report is available under the Unit, 

Consumable Type and Component designations. 

The Parts Manual of Equipment report displays all the assemblies and 

parts contained within the specified unit or component. This does NOT 

include other units or components listed beneath this specified unit in the 

hierarchy. 

There are three types of formats to select from: 

• Standard Format – basic information such as description of the 

parts/assemblies, part number, quantity and unit of measure and 

storage location. 

• Bar Code Format – includes all the information in the Standard 

format and includes the barcode. 

• Extended Format – includes all the information in the Standard 

format plus the pin number, maximum number of parts, minimum 

number of parts and number of parts reordered. 
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Option Description 

Print Labels 

Print labels 

The Print Labels report is available under the Unit, Consumable Type and 

Component designations. 

The Print Labels option prints labels containing the following 

information: 

• Ship 

• Equipment 

• Manufacturer 

• Part name 

• Pin 

• Location  

• Date labels were printed 

• Bar code of part 

• Serial Number 

There are two options in the Select Number of Labels to Print portion of 

the Report Option window to print labels: 

• Per Items on Hand– this option prints one label for each part 

associated with the equipment unless the Multiple Labels check 

box on the Part window is checked. Then it prints one label for 

every part on hand of that part. For example, the part - “Piston” - 

is listed under a piece of equipment. There are 3 pistons on hand 

according to the Inventory tab on the Piston Part window. The 

Multiple Labels check box is NOT checked so only 1 label for 

pistons is printed regardless that there are 3 on hand. However, 

using the same example, the Multiple Labels check box is 

checked, and three labels are printed for pistons. 

• Other Number – the Other Number option prints the number of 

labels specified in this field for parts with the Multiple Labels 

check box checked on the Part window for each storage location. 

For example, the number 2 is typed in the Other Number option 

field. There are 3 roller bearings in Storage A and 3 roller bearings 

in Storage C. The Multiple Labels check box is checked on the 

Roller Bearing Part window. Two labels are printed for roller 

bearings in Storage A and 2 labels are printed for Roller Bearings 

in Storage C.   

Currently only 4 x 2-inch labels are available. 
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Option Description 

Spares Usage over time 

period Report 
This report is available under the System, Consumables Category, Unit, 

Consumable Type and Component designations. 

The Spares Usage over time period report displays the parts used over a 

specified time period. This time period is designated on the Report 

Option window. Click the Calendar buttons at the end of the Start Date 

and End Date fields to select the date range for the information contained 

on the report. 

Requisition Stock and 

Order Status Report 

This report is available under the Unit, Consumable Type and Component 

designations. 

The Requisition Stock and Order Status report displays all parts ordered 

under the specified equipment. It lists the purchase order or request for 

quotation (RFQ) number as well as the quantity of each part ordered. 

Equipment Cost Details 

Report 

This report is available under the Unit, Consumable Type and Component 

designations. 

The Equipment Cost Details report displays the cost of the specified 

equipment over a period of time. This can include cost of parts to repair 

the equipment as well as the cost of service.  

There are a number of parameters that must be selected from the Report 

Option window prior to the report creation. These parameters include: 

• Time frame of report 

• Currency 

• Exclude certain documents from report 

Cross Reference 

Equipment Cost Report 
This report is available under the Unit, Consumable Type and Component 

designations. 

The Cross-Reference Equipment Cost report displays the cost of 

equipment that is cross referenced. It reflects the cost throughout the 

system where it is cross referenced. The same parameters used to create 

the Equipment Cost Details report are used for the Cross-Reference 

Equipment Cost report. 

 
NOTE: Data is displayed in this report only if documents such 

as purchase orders or requisitions have been created for the 

specified unit or part. 
 

Equipment Detail 

Report 

The Equipment Detail report displays information from the fields on the 

Equipment window as well as the Cross-Reference tab and Remarks 

tab. An option is available to include the maintenance history of the 

equipment. 
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Option Description 

Work History and 

Schedule Report 

This report is available under the Unit, Consumable Type and Component 

designations. 

The Work History and Schedule report displays all the work orders for 

this piece of equipment. All or individual work orders can be selected for 

this report from the menu. These options are: 

• Summary – displays a summary of all the work orders for the 

selected equipment. This includes the scheduled date of service, 

work order number, equipment name, job title, last date service 

was performed, the interval between service and the job category. 

• Work Specifications – displays only the work specifications 

which include the job category, scheduled date of service, work 

order number and job title. 

• Detail Format - displays all work orders in detail. This includes 

such details as the estimated labor and cost data, materials 

required and used, work order description and findings.   

Work History / Findings 

Report 

This report is available under the Unit, Consumable Type and Component 

designations. 

The Work History/Findings report displays the completed work orders 

and findings for a specified time frame. Click the Calendar buttons at the 

end of the Start Date and End Date fields to select the date range for the 

information contained on the report. 

Help 

 

The option in the Help menu is Help. Select this option / button to open 

the online help. 
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The fields on the Equipment window are: 

 

 

1.   Type the name of the system or equipment in the Name field. THIS IS A REQUIRED FIELD.  

 There is no naming convention, but the name of the equipment or consumable type should identify the piece 

of machinery. This is important when there is duplicate equipment on board. 

NOTE:   Whatever is entered in the Name field is repeated in the Complete Name field when the cursor  

                is moved out of the Name field. A more descriptive name can be typed in the Complete Name 

                field. 

 

2.   Click on the dropdown menu on the Designation field to select the classification. This is a required field 

that is automatically filled by default. This default value can be changed. 

 The options in this field vary depending on the position in the hierarchy.  

 The options are System or Consumables Category if it is directly under the ship. 

 

 

The option is Unit if it is under a System or it is a Consumable Type if it is under a Consumable Category. 
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The options are Unit or Component if it is under a Unit. 

 

A unit is a piece of machinery that may run independently from its owner machinery. A component is a piece 

of machinery that only runs when its owner machinery is running. Unit and component designations are also 

important when dealing with running hours.  

For example, the auxiliary blower is a unit under the main engine. It only runs on startup and then shuts off. But 

the turbocharger is a component under the main engine because it runs the whole time the main engine runs. 

The main engine is a unit because it is directly under the System Propulsion and Steering and only units can be 

entered directly under systems.  

When the main engine is operating, so are the turbochargers. NS Enterprise has a single running-hour entry to 

update the register of all the items and the jobs that are associated with the main engine, its maintained parts, 

its components, and any component’s-maintained parts. 

The other fields on the Equipment window are: 

Field Description 

Name The short name of the equipment. 

Designation Options include System, Consumables Category, Consumables Type, Unit, Component, 

Part, and Assembly depending on what type of equipment document is being created. 

Complete Name The Complete Name field fills with the same value that is typed in the Name field. A 

more descriptive name can be typed in the Complete Name field. 

Equipment Code Type an alphanumeric equipment code in the Equipment Code field. NS Enterprise 

can find equipment records by this code.  
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Field Description 

Manufacturer There are two sections in the Manufacturer field. Either field can be filled first. The 

other field completes with referenced information from the Companies window. 

 

Type the manufacturer code in the first section (shaded white) if it is known. The second 

section automatically fills if this manufacturer has been created in the Companies 

window. 

Click on the dropdown menu at the end of the second section to open the Equipment 

Maker window. Equipment Maker is selected in the Company Type field by default. 

Select any other parameters that will help locate the necessary manufacturer for the 

equipment. Click the Search button. All companies meeting the specified criteria are 

listed on the right side of the Equipment Maker window. Double click on the company 

that manufactures the equipment to close the Equipment Maker window and add the 

selected manufacturer to the Manufacturer field of the Equipment – New window. 

 

NOTE: The Manufacturer field applies to equipment and NOT to 

consumables. 
 

Equipment 

Location 

Type a location of the equipment in the Equipment Location field. This field is alpha-

numeric with a maximum of 60 characters and is user defined. The Equipment 

Location field is included in the Equipment Details report and the Equipment 

Particulars portion of the WO / SR / NAJ form   

Spares Storage The Spares Storage field specifies where the equipment is stored and is related to 

inventory. 

Status Click on the dropdown menu in the Status field to select whether the equipment is 

Active or Inactive. The default selection is “Active”.  

 

This field is used in the Preventive Maintenance application. It defines whether the 

equipment is currently part of the ship's maintenance plan or has been removed, either 

temporarily or permanently.  

All the PM Standard Jobs based on the equipment are excluded from the job scheduling 

calculation when the Status is “Remove” and are not listed in the ship's Maintenance 

Plan.  

The Running Hours Clock of the equipment, its components and maintained parts are 

stopped. The PM Standard Jobs for these are also stopped. The entries of elapsed 

running hours for these items are ignored.  
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Field Description 

Date Installed Click the Calendar button at the end of the field to open the Calendar window to select 

the month, day, and year that the equipment was installed. 

Click the arrow or double arrows at the top of the calendar to navigate to the correct 

date. Double click on the date to close the Calendar window and enter the date in the 

Date Installed field. 

-- OR – 

Type the date the equipment was installed in the Date Installed field. The date format 

is defined in the Options window. 

Year Made Type the year the equipment was made in the Year Made field. 

Srl. No. Type the serial number of the equipment in the Srl. No. field, if applicable.  

 

NOTE: The Srl. No. field applies to equipment and NOT to 

consumables. 
 

Model Type the model number of the equipment in the Model field.  

 

NOTE: The Model field applies to equipment and NOT to consumables. 

 

Apply Vendor 

Restriction check 

box 

Click the Apply Vendor Restriction check box to indicate that only vendors specified 

on the Sources Tab can be used for any requests for quotations or purchase orders 

regarding this equipment. A user with the Override Vendor Restriction authorization 

can use vendors not specified on the Sources tab.  

Serialized 

Equipment 

Required 

checkbox 

If this box is checked, then any time a Serialized Equipment is removed from the 

Equipment, the system displays a message that a new Serialized Equipment must be 

installed into the Equipment before the Equipment screen is closed.   

NOTE:  This only applies when a Serialized Equipment is being removed from 

the Equipment.   

Size Type the size of the equipment, if applicable, in the Size field. 

 

NOTE: The Size field applies to equipment and NOT to consumables. 

 

Type Type the kind of equipment in the Type field.  

 

NOTE: The Type field applies to equipment and NOT to consumables. 
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Field Description 

Class Data 

section 

The Class Data section was added to include classification information. The fields in 

this section are: 

• Class Code – classification code which is the UID of the vessel  

• HID – Hierarchy Identification Number 

• Class Equipment Name – the name by which the equipment is referenced by 

the class society 

 

NOTE: Only authorized users can add or edit information in these fields. 

 

 

Admin Info Tab 

 

The Admin Info tab contains general information regarding the equipment. This includes the 

department responsible for the equipment and other purchasing information. 

The fields on the Admin Info tab are: 

Field  Description 

Criticality Click on the dropdown menu in the Criticality field to select the priority rating of 

the equipment. The options are A, B, C and D with A being the highest priority. The 

default selection is “D”.  

It is suggested that the value “A” be used to designate equipment that is critical from 

a safety standpoint in connection with the ISM code requirements. “B” can be used 

to designate equipment which is critical from an economic/quality standpoint, which 

is related to the goals of ISO. The “C” and “D” designations can be used for less 

critical equipment. 
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Field  Description 

Department Click on the dropdown menu at the end of the Department field for a list of 

departments. The Department List window opens. Double click on a department to 

close the Department List window and add the selected department to the 

Department field of the Equipment window. 

Authorized users can add new departments from the Department List window. 

Account 

(Materials) 

Select the account that materials associated with this equipment are credited to in the 

Account (Materials) field. This account number is the default number included in 

any requisition for materials for this equipment. 

There are two sections in the Account (Materials) field. Either field can be filled 

first. The other field completes with referenced information from the Available 

Accounts window. 

-- OR -- 

Click on the dropdown menu at the end of the second section to open the Available 

Accounts window.  

Double click on the account associated with materials for the equipment to close the 

Available Accounts window and add the account to the Account (Materials) field.  

Authorized users can add new accounts from the Available Accounts window or 

from the General Data module. 

Account 

(Services) 

Select the account that services associated with this equipment are credited to in the 

Account (Services) field. This account number is the default number included in 

any requisition for services for this equipment. 

There are two sections in the Account (Services) field. Either field can be filled first. 

The other field completes with referenced information from the Available Accounts 

window. 

-- OR -- 

Click on the dropdown menu at the end of the second section to open the Available 

Accounts window.  

Double click on the account associated with services for the equipment to close the 

Available Accounts window and add the account to the Account (Services) field.  

Authorized users can add new accounts from the Available Accounts window or 

from the General Data module. 
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Field  Description 

Subject Index Click on the dropdown menu at the end of the Subject Index field to select a 

reference from the Subject Index Selection window for cross referencing and query 

purposes. One or more items can be selected. 

Select the subject index associated with the equipment.  

Double click on a selection from the left side of the Subject Index Selection window 

to move it to the right side of the window. More than one selection can be made, but 

they can only be moved to the right side of the window one at a time. 

Click the OK button on the Subject Index Selection window to accept the selections 

and close the window. These subject indexes are listed in the Subject Index field. 

Authorized users can add new indexes to the Subject Index from the General Data 

module. 

ASTM Class Click on the dropdown menu at the end of the ASTM Class field to select the 

American Standard Tools and Materials class for this piece of equipment. 

The ASTM Code List window opens. Double click on an ASTM selection to close 

the ASTM Code List window and add the selection to the ASTM Class field.  

Authorized users can add new selections from the ASTM Code List window or from 

the General Data module. 

Equipment 

Index 

The Equipment Index is intended to provide an additional means of classifying and 

searching equipment beyond the Subject Index. Click on the dropdown menu at the 

end of the Equipment Index field to select the equipment index list to associate with 

the new equipment 

Requisitioning Click the radio button in the Requisitioning section to indicate whether the 

equipment is included in inventory.  

• Stock – included in inventory. Inventory update is performed. 

• Non-Stock – not included in inventory. No inventory update is required. 

 

NOTE: The Requisitioning section applies to the purchasing of 

materials. 
 

Under Warranty 

check box 

Click the Under-Warranty check box to indicate if this equipment is under 

warranty. 

Expires The Expires field becomes available when the Under-Warranty check box is 

checked. 

Click the Calendar button at the end of the Expires field to select the date that the 

warranty expires. 
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Field  Description 

Restrict Part 

Creation check 

box 

When checked the user is restricted in certain cases to create / edit part or group even 

if the user has Part/consumable Create /edit authorization. 

Equipment and consumable category checkbox indicate if create / edit restriction is 

to be applied for parts and groups under this particular equipment or consumable.   

If Equipment or consumable category has the restrict part create/edit checkbox 

checked, then user would require existing authorization of create/edit AND also the 

newly added authorizations of create/edit part for restricted equipment 

Buyer Group Click on the dropdown menu on the Buyer Group field to select the group 

authorized to purchase the equipment. The groups displayed on the Buyer Group 

Selection window are dependent on the user profile. Specific equipment may only 

be purchased by certain groups.  

The Buyer Group field applies to the purchasing of materials and equipment.  

Cross References Tab 

 

The Cross References tab contains information regarding the same equipment that is contained on other vessels 

or the same equipment located in another part of the same ship. The Cross References label on the tab turns 

blue and an icon is present when entries are made on the tab. 

 
NOTE:  Equipment that is cross referenced share the same parts listing. Any new parts 

entered in any of the equipment that is cross referenced are entered into all the 

equipment that is cross referenced together. This includes the storage locations and 

the quantities of the spare parts if the equipment is on the same vessel. 

The selected equipment is listed on the Cross References tab by default.  

The fields on the Cross-Reference tab are: 

• Ship name – the name of the ship where the cross-referenced equipment is located 

• Equipment Hierarchy Reference – the name of the equipment or system in the preceding level of the 

hierarchy of the cross-referenced equipment 

• Equipment – the name of the cross-referenced equipment  
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    NOTE:  Equipment MUST be cross referenced to add sites to the Other Sites tab on the 

Parts window. 

Add or Link Equipment in Cross References Tab 

1. Click the Link button from the Equipment toolbar to add a cross reference or right mouse click in the 

       empty area of the Cross References Tab. The Equipment Explorer window opens with the selected   

       equipment checked in the left window and the details about the equipment in the right window. 

 

 
NOTE:   Notice that all ships in the NS Enterprise system are listed at the bottom of the 

Equipment Explorer window if the window is accessed on the fleet level. The 

equipment on these vessels is listed within these vessel hierarchies. 

 

2.   Find the equipment that the selected equipment is linked to in the left window of the Equipment 

Explorer.  

3.   Click the check box to select the equipment. More than one selection can be made.  

4.   Click the Select button on the Equipment Explorer toolbar. The selected equipment is displayed on 

the Cross References tab. 
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Delete or Unlink Equipment in Cross References Tab 

 
NOTE:   Equipment with maintained parts that are cross referenced CANNOT be unlinked. 

1.   Click the equipment to be unlinked on the Cross References tab. 

2.   Click the right mouse button on the Cross References tab for a list of options.  

 

3. Click the Unlink option. A confirmation message box opens.  

4.   Click Yes in the message box to unlink the equipment. The selected equipment is removed from the 

Cross References tab and is no longer linked. 

Copy to X Ref 

The Copy to X Ref option is only available from the Equipment window menu bar or by clicking 

the right mouse button within the Cross References tab. This option copies information from this 

equipment to the cross-referenced equipment.  

1.  Select the Copy to X Ref option from the Equipment window menu bar  

 -- OR – 

 Select the Copy to X Ref option from the menu that opens when the right mouse button is clicked on 

the Cross References tab. 

 

The Copy to X Ref window opens. 

 

 

2. Click the check box to select the information to be copied to the cross-referenced equipment. One or 

both options can be selected. 
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• Equipment Particulars – copies the following information: 

○ Model 

○ Equipment Code 

○ Style 

○ Type 

○ Size 

○ Year Made 

○ Remarks 

○ Manufacturer 

○ Account 

○ Department 

○ Subject Index 

○ Spares Storage Location (only copied to equipment of the same ship) 

○ Sources (vendors) 

○ Part Number Reference 

○ SI Required 

• Maintained Parts – copies information from the Maintained Parts tab 

 

3.   Click the OK button on the Copy to X-Ref window to accept the options selected and close the Copy 

to X-Ref window. 

A message box opens confirming that the options selected have been copied to all cross-referenced equipment. 

 
NOTE:   Any equipment particulars in the cross-referenced equipment is overwritten with this 

procedure. Maintained parts are NOT overwritten. Any new parts added to the 

original equipment are added to the cross-referenced equipment with this procedure, 

but parts are NOT deleted. 

Part. No. Reference Tab 

 

The Part Number Reference tab is used to add the reference manual names for the part numbers used on a 

piece of equipment. There can be several reference manuals for each piece of equipment.  
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NOTE:   Part number references MUST be created prior to part creation. Part numbers are 

used extensively throughout the NS Enterprise Maintenance and Purchasing 

modules. Having the correct part number and its corresponding reference manual is 

essential. 

The fields on the Part No. Reference tab are: 

• Main Part No. – Click the check box in the Main Part Number column to indicate the primary manual 

used for parts. This is the manual used to check part numbers throughout the NS Enterprise 

Maintenance and Purchasing modules. The main reference can be changed at any time.  

• Part No. Reference – the name of the reference manual 

 

Add or Link a Reference in Part No. Reference Tab 

1. Click the Link / Unlink Part No. Reference button from the Equipment toolbar to add a part number 

reference or right-click in an empty area on the Part No. Reference Tab.  

            

The Part No. Reference Lists window opens.  
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2.   Double click on a reference on the left side of the Part No. Reference Lists window to move it to the right 

side of the window.  Authorized users can add new references from the Part No. Reference List window. 

Only one selection can be made at a time, but several references can be listed on the right side of window. 

3.   Click the OK button when the reference list is complete to close the Part No. Reference List window and 

list the selected references on the Part No. Reference tab. 

4.   Click the check box in the Main Part No. check box to specify the primary manual used for part numbers. 

The Main Part No. selection is used for reference in several other places within the NS Enterprise system. 

 

NOTE: 

   The Main Part No. Reference tag is added to the approved RFQ export xml. 

 

 

Delete or Unlink a Reference in Part No. Reference Tab 

1.   Click the Link/Unlink Part No. Reference button from the Equipment toolbar to remove a part number 

reference from the Part Number Reference tab. The Part No. Reference List window opens.  

 
NOTE:   Click to uncheck the Main Part No. check box if the reference to be unlinked is 

used as the main part number reference. References that are selected as the main 

part reference CANNOT be unlinked or deleted. 

 

2.   Double click on the reference manual on the right side of the Part No. Reference List window to be 

unlinked to move it to the left side of the Part No. Reference List window. Only one selection can be made 

at a time, but more than one reference can be unlinked in this process. 

3.   Click the OK button when all references to be unlinked have been moved to close the Part No. Reference 

List window. The selected references are deleted from the Part No. Reference tab. 

Sources Tab 

 

The Sources tab displays information regarding all vendors that have supplied the part or a quotation of a price 

for the part.  The Sources tab contains basic vendor information that is applicable to purchasing. 
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Counter Setup Tab 

 

The Counter Setup tab is used to set the counter readings of the equipment and all parts under this equipment 

in the hierarchy. This reading is used to schedule counter jobs for the equipment. 

The fields on the Counter Setup tab are: 

Field Description 

Counter Type Click on the dropdown menu in the Counter Type field to select the format of the 

counter. The field is disabled using Hourly as the default counter type at this time. 

This field will have options in future versions of NS Enterprise. 

Counter Reading Set the number of hours the equipment has been running in the Counter Reading 

field.  

Zero is used if this is a new piece of equipment.   

As of Use the Calendar button at the end of the As of field to select the date the counter 

reading was entered. 

Total Hrs. Run Type the number of hours that the equipment has run in the Total Hours Run 

field. This should be the same number as the counter reading at this time.  

It may not be the same as the counter reading when the Counter Type field 

contains more options. 

Average Daily 

Usage section: 

The Average Daily Usage section of the tab is used when scheduled jobs are 

overdue.  

Manual 

Estimate – 

Hrs/day 
 

Click the Manual Estimate – Hours per Day radio button to type the number of 

hours in a day that this equipment operates.  

12 Month 

Historical 

Estimate 
 

Click the 12 Month Historical Estimate radio button for the system to check the 

history of this equipment for the past 12 months to estimate the number of hours 

it operates. This value is set in the Manual Estimate field. 

The default value is 24 if there is NOT 12 months of historical data for this piece 

of equipment. 
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File Attachments Tab 

Refer to Item 21.2 File Attachment Tab section of this manual 

 

Remarks Tab 

The Remarks tab is a free form text tab. Any comments or remarks pertaining to the equipment are recorded 

on the Remarks tab. For example, the amperage, voltage, and cycles can be specified here if the equipment is 

an electric motor. These comments and remarks are viewed by all who have access to this tab. The Remarks 

label on the tab turns blue and an icon is present when entries are made on the tab. 

 

Messages Tab 

Refer to Item 21.5 Messages Tab section of this manual. 

Standard Jobs Tab 

The Standard Jobs tab lists all the standard jobs for the specified equipment. Jobs are added to the tab 

automatically by the system when the standard jobs are created. 

 

Standard jobs are created by the central office. Some fields on the standard job can be edited by authorized users 

at the ship level. Open the standard job listed on the Standard Jobs tab to view details about that job.  

The fields on the Standard Jobs tab are: 

• Job Size – the size of the job. This rating is from 1-99.   

• Job Name – the name of the job 

• Interval – the time frame between this job and the next time it is to be performed.  

• Last Done – when the job was last completed 

• Price – the cost of the job 



  Nautical Systems Enterprise Maintenance User Manual 

©2020 American Bureau of Shipping and affiliated companies. All rights reserved. This document contains proprietary and confidential information for review and discussion 

purposes only. No part of this document may be used, disclosed, copied, or distributed, by any form or any means, without the express written consent of the American Bureau 

of Shipping.   

       PROPRIETARY AND STRICTLY CONFIDENTIAL. DISTRIBUTION TO THIRD PARTIES IS STRICTLY PROHIBITED.          P a g e  | 74 

Double click on a standard job on the Standard Job tab to open. 

Maintenance History Tab 

The Maintenance History tab displays the maintenance history of the equipment. This history has been divided 

by sub-tabs into two categories.  

 

The Maintenance sub-tab contains the information previously available on the Maintenance History tab. It 

lists all the documents associated with maintenance on the specified equipment. These documents are work 

orders, service requisitions, no action jobs and service purchase orders. Documents are added to this tab when 

they are created if they specify this equipment.  

The fields on the Maintenance sub-tab are: 

• Document Number – the maintenance document name and number. 

• Scheduled – the scheduled date of the maintenance 

• Completed – the date the maintenance was completed 

• Status - indicates whether the work is scheduled (SCHD or S), completed (CMPL or CP), closed 

(CLOS or CL) or cancelled (CANC or X).  

• Job Title – the title of the maintenance as listed on the work order or service purchase order 

• F(Findings) – an icon in this column indicates that entries are made on the Findings tab of the Work 

Order.   

 
NOTE:  Double click on any of the documents listed on this sub-tab to open the document.  

 

The Condition sub-tab contains the information from the Machinery Health window that was added when the 

summary report from the condition monitoring analyst was imported.  
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The fields on the Condition sub-tab are: 

• Report ID – the number of the summary report. Click on the Report ID to open the Condition 

Monitoring Report. 

• Date – the date of the visit by the condition monitoring analyst. 

• Source – The Sources tab displays information regarding all vendors that have supplied the part or a 

quotation of a price for the part. 

• CM Type – the type of condition monitoring checked for the report. Double click in this field to open 

the CM Status Detail window. 

• Status – the condition monitoring status according to the summary report. Double click in this field to 

open the CM Status Detail window. 

• Problem – the problem with the equipment associated with the condition monitoring type designated 

by the summary report. Double click in this field to open the CM Status Detail window. 

• Recommendation – the recommendation by the monitoring analyst to fix the problem. Double click in 

this field to open the CM Status Detail window. 

• WO Number – the number of the work order to do the work recommended in the Recommendation 

field. This field is completed by the system when the work order is created from the Condition 

Monitoring Report.  

 
NOTE:   Double click on the work order listed on this sub-tab to open the document.  

 

• Last column – the last column does not have a heading, but this column contains an Attachment icon 

if there is an attachment on the CM Status Detail window. 

 

Documents Tab 

The Documents tab lists all the documents associated with the purchasing and inventory on the specified 

equipment. These documents are requisitions, request for quotations, purchase orders and invoices. Documents 

are added to this tab when they are created and involve this equipment. Some fields on these documents can be 

edited by authorized users at the ship level. 
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The fields on the Documents tab are: 

• Document Type – the type of document  

• Document Number – the document number 

• Ship Name – the name of the ship where the specified equipment is located 

• Date – the date the document was created  

Double click the document in the Documents tab and it opens. 

Maintained Parts Tab 

The Maintained Parts tab displays the list of maintained parts for a piece of equipment. Maintained parts are 

different than the Parts listed in the hierarchy because they track the maintenance and running hours of a 

specific part. The Parts listed on the hierarchy are more generalized and used for inventory.  

For example, a ship’s engine can have “x” number of cylinders. All these cylinders are exactly the same. So, 

for inventory purposes, “x” number of cylinders are listed plus any of the same cylinders that might be in spares. 

But, for maintenance purposes each cylinder has a different history. One cylinder may have been repaired twice 

with 10,000 running hours, whereas another cylinder may be brand new with zero running hours. This 

information is specific to a particular part and needs to be recorded. This is the maintained part. 

 

Maintained parts are displayed in the Maintenance view on the hierarchy of the Equipment Explorer. 

The fields on the Maintained Parts tab are: 

• Name – name of the maintained group or part 

• Status – indicates whether the part is Active or Inactive 

• Serial Number – the serial number of the specific part 
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Create a New Maintained Group 

A maintained group is a group of maintained parts that share a common characteristic.  

1.   Click the Group button from the Equipment toolbar or Maintained Parts menu option New→Group 

to add a maintained group. 

 

• The Maintained Part Group – New window opens. 

 

3. Type the name of the maintained part group in the Name field. THIS IS A REQUIRED FIELD. 

4. Click the OK button to save the name and close the Maintained Part Group – New window. 

• The Maintained Part Group name is displayed on the Maintained Part tab. 

 

Create a New Maintained Part 

Maintained parts are created from parts. The part must exist before it can be specified as a maintained part.  

1.   Click the Maintained Part button from the Equipment toolbar or Maintained Parts menu option 

New→Maintained Part when the Maintained Part tab is active to add a maintained part. 
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• The Equipment Explorer window opens with the selected equipment highlighted in the window. 

2.   Click the + sign next to the selected equipment to expand the list to display the parts created under the 

selected equipment.  

3.   Click to highlight the part. 

 

4.   Click the Select button on the Equipment Explorer toolbar to select the part. 

• The Maintained Part – New window opens. The name of the part is in the Name field. 

 

5.   Click the radio button in the Create section to select if one or more of these maintained parts are to be 

created. The No. of Maintained Parts field opens if the Multiple radio button is clicked. 

Type the number of maintained parts to be created in the No. of Maintained Parts field if several of these parts 

are to be created. 

Click the radio button in the Number/Abbreviation field to select the designation to be used to differentiate 

the parts – No. or #. This field becomes available when the Multiple radio button is clicked. 

Once new maintained part is saved, it will display on the maintained parts tab of the equipment record. 
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The other fields on the Maintained Part window are: 

Field  Description 

Referenced Part 

Name 

The Referenced Part Name field contains the name of the part listed in inventory. 

This field is automatically filled by the system. 

Serial Number The Serial Number field is the main field that distinguishes this part from all the 

other parts. For example, a ship’s engine may have several cylinders that are 

exactly alike. The serial number is what distinguishes one cylinder from the others.  

Date Acquired Click the Calendar button at the end of the Date Acquired field to select the date 

the part was acquired. 

Expiry Date Click the Calendar button at the end of the Expiry Date field to select the date 

the part warranty expires. 

Status Click on the dropdown menu in the Status field to select whether the maintained 

part is Active on the ship or designated as Inactive.  

Code Type an alphanumeric part code in the Code field. This part code links an imported 

standard job to the maintained part. 

 

Serialized Item 

Required check box 

Click the Serialized Item Required check box to indicate that a serialized item 

must be installed for this part to be active. 

Location Type a location of the equipment in the Equipment Location field. This field is 

alpha-numeric with a maximum of 60 characters and is user defined. The 

Equipment Location field is included in the Equipment Details report and the 

Equipment Particulars portion of the WO / SR / NAJ form   

Manufacturer Click on the dropdown menu at the end of the Manufacturer field opens the 

Equipment Maker Search window.  On the Search Tab, the company type is 

defaulted to Equipment Maker.  Select any other filters that might apply.  Highlight 

the selected manufacturer to close the Equipment Maker Search window and 

display the value on the new maintained part screen. 

Model Type the model number of the equipment in the Model field.  

 

NOTE: The Model field applies to equipment and NOT to 

consumables. 
 

Type Type the kind of equipment in the Type field.  

 

NOTE: The Type field applies to equipment and NOT to 

consumables. 
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Field  Description 

Size Type the size of the equipment, if applicable, in the Size field. 

 

NOTE: The Size field applies to equipment and NOT to 

consumables. 
 

Part Criticality Click on the dropdown menu at the end of the Part Criticality field to open the 

Part Criticality Selection window.  Select the part criticality by highlighting and 

clicking the right arrow to move it from the left side of the window to the right 

side.  Click the OK button when finished.  More than one criticality can be selected 

for a maintained part. 

Open Part button Clicking on the Open Part button opens the part record for the part listed in the 

Name field of the new Maintained Part window. 

Remarks Click in the Remarks field to make notes regarding the maintained part. These 

remarks remain as part of the record for this part. 

Class Data section The Class Data section was added to include classification information. The fields 

in this section are: 

• Class Code – classification code which is the UID of the vessel  

• HID – Hierarchy Identification Number 

• Class Equipment Name – the name by which the equipment associated 

with this maintained part is referenced by the class society 

 

NOTE: Only authorized users can add or edit information in these 

fields. 
 

 

6.  Click the Save button in the Maintained Part – New window to save the information and close the 

Maintained Part – New window. 

The maintained part is displayed on the Maintained Part tab. 

 

Open a Maintained Part  

Double click on the maintained part from the Maintained Part tab. 

 

• The Maintained Part window opens. 
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Delete a Maintained Part 

1.   Click to select a maintained part from the Maintained Part tab. 

2.   Click the Delete button from the Equipment toolbar to delete the selected maintained part. 
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• A delete confirmation message box opens.  

3.   Click the Yes button in this confirmation box to delete the selected part and close the confirmation box. 

The selected maintained part is deleted from the Maintained Parts tab. 

 
NOTE:   Parts in a Maintained Part Group MUST be deleted before the maintained group 

can be deleted.  Follow steps 1 and 2 above to delete each part in the Maintained 

Group individually. Then the Maintained Group can be deleted using the same 

procedure.  

 

Hide a Maintained Part 

Hiding a part removes the part from view on the Equipment Explorer window or the Maintained Parts tab.  

1.   Click to select a maintained part from the Maintained Part tab. 

2.   Click the Hide button from the Equipment window toolbar to hide the selected maintained part from 

view. 

 
 

A confirmation message box opens verifying that the selected part is to be hidden.  

 

3. Click the OK button to hide the part and close the message box and close the message box. The selected 

part is hidden from view. 
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View a Hidden Maintained Part 

 

1.   Click the Toggle Hidden Record Display Mode button from the Navigator pane on the Maintenance 

and Purchasing window. 

2.   Open the Equipment Explorer window.  

3.   Click to select the equipment from the left side of the Equipment Explorer window. 

4.   Click the Open Left Pane Item button on the Equipment Explorer toolbar to open the Equipment 

window. 

5.   Click the Maintained Parts tab.  The previously hidden part is shown on the tab. 

Unhide a Hidden Maintained Part 

 

1.   Follow the steps in the View a Hidden Maintained Part portion of this section to view the hidden part. 

2.   Click the hidden maintained part to select. 

3.   Click the Hide button from the Equipment window toolbar to unhide the selected maintained part from 

view. 

 
• A confirmation message box opens verifying that the selected part is to be unhidden.  

4. Click the OK button to unhide the part and close the message box. The previously hidden part is visible 

again. 
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Local Description Tab 

The Local Description tab is a free form text tab. Use this tab to type information about the equipment in a 

language other than English. This information is viewed by all who have access to this tab. 

 

DMS Link Tab 

Refer to Item 21.8 DMS Link Tab section of this manual. 

 

Custom Forms Tab 

Refer to Item 21.3 Custom Forms Tab section of this manual 

 

Condition Monitoring Tab 

 
NOTE:  Equipment MUST be set up for condition monitoring before it is available from any 

Equipment field associated with condition monitoring. 

 

Select the condition monitoring types associated with the equipment on the Condition Monitoring tab.  

1.   Click the Condition Monitoring check box to indicate that the equipment is being monitored.  

 
NOTE:  This check box MUST be checked before condition monitoring types can be linked. 

 

 
 

2.   Click the Link / Unlink Condition Monitoring button on the Equipment window toolbar.  

• The Condition Monitoring Type Selection window opens.  



  Nautical Systems Enterprise Maintenance User Manual 

©2020 American Bureau of Shipping and affiliated companies. All rights reserved. This document contains proprietary and confidential information for review and discussion 

purposes only. No part of this document may be used, disclosed, copied, or distributed, by any form or any means, without the express written consent of the American Bureau 

of Shipping.   

       PROPRIETARY AND STRICTLY CONFIDENTIAL. DISTRIBUTION TO THIRD PARTIES IS STRICTLY PROHIBITED.          P a g e  | 85 

 

 
NOTE:  Condition monitoring types and statuses are created in the General Data module by 

authorized users.  

3. Double click on a selection on the left side of the Condition Monitoring Type Selection window to 

move it to the right side of the window.  

4. Continue making selections until all condition monitoring types associated with the equipment are listed 

on the right side of the window. 

5. Click the OK button to close the Condition Monitoring Type Selection window and add the selections 

to the Condition Monitoring tab. 

 

Serialized Items Tab 

When this tab is selected, Serialized Item menu options are available.  The menu options allow the user to 

Install, Remove, View Installed Item, Create Serialized Item, Edit Serialized Item or Change the Status 

of a Serialized Item.  Serialized Item Tab displays a list of all serialized parts with the same SI reference. 
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Menu Option Description 

 Install Select the Install option to install the part as a serialized item. 

 Remove The Remove option becomes available when the maintained part has 

been installed as a serialized item.  

Select the Remove option to remove the part as a serialized item. A 

serialized item is removed to be repaired, used as a spare part, or 

discarded. Discarded items CANNOT be installed again.  

View Installed Item Selecting this menu option opens the selected serialized item on the 

Serialized Item Tab to allow the user to view the details for the serialized 

item. 

Create Serialized Item Before selecting this menu option, the SI reference must have been 

selected.  Selecting this menu option allows the user to create a new 

serialized item. 

Edit Serialized Item Selecting this menu option opens the selected serialized item on the 

Serialized Item Tab to allow the user to edit the details for the serialized 

item. 

Change Status Selecting this menu option opens the selected serialized item on the 

Serialized Item Tab to allow the user to edit the Status field for the 

serialized item. 

 

Add or Edit a Serialized Item 

 

Refer to Section 8 of this manual, for a detailed information on the processes, tabs, and fields. 

 

  Add or Edit a Part 

Parts can be added to equipment from the fleet or ship view as well as from the purchasing or maintenance 

view. However, parts that are added from the maintenance view are not visible on the maintenance hierarchy. 

Only maintained parts are visible on the maintenance view of the hierarchy. 
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NOTES:    

• Parts can only be added under Units, Components or Assemblies on the hierarchy.  

• For Part Entry, the system validates Part PIN duplication based on the system 

preference “Validate Part PIN Duplicate”. 

 

The procedure for adding a part is the same no matter which view it is created from. The fleet view allows the 

central office to add parts to any or all ships in the fleet at one sitting.  A ship can only add parts to itself in the 

ship view. 

1.   Open the Equipment Explorer window.  

2.   Click the New Part button on the Equipment Explorer toolbar to open the Part – New window. The 

name of the ship and the name of the equipment that the new part is subordinate to are displayed in the 

first line of the window.  

 

 

Editing a part can only be done in the purchasing view from either the fleet or ship views.  Open the Part 

window from the Equipment Explorer and edit the necessary fields. The fields and procedures to edit them 

are the same as adding a new part. 

1. Click to select a part from the left pane of the Equipment Explorer window to edit a part that has 

already been created. 

2. Click the Open Left Pane Item button on the Equipment Explorer toolbar to open the selected part.  



  Nautical Systems Enterprise Maintenance User Manual 

©2020 American Bureau of Shipping and affiliated companies. All rights reserved. This document contains proprietary and confidential information for review and discussion 

purposes only. No part of this document may be used, disclosed, copied, or distributed, by any form or any means, without the express written consent of the American Bureau 

of Shipping.   

       PROPRIETARY AND STRICTLY CONFIDENTIAL. DISTRIBUTION TO THIRD PARTIES IS STRICTLY PROHIBITED.          P a g e  | 88 

 

The options on the Part window menu bar are: 

Option Description 

File→ The File menu contains options to manipulate a file.  

 Save Select the Save option / button to save any changes made on the 

Part window. 

       Relog This allows the user to replicate this document to all applicable 

remote sites for either a missing document or inconsistent data 

between sites.  

Part No. Ref→ The Part Number Reference menu contains the option to link or 

unlink a part number reference manual to the part.  

 
NOTE:  Part number references MUST be created 

prior to part creation. Part numbers are used 

extensively throughout the Maintenance and 

Purchasing module. Having the correct part number 

and its corresponding reference manual is essential. 

The part number reference selected for the unit, component, or 

assembly that this part is under in the hierarchy is selected by 

default. New part number references can be added, but this default 

reference CANNOT be deleted unless it is deleted from the parent 

unit, component, or assembly. 
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Option Description 

Link/Unlink Part No. 

Reference 
 

Select the Link/Unlink Part Number Reference option / button 

to open the Part Number Reference Lists window. 

Double click on the reference manual on the left side of the 

window to move the selection to the right side of the window.  

Click the OK button to accept the selections on the right side of 

the window, close the Part No. Reference Lists window and list 

the selected reference in the Part Number / Reference field of the 

Part window. 

Requisitioning→ The Requisitioning menu contains options to create requisitions 

to replenish this part to the maximum, minimum or reorder level 

designated on the Inventory tab of the Part window. 

The Inventory Replenishment Preview option creates a report 

with information on the part to help determine whether a 

requisition needs to be created. 

The Inventory Replenishment adds the part to an existing 

requisition for the equipment the part is under in the hierarchy if a 

requisition exists that has NOT been approved. A new requisition 

is created if none exists or one has already been approved.  

Locations→ The Locations menu contains options regarding storage and 

removal of inventory.   The Locations menu options is only for 

parts. 

 Storage Locations 

 

The Storage Locations option / button opens the Storage 

Locations window for the selected part. These storage locations 

are used on the Inventory tab of the Part window. Storage 

locations are used mainly in the Purchasing module.  

 Delete Inventory Data 

    

The Delete Inventory Data option / button deletes the selected 

storage locations and the quantity on hand information from the 

Inventory tab of the Part window.  

 

NOTE:  BE CAREFUL! The information CANNOT 

be retrieved once the button or option is selected and 

the information is deleted.  
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Option Description 

Reports→  The Reports menu contains options to create different kinds of 

reports. 

Any report selected opens the Report Options window. Click the 

radio button to select where this report should be sent. The options 

are: 

• Screen – displays the formatted report on the screen. Click 

the OK button to generate the report. The report displays 

on the monitor when it is complete. 

• Printer/Fax – sends the report to the assigned printer. The 

Print window opens when the report is complete to select 

the printer. 

• File – the field next to the File radio button opens when 

this option is selected. Click on the dropdown menu to 

select the type of format for the saved report. Click the 

OK button. The Save As window opens to select the 

directory where the report is to be saved. 

• Email - The Email option allows the user to attach the 

report to a MS Outlook message. 

 Time Phased Part Usage The Time Phased Part Usage report is a report of the usage of the 

selected part as indicated through purchase orders and 

requisitions. Click the Calendar button at the end of the Start 

Date and End Date fields to select the time frame for the report. 
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Option Description 

       Print Labels 

 

The Print Labels option prints labels containing the following 

information: 

•  Ship 

•  Equipment 

•  Manufacturer 

•  Part name 

•  Pin 

•  Location (2 sections) 

•  Number of parts available 

•  Date labels were printed 

•  Bar code of part 

There are two options in the Select Number of Labels to Print 

portion of the Report Option window to print labels: 

•  Per Items on Hand– this option prints one label for the part 

unless the Multiple Labels check box on the Part 

window is checked. Then it prints one label for every part 

on hand of that part. For example, there are 3 pistons on 

hand according to the Inventory tab on the piston Part 

window. The Multiple Labels check box is NOT checked 

so only 1 label for pistons is printed regardless that there 

are 3 on hand. However, using the same example, the 

Multiple Labels check box is checked, and three labels 

are printed for pistons. 

• Other Number – the Other Number option prints the 

number of labels specified in this field for each storage 

location if the Multiple Labels check box is checked. For 

example, the number 2 is typed in the Other Number 

option field. There are 3 roller bearings in Storage A and 

3 roller bearings in Storage C. Two labels are printed for 

roller bearings in Storage A and 2 labels are printed for 

Roller Bearings in Storage C.  Only one label per storage 

location is printed if the Multiple Labels check box is 

NOT checked regardless of the value typed in the Other 

Number field. 

At this time only 4 x 2-inch labels are available. 

 Part Detail The Part Detail report displays information from the fields on the 

Part window as well as the Inventory tab and Local Description 

tab. 
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Option Description 

Print SI Labels The Print SI Labels option prints labels for serialized items. 

Help The option in the Help menu is Help. Select this option to open 

the online help. 

 

The fields on the Part window are: 

 

1.   Click in the Brief Name field to type the name of the part. THIS IS A REQUIRED FIELD with a 

maximum of 40 characters.  

 There is no naming convention, but the name of the part should identify the part. This is important when 

there are multiple parts with the same name on board. 

 
NOTE:   Whatever is typed in the Brief Name field is repeated in the Full Description field 

when the cursor is moved out of the Brief Name field. 

 

2.   Click the dropdown menu at the end of the Unit field to select the unit of measure used for this part. 

The Available Units window opens with a list of units of measure. Authorized users can add new units 

of measure from this window or the General Data module.  

  

This is a required field that is automatically filled as “Pieces” by default. This default value can be changed. 

The Unit field can only be edited for an existing part if: 

• The part information has NOT been replicated  

• A spares record has NOT been created 

• This part is not included in any document such as a purchase order or requisition 

 
NOTE:   Inventory quantities MUST be adjusted manually if the unit of measure is changed. 

A warning message box opens stating this fact. 
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3.   Click on the dropdown menu on the Designation field to select the classification. THIS IS A 

REQUIRED FIELD that is automatically filled by default. This default value can be changed. 

The options in this field vary depending on the position in the hierarchy.  

The options are Part or Assembly if it is directly under a Unit or Component. 

 

 

The options are Part or Subassembly if it is under an Assembly or Subassembly. 

 
 

 

The option is Part if it is under a Part. 

 
 

 

The options are Item or Group if it is under a Consumable Type. 

 
 

 

The options are Item or Subgroup if it is under a Group or Subgroup. 

 

The option is Item if it is under an Item. 
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Other fields on the Part window are: 

Field Description 

Full Description Whatever is typed in the Brief Name field is copied to the Full Description 

field. The Full Description field is used to type more details or an expanded 

explanation of the Brief Name field.  

Part Number and 

Reference 
NOTE:  Part number references MUST be created prior to part 

creation. Part numbers are used extensively throughout the NS Enterprise 

Maintenance and Purchasing module. Having the correct part number and 

its corresponding reference manual is essential 

The Reference portion of this field is automatically filled with the Reference 

selected for the Unit, Assembly or Component that this part is under in the 

hierarchy. New part number references can be added, but this default 

reference CANNOT be deleted unless it is deleted from the parent unit, 

component, or assembly. 

Click the Link / Unlink Part No. Reference button on the toolbar to add or 

delete a part number reference. See Link/Unlink Part No. Reference in the 

menu and toolbar table for the Part window preceding this section for details 

on linking or unlinking part number references. 

Click in the Part Number field of the selected reference to add the part 

number for this part. 

PIN Number Type the PIN number in the PIN Number field. The PIN number is used to 

distinguish a part or consumable item from other parts with the same name. 

The same PIN number can be used for several parts with different names if 

the part is the same.  

The PIN number has the same function as the interchangeability term used in 

the Interchangeable field. This field indicates any parts designated as 

interchangeable with this part.    
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Field Description 

Interchangeable Identical parts installed in unrelated equipment or called by a different name 

are defined as interchangeable. These parts are linked by a common index 

term that is defined in the Part Interchangeability window. 

Click the dropdown menu at the end of the Interchangeable field to identify 

this part with an interchangeability index term. A message box opens 

cautioning that interchangeability is irreversible and verifying that you want 

to continue.  

 

Click the Yes button to proceed. The Available Interchangeabilities 

window opens. Defined interchangeability terms are listed on this window. 

Authorized users can add new terms to this window. 

All parts with the same index term selected in the Interchangeable field can 

be substituted for each other. These parts can be instantly found in any storage 

location by clicking the Find a Part button on the Equipment Explorer 

window and searching by the Interchangeable field. The stock of 

interchangeable parts is included in the inventory count of the particular item 

in certain inventory reports.  

Item Category Item Category is used to categorize items for reporting purposes. 

Click the dropdown menu at the end of the Item Category field to select a 

category. The Item Category List window opens with a list of categories 

defined in the General Data module. Authorized users can create more 

categories from the Item Category List window.  

MARAD No. The MARAD number is available to companies upon request. It is used to 

identify the inventory, such as the part’s specific location. The MARAD 

number differs from the PIN number because a PIN number is the same 

across the fleet whereas the MARAD number is specific to a ship or 

warehouse.  

Qty. Working Type how many of this part are being used in the piece of equipment in the 

Qty. Working field.  

Multiple Labels check box Click the Multiple Labels check box to print more than one label for this 

part. The number of labels printed depends on the selection made when the 

Print Labels option is selected on the Report menu of the Parts window 

menu bar. 

Only one label prints for the part regardless of how many of this part is in 

inventory if this check box is unchecked. It is unchecked by default.  
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Field Description 

Override Price History 

check box 

The Override Price History check box and the Estimated Cost field work 

together. NS Enterprise uses the pricing history for a part as the basis of any 

pricing used in reports. The pricing history is created from past purchase 

orders and requests for quotations (RFQ) for this part. 

Click the Override Price History check box to disregard any price history 

and use the value in the Estimated Cost field for these reports.  

 

NOTE: Checking this check box has NO validity if no price 

history for this part is available or no value is listed in the 

Estimated Cost field.  
 

Criticality Index Click the dropdown menu at the end of the Criticality Index field to open 

the Part Criticality window.  Highlight the criticality index term and click on 

the arrow to move the criticality term to the right-hand portion of the screen.  

Once all Criticality terms are selected click the OK button to close the 

window and bring all selected terms to the Part screen. 

Estimated Cost Type the estimated cost of this part in the Estimated Cost field.  

The Estimated Cost field is associated with the Override Price History 

check box. NS Enterprise uses the pricing history for a part as the basis of 

any pricing used in reports. The pricing history is created from past purchase 

orders and requests for quotations (RFQ) for this part. However, the value in 

the Estimated Cost field is used if the Override Price History check box is 

checked.  

Actual Cost button Click the Actual Cost button to calculate the cost of the part as specified in 

the Inventory Valuation Method system preference in the System 

Administration module. The actual cost is calculated by averaging the last 

3 prices on the price history for the part.  

The value in the Actual Cost field is calculated in real time when the button 

is depressed and is only available when calculated. This value is not retained 

after the Part window is closed. The actual cost of the part can be recalculated 

every time the Part window is opened.  

Barcode The code assigned to the part to which it can be identified. 

User Defined  

 

 

Inventory Tab 

The Inventory tab on the Part window contains information regarding the inventory of this part for the selected 

ship or warehouse. This includes the maximum, minimum and reorder level for this part as well as where the 

parts are stored and the number of spare parts on hand. The Inventory tab contains information that is applicable 

to purchasing. 
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Other Sites Tab 

The Other Sites tab displays the quantity-on-hand of the part on each ship that carries this part in its inventory. 

Sites are copied to this tab from the Cross References Tab of the equipment that the part is under in the 

hierarchy. 

 
NOTE:   Information on this tab is only visible to the central office. The shipboard database 

does NOT display this information. 

The Other Sites tab contains information that is applicable to purchasing.  

 
 

Material Contracts Tab 

The Material Contracts tab displays all material contracts that include this part.  

 
NOTE:  Contracts are only used for material purchases NOT for service.  

The Material Contracts tab contains information that is applicable to purchasing.  

 

File Attachments Tab 

Refer to Item 21.2 File Attachment Tab section of this manual. 
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The tab name turns blue and an icon is added in front of the tab name when entries are present on the tab.  

 
 

Sources Tab 

The Sources tab displays information regarding all vendors that have supplied the part or a quotation of a price 

for the part. This information is automatically added to the tab by the system whenever a purchase order or 

request for quotation (RFQ) is created for this part.  The Sources tab contains information that is applicable to 

purchasing.  

 
 

PO History Tab 

The PO History tab displays the purchasing history of the part through purchase orders. This tab contains 

information that is applicable to purchasing. 

 
 

Documents Tab 

The Documents tab lists all the documents associated with the purchasing and inventory on the specified part. 

This tab contains information that is applicable to purchasing. 



  Nautical Systems Enterprise Maintenance User Manual 

©2020 American Bureau of Shipping and affiliated companies. All rights reserved. This document contains proprietary and confidential information for review and discussion 

purposes only. No part of this document may be used, disclosed, copied, or distributed, by any form or any means, without the express written consent of the American Bureau 

of Shipping.   

       PROPRIETARY AND STRICTLY CONFIDENTIAL. DISTRIBUTION TO THIRD PARTIES IS STRICTLY PROHIBITED.          P a g e  | 99 

 
 

Messages Tab 

The Messages tab on the Part window works the same as the Messages Tab on the Equipment window. 

 
 

Local Description Tab 

The Local Description tab is a free form text tab. Use this tab to type information in a language other than 

English. This information is viewed by all who have access to this tab. 

 
 

Serialized Items Tab 

Serialized Item Tab displays a list of all serialized parts with the same SI reference number.  Users can create 

new serialized items or edit an existing Serialized Item from this tab. 
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Other Site Reference Tab 

Displays all vessels where the part is used.  This is applicable for equipment that is cross referenced.  If the 

reference tab is checked, then inventory from other vessels is displayed in the Other Sites Tab. 

 
 

DMS Link Tab 

The DMS Link tab is used to attach documents from the Document Management System (DMS) module to 

the part. 

The fields on this tab are: 

• Display Name - the name of the part  

• Size - the size of the part  

• Type - the type of part 

 
NOTES: The Document Management System module is one of the web-based modules 

in NS Enterprise. It is used to store, organize, and track electronic documents 

and images. These documents can then be linked to parts and documents within 

NS Enterprise.  

               The DMS Link tab is only available if the Document Management System 

module is part of your company’s NS Enterprise suite of modules. 
 

1. Click the Link button from the toolbar of the Part window to add a document to the tab. 

 
NOTE:   Be sure the DMS web app configuration has the correct server and IP address. 

2.   Another window opens with the hierarchy from the Document Manager.  

3.   Navigate through the folders until the document to be linked with the part is located. 

4.   Click the check box preceding the documents to be linked. 

5.   Click the Select button to close the Document Manager window and add the selections to the DMS 

Link tab. 
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Delete a Document 

1.   Highlight a document on the DMS Link tab.  

2.   Click the Delete button on the Part window toolbar to delete the selection from the tab.  

 
NOTE:  The right mouse button can be clicked anywhere on the DMS Link tab to get the same 

options. 

 

Custom Forms Tab 

Refer to Item 21.3 Custom Forms Tab section of this manual 

 

Maintained Part Window 

Maintained parts are created and viewed differently from other parts. Maintained parts are created from the 

Maintained Parts tab of the Equipment window.  

Maintained parts can only be seen in the hierarchy when View → Maintenance is selected on the Equipment 

Explorer menu bar.  

1.   Select a maintained part from the hierarchy.  

2.   Click the Open Left Pane button on the Equipment Explorer toolbar to open the Maintained Part 

window.  
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The options / buttons on the Maintained Part window menu bar and toolbar are: 

Option  Description 

File→ The File menu contains options to manipulate a file.  

Save 

 

Select the Save option / button to save any changes made on the 

Maintained Part window. 

Standard Job→ The Standard Job menu contains options on opening a standard job. 

      Open Select the Open option / button to open the selected standard job. 

Serialized Items The Serialized Items menu contains options is available when user selects 

Serialized Items Tab. 

 Install Select the Install option to install the part as a serialized item. 

 Remove The Remove option becomes available when the maintained part has been 

installed as a serialized item.  

Select the Remove option to remove the part as a serialized item. A 

serialized item is removed to be repaired, used as a spare part, or discarded. 

Discarded items CANNOT be installed again.  

View Installed Item Selecting this menu option opens the selected serialized item on the 

Serialized Item Tab to allow the user to view the details for the serialized 

item. 

Create Serialized Item Selecting this menu option allows the user to create a new serialized item.  

The Serialized Item Reference must first be populated on the Serialized Item 

Tab before the Serialized Item - New window opens. 

Edit Serialized Item Selecting this menu option opens the selected serialized item on the 

Serialized Item Tab to allow the user to edit the details for the serialized 

item. 

Change Status Selecting this menu option opens the selected serialized item on the 

Serialized Item Tab to allow the user to edit the Status field for the 

serialized item. 
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Option  Description 

Reports→ The Reports menu contains options to create different kinds of reports. 

Any report selected opens the Report Options window. Click the radio 

button to select where this report should be sent. The options are: 

• Screen – displays the formatted report on the screen. Click the OK 

button to generate the report. The report displays on the monitor 

when it is complete. 

• Printer/Fax – sends the report to the assigned printer. The Print 

window opens when the report is complete to select the printer. 

• File – the field next to the File radio button opens when this option 

is selected. Click on the dropdown menu to select the type of format 

for the saved report. Click the OK button. The Save As window 

opens to select the directory where the report is to be saved. 

• Email - The Email option allows the user to attach the report to a 

MS Outlook message. 

Work History 

and Schedule  

  

The Work History and Schedule report displays all the work orders for 

the maintained part. Click on the dropdown menu in the Desired Format 

field to select the format of the report. The options are: 

• Summary – displays a summary of all the work orders for the 

selected part. This includes the scheduled date of service, work 

order number, part name, job title, last date service was performed, 

the interval between service and the job category. 

• Work Specifications – displays only the work specifications which 

include the job category, scheduled date of service, work order 

number and job title. 

• Detail Format - displays all work orders in detail. This includes 

such details as the estimated labor and cost data, materials required 

and used, work order description and findings. 

Click the radio button to select if all or individual work orders are to be 

selected for this report. A list of work orders associated with the maintained 

part are listed if the Selected ratio button is clicked. Click the check box of 

the work orders to be included on the report.  

Click the OK button to generate the report. 

Work 

History/Findings 
 

The Work History/Findings report displays the completed work orders 

and findings for a specified time frame. 

Help The option in the Help menu is Help. Select this option to open the online 

help. 

 

The Maintained Part window has fields and tabs. The tabs are explained in their own sections, but the fields 

are explained in the following table. 
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The name of the equipment that the maintained part is under in the Equipment Explorer hierarchy and the 

name of the maintained part are displayed in the first field. 

Field  Description 

Name The Name field contains the name of the part and a number. This number 

distinguishes this part from other parts if more than one maintained part was 

created. 

Referenced Part 

Name 

The Referenced Part Name field contains the name of the part listed in inventory. 

Serial Number The Serial Number field is the main field that distinguishes this part from other 

parts. For example, a ship’s engine may have several cylinders that are exactly 

alike. The serial number is what distinguishes one particular cylinder from the 

others.  

Date Acquired Click the Calendar button at the end of the field to select the date the part was 

acquired. 

Expiry Date Click the Calendar button at the end of the field to select the date the part 

warranty expires. 

Status The Status field displays whether the maintained part is Active/Inactive on the 

ship or has been removed.  

Click on the radio button to select a status. 

Code Type an alphanumeric part code in the Code field. This part code links an 

imported standard job to the maintained part. 

Serialized Item 

Required check box 

Click the Serialized Item Required check box to indicate that the maintained 

part is a serialized item.  

Location Type a location of the equipment in the Equipment Location field. This field is 

alpha-numeric with a maximum of 60 characters and is user defined. The 

Equipment Location field is included in the Equipment Details report and the 

Equipment Particulars portion of the WO / SR / NAJ form   

Manufacturer Click on the dropdown menu at the end of the Manufacturer field to open the 

Equipment Maker Search window.  On the Search Tab, the company type is 

defaulted to Equipment Maker.  Select any other filters that might apply and click 

Search to view a list of manufacturers.  Highlight the selected manufacturer to 

close the Equipment Maker Search window and display the value on the new 

maintained part screen. 

Model Type the model number of the equipment in the Model field.  

 

NOTE: The Model field applies to equipment and NOT to 

consumables. 
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Field  Description 

Type Type the kind of equipment in the Type field.  

 

NOTE: The Type field applies to equipment and NOT to 

consumables. 
 

Size Type the size of the equipment, if applicable, in the Size field. 

 

NOTE: The Size field applies to equipment and NOT to 

consumables. 
 

Part Criticality Click on the dropdown menu at the end of the Part Criticality field to open the 

Part Criticality Selection window.  Select the part criticality by highlighting and 

clicking the right arrow to move it from the left side of the window to the right 

side.  Click the OK button when finished.  More than one criticality can be 

selected for a maintained part. 

Open Part button Clicking on the Open Part button, opens the Part record associated with this Maintained 

Part. 

Class Data section The Class Data section was added to include classification information. The 

fields in this section are: 

• Class Code – classification code which is the UID of the vessel  

• HID – Hierarchy Identification Number 

• Class Equipment Name – the name by which the equipment associated 

with this maintained part is referenced by the class society 

 

NOTE: Only authorized users can add or edit information in these 

fields. 
 

Standard Jobs Tab 

The Standard Jobs tab lists the standard jobs that include this part. The information on this tab is taken from 

the standard job. 

Double click on a standard job on the Standard Jobs tab to open the job window. Only authorized users can 

enter or change information on the Standard Job window.  
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The fields on the Standard Jobs tab are: 

• Job Size Indicator –the Job Size Indicator defines the relationship of the job compared to 

other jobs under the same equipment or space. 

• Job Size Index – the Job Size Index categorizes machinery jobs. For example, a Major 

Overhaul for Unit #1 can be a job size index and all the smaller tasks involved in completing 

this job are given a Job Size Indicator.   

• Interval – the Interval is the time frame between when the job was last performed and the next 

time it needs to be performed. 

• Estimated Cost – the estimated price of performing the job that includes cost of personnel, 

tools, services, and materials. 

• Status – indicates the status of the standard job associated with the maintained part. 

 

Miscellaneous Work Tab 

Refer to Item 21.6 Miscellaneous Work Tab section of this manual. 

 

Maintenance History Tab 

The Maintenance History tab lists the documents associated with the maintenance on the specified maintained 

part. Tracking also includes individual maintained parts and equipment by serial number.  Landing order 

documents facilitate the movement of serialized items from one location to another.  These documents are work 

orders, service requisitions, no action jobs and service purchase orders that have the maintained part listed. 

Some fields on these documents can be edited by authorized users at the ship level. Documents are automatically 

added to this tab when they are created if they specify this maintained part. 

 

The fields on the Maintenance History tab are: 

• Document number – the maintenance document name and number. 

• Scheduled – the scheduled date of the maintenance 

• Completed – the date the maintenance was completed 

• Price – the price to do the job 

• Status - indicates whether the work is scheduled (SCHD or S), completed (CMPL or CP), 

closed (CLOS or CL) or cancelled (CANC or X).  
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• Job Title – the title of the maintenance as listed on the work order or service purchase order 

• F – an icon is displayed in this column if information is entered on the Findings tab of the 

document. Double click the icon to open the document. 

Double click on a document on the Maintenance History tab to open. 

Counter Data Tab 

 

The Counter Data tab displays the counter information recorded on the Counter Setup Tab of the equipment 

that the maintained part is under in the hierarchy. Only the Total Hrs Run field is editable from this tab.  

Admin Info Tab 

The Admin Info Tab identifies the Criticality for the maintained part, the Subject Index and ASTM Class 

associated to the Maintained Part. 

Serialized Items Tab 

 

The menu options allow the user to Install, Remove, View Installed Item, Create Serialized Item, Edit 

Serialized Item or Change the Status of a Serialized Item.  If there are serialized items with the same SI 

Reference as the Maintained Part and already associated to the maintained part, they will display on this tab.  

When creating a new Serialized Item, user must first select the SI reference on the Equipment 

record→Serialized Item Tab before selecting the menu option Serialized Item→Create New Serialized Item. 

Click on the menu option Serialized Item→Create Serialized Item to open the Serialized Item – New 

window. 



  Nautical Systems Enterprise Maintenance User Manual 

©2020 American Bureau of Shipping and affiliated companies. All rights reserved. This document contains proprietary and confidential information for review and discussion 

purposes only. No part of this document may be used, disclosed, copied, or distributed, by any form or any means, without the express written consent of the American Bureau 

of Shipping.   

       PROPRIETARY AND STRICTLY CONFIDENTIAL. DISTRIBUTION TO THIRD PARTIES IS STRICTLY PROHIBITED.          P a g e  | 108 

 

Menu Option Description 

 Install Select the Install option to install the part as a serialized item. 

 Remove The Remove option becomes available when the maintained part has been 

installed as a serialized item.  

Select the Remove option to remove the part as a serialized item. A serialized 

item is removed to be repaired, used as a spare part, or discarded. Discarded 

items CANNOT be installed again.  

View Installed Item Selecting this menu option opens the selected serialized item on the 

Serialized Item Tab to allow the user to view the details for the serialized 

item. 

Create Serialized Item Selecting this menu option allows the user to create a new serialized item.  

The Serialized Item Reference must first be populated on the Serialized 

Item Tab before the Serialized Item - New window opens. 

Edit Serialized Item Selecting this menu option opens the selected serialized item on the 

Serialized Item Tab to allow the user to edit the details for the serialized 

item. 

Change Status Selecting this menu option opens the selected serialized item on the 

Serialized Item Tab to allow the user to edit the Status field for the 

serialized item. 

 

Voyage Management Tab (Maintained Part) 

Currently as part of the Voyage Manager Module if the maintained part is identified as a Cylinder the user 

would enter/save in the min/max values on this tab.  As events occur on the voyage that record performance of 

the cylinder the values are validated against the min/max values.  In future releases more types of maintained 

parts will be included. 
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Serialized Item History Tab 

The Serialized Item History Tab displays a list of all serialized items that have been in this Maintained Part 

slot throughout the lifetime of the vessel.  The tab includes the name, serial number, date installed, date removed 

and document number. 

File Attachments Tab 

Refer to Item 21.2 File Attachment Tab section of this manual 

 

Message Tab 

Refer to Item 21.5 Messages Tab section of this manual. 

Custom Forms Tab 

Refer to Item 21.3 Custom Forms Tab section of this manual 

 Merge Parts 

Sometimes parts are created that actually are the same as another part. Both parts may also contain inventory. 

These parts can be merged into one part and their inventories merged in NS Enterprise. 

 
NOTE:   Only parts can be merged. Systems, equipment, consumable types, and components 

CANNOT be merged. 

1.   Select Inventory gadget→ Tools → Hide/Reclassify Equipment/Parts, Merged Parts from the 

Navigator pane on the Maintenance and Purchasing module at either the ship level or the fleet level. 

 

The Hide, Merge, Move Equipment/Parts Explorer window opens. This Explorer window has a different 

menu and toolbar than the Equipment Explorer used to create equipment and parts. This Explorer window is 

used specifically for hiding, merging, or moving equipment and / or parts and the menu bar and toolbar are 

equipped to perform those procedures. 
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2.   Drill down through the hierarchy to locate the parts to be merged.  

3.   Tick the check boxes preceding the parts to be merged. The parts are merged into the first part selected. 

For example, Merge Part A and Merge Part B are to be merged. If Merge Part A is selected before 

Merge Part B, the items in Merge Part B are merged into Merge Part A. If Merge Part B is selected 

before Merge Part A, then all items are merged into Merge Part B.  

 
NOTE:   All sub-items listed under the part are also merged so these check boxes do NOT 

need to be checked if the parent part is being merged. 

 

4.  Click the Merge button from the toolbar. 

 

• A message box opens confirming the merging of parts. 
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5.   Click the Yes button on the message box to confirm the merge and close the message box.  

The parts are merged into one part and the other selected parts are hidden. These parts can be used again, but 

they must be “unhidden”. 

 

 
NOTE:   Parts that are merged on one ship are also merged on all ships where the parent 

equipment is cross referenced.  

 Hide Equipment or Parts 

Equipment and parts that are no longer used can be hidden or archived to reduce the number displayed on the 

Equipment Explorer window. These same equipment and parts can also be viewed or “unhidden”.  

1.   Select Inventory gadget→ Tools → Hide/Reclassify Equipment / Parts, Merged Parts from the 

Navigator pane on the Maintenance and Purchasing window. 

 The Hide, Merge, Move Equipment/Parts Explorer window opens. This Explorer window has a 

different menu and toolbar than the Equipment Explorer window used to create equipment and parts. 

This Explorer window is used specifically for hiding, merging, or moving equipment and / or parts and 

the menu bar and toolbar are equipped to perform those procedures.  

2.   Drill down through the hierarchy to locate the equipment or parts to be hidden. 

3.   Click the check boxes preceding the equipment or parts to be hidden. 

More than one piece of equipment or part can be hidden at one time by clicking the check boxes for all 

equipment and parts that are to be hidden. 

 
NOTE:   All sub-locations listed under the hidden equipment or parts are also hidden so these 

check boxes do NOT need to be checked if the primary equipment or part is being 

hidden. 

4. Click the Hide button on the Hide, Merge, Move Equipment/Parts Explorer window. 

5. Select “Yes” or “No” to the confirmation/warning message “The inventory associated with 

equipment(s) / part(s) will not be accessible.” 

 

The selected equipment or part is removed from view on the Hide, Merge, Move Equipment/Parts Explorer 

window. 

 

View Hidden Equipment or Part 

1.  Click the Toggle Hidden Record Display Mode button on the Navigator pane toolbar from the 

Maintenance and Purchasing window. 

2.  Select Inventory gadget→ Tools → Hide / Reclassify Equipment / Parts, Merged Parts from the 

Navigator pane on the Maintenance and Purchasing window to open the Hide, Merge, Move 

Equipment/Parts Explorer window. The hidden equipment or part is displayed with a red “X” on the 

equipment or part icon. 
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Unhide Hidden Equipment or Part 

Unhiding equipment or parts is different than viewing them. They are visible in the hierarchy on the Equipment 

Explorer window without using the toggle. 

1.  Click the Toggle Hidden Record Display Mode button from the Navigator pane toolbar on the 

Maintenance and Purchasing window. 

2.   Select Inventory gadget→ Tools → Hide/Reclassify Equipment / Parts, Merged Parts from the 

Navigator pane on the Maintenance and Purchasing window to open the Hide, Merge, Move 

Equipment/Parts Explorer window. The hidden equipment or part is displayed with a red “X” on the 

equipment or part icon. 

3.   Click the Hide button on the Hide, Merge, Move Equipment/Parts Explorer window. 

The previously hidden equipment or part is again visible on the Hide, Merge, Move Equipment/Parts 

Explorer window. 

 Move Equipment or Parts 

Equipment and parts can be moved from one position on the hierarchy to another. The Tools menu does NOT 

list “Move” as an option, it is called “Reclassify Equipment”. It is called reclassify because it redefines the 

relationship of the part or equipment within the hierarchy.  

 
NOTE:   Equipment or parts CANNOT be moved to a location that is a sub-item of the 

equipment or part. For example, equipment CANNOT be moved “under” a part. 

 

There are two ways to move equipment or parts from one position in the hierarchy to another: 

• Drag and Drop 

• Conventional method 

 
NOTE:   Both methods move all sub-items listed under the equipment or parts. 

Drag and Drop 

1.   Click and hold the left mouse button on the equipment or part to be moved. 

2.   Continue depressing the left mouse button and “drag” the equipment or part to the destination location 

on the hierarchy. 

3.   Release the mouse button to “drop” the equipment or part into the destination location on the hierarchy. 

Conventional Method 

1.   Select Inventory gadget→ Tools → Hide/Reclassify Equipment / Parts, Merged Parts from the 

Navigator pane on the Maintenance and Purchasing window. 
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 The Hide, Merge, Move Equipment/Parts Explorer window opens.  

2.  Click the check boxes preceding the equipment or parts to be moved.  

 
NOTE:   All sub-items listed under the equipment or part are also moved so these check 

boxes do NOT need to be checked if the primary equipment or part is being moved. 

 

3.   Click to highlight the position where the equipment or parts are to be moved. DO NOT CLICK THE 

CHECK BOX! 

4.   Click the Move button on the Hide, Merge, Move Equipment/Parts Explorer window. 

 

• A message box opens to confirm the locations to be moved. 

5.   Click the Yes button on the message box to confirm moving the equipment or part and close the message 

box.  

• The equipment or part is moved.  

  Search for Equipment or Parts 

The Equipment Explorer provides options for locating parts or equipment. 

Find Part 

Locate a part with the Find Part button on the Equipment Explorer toolbar. 

1. Click the Equipment Explorer button from the Navigator pane toolbar on the Maintenance and 

Purchasing window.    

2. Click the Find Part button on the Equipment Explorer toolbar to search for a part by one of the 

options.  

 

            NOTE:  NS Search windows include: 

• If any document is edited, the document is marked with a Red color to indicate that   it has 

been edited. 

• If any document is edited and the document screen is closed, the row for that document will 

remain highlighted. 

• The edited documents indicator will be reset on Search button click. 
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2.   Click on the dropdown menu at the end of the Ship field to open the Ship List window.  To select/Tag all 

ships, click on the dropdown menu to the right of the Vessel Class column and choose Tag All.  To select 

individual ships, check the box (es) to the left of the Vessel Name.  
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3. Click in the field(s) to type the required parameter.  

 
NOTE:  Parameters must be entered in the correct case. The more parameters entered 

shortens the number of results found.  

• General section 

o Part Number  

o Part Number Reference  

o Pin Number 

o MARAD Number 

o ID/Bar Code – click the check box at the end of this field to open this field. Type the 

bar code or the ID number of the part for the query. Some fields in the Search 

Companion are disabled when this field is used.  

o Ignore Punctuation check box – click the Ignore Punctuation check box to ignore 

any punctuation in these fields 

• Description section – the Description section is used to find equipment or parts using 

specific words included in the Description field  

o Options:  Help to filter information entered in the Description section.  Only one 

choice can be selected. 

▪ All these Words 

▪ Any of these Words 

▪ The exact phrase  

o Find whole words only check box – click this check box to trigger the query to only 

find whole words used in the Search String field.   
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o Search String - type a word or words that may be included in the description of the 

part. 

• Index Term Section 

o Include Critical Parts Only check box – click this check box to only include parts 

that have the Critical check box on the Part window checked. 

o Criticality Index – click on the dropdown menu at the end of the field to open the list 

of criticality indexes.  Check the box (es) that will be applied to the query and click the 

OK button to return to the search companion window. 

o Interchangeability Term – click on the dropdown menu at the end of the field to open 

the Available Interchangeabilities window. Check the box (es) that will be applied to 

the query and click the OK button to return to the search companion window. 

o Item Category – click on the dropdown menu button at the end of the field to open the 

Item Category Selection window. Check the box (es) that will be applied to the query 

and click the OK button to return to the search companion window. 

o Serialized Item Reference – click on the dropdown menu at the end of the field to 

open the list for serialized item references. 

o Serialized Parts check box – click the check box to only include serialized parts. 

• Miscellaneous Section  

o Custom Forms - click on the dropdown menu at the end of the Custom Form field to 

select the custom form 

4 Click the Search button to generate the search. The right side of the window displays the items meeting 

the specified criteria when the search is complete. 

• “Critical” column is added in the search result screen for Find Part. 

 

Find Equipment 

1.   Click the Equipment Query button on the Equipment Explorer toolbar to search for equipment.  

• The Equipment Query window opens. 
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2.   Click in the field to type the required parameter or click the dropdown menu on the selected field for a 

list of options to search for the desired equipment.  

 
NOTE:  Parameters must be entered in the correct case. The more parameters entered 

shortens the number of results found.  

• General Section 

o Ship - click the dropdown menu at the end of the field for a list of ships. The ship name is 

automatically entered if the query is run from the ship level. Only one selection can be made. 

o Equipment Code – type the equipment code for the equipment 

o Complete Name (of the equipment) – a partial name can also be used 
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o Maintained Part check box – The check box by default is selected to include the maintained parts 

for the equipment. 

o Maintained Part Name – type the name of a specific maintained part in the Maintained Part 

field. 

o Keyword – type a word or words that may be included in the description of the equipment. 

• Particulars Section 

o Manuf. By Company check box – By default this is checked and will filter the search to 

look only at company records that are identified as a manufacturer 

o Manufacturer – click the dropdown menu in this field for a list of manufacturers 

o Source – click the dropdown menu in this field for a list of vendors 

o Model – model number 

o Type – the type of equipment 

o Serial No. – serial number of the equipment  

o Size – the size of the equipment 

o Equipment Criticality – click on the dropdown menu at the end of the field to select the level of 

user defined equipment criticality. A column in the search result screen is added and named 

“Criticality”. 

o Vendor Restriction check box  

o Serialized Item Required check box 

o Serialized Item Reference – click on the dropdown menu at the end of the field to open the list for 

serialized item references 

• Index Term Section 

o Equipment Index – click on the dropdown menu at the end of the field to select the equipment 

term. 

o Subject Index – click the dropdown menu at the end of the field for a list of subject index terms 

that best describes the equipment. 

• Miscellaneous Section  

○ CM Equipment Only check box - click this check box to only include equipment that has the 

Condition Monitoring check box checked.    

○ Monitoring Type – the Condition Monitoring Type field becomes available when the All check 

box is unchecked. Click on the dropdown menu at the end of the field to select the type of condition 

monitoring equipment is to be included in the query results.  

○ Class Equipment Only check box – click the check box to only include equipment where the Class 

Data section of the Equipment window is completed 

○ Eq Class Name – specify a class name 

○ Eq Class Code – specify a class code  

○ Custom Forms - click on the dropdown menu at the end of the Custom Form field to select the 

custom form. 
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1. Click the Search button. The right side of the window displays the items meeting the specified criteria 

when the search is complete.  

2. When searching with the Maintained Part checkbox checked, the Equipment List window displays 

two panes.  The top part of the window lists the information about the equipment.  The bottom half of 

the list window displays the detailed information for the maintained parts. 
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Section 7 Condition Based Monitoring 

Condition based monitoring is used to monitor the condition of specific areas of equipment for predictive 

maintenance. This is done automatically with the use of instrumentation such as machinery vibration analysis 

and thermal imaging equipment or manually. Properly applied condition-based maintenance can help identify 

and rectify problems at an early stage, improve machinery reliability and can help to reduce maintenance costs. 

The condition-based monitoring workflow is: 

• Ship owner identifies the machineries whose condition is to be monitored and tags them in NS 

Enterprise. The equipment is identified on the Condition Monitoring tab of the Equipment window.   

• A standard job is created for each type of condition monitoring and linked to the related machineries.  

• Service requisitions and service purchase orders are created from the standard job. The service purchase 

order vendor is an approved condition monitoring firm.  

• The third-party condition monitoring vendor comes on board the vessel and conducts the monitoring. 

The condition monitoring vendor is identified as “Condition Monitoring Analyst” by the Identity field 

on the Company Type window.  

• The vendor places the summary report in .xml format on their ftp site or emails the report. Either format 

can be imported into NS Enterprise. 

• Work orders are created per the report for equipment having problems.  

Fields and tabs have been added to several windows within the NS Enterprise Maintenance module to reflect 

the addition of Condition Based Monitoring. 

  Setup for Condition Based Monitoring 

The URL for the condition monitoring analyst vendor and any other configuration is set up in the System 

Administration module by an authorized user.  

     Machinery Health 

Information from condition reports is displayed on the Machinery Health window. The Machinery Health 

window is a query window where parameters are set to display selected reports. The information from the 

Machinery Health window is also on the Condition sub-tab of the Maintenance History tab on the 

Equipment window.  

Machinery Health is available both in the fleet level and ship level. A snapshot of the overall health of the 

fleet can be viewed at the fleet level. The Machinery Health window is slightly different on the fleet level than 

the ship level. The Machinery Health window that is opened from the fleet level displays the condition reports 

for all vessels in the fleet. 
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Fleet Level 

 

Ship Level 

 

There are two tabs on the Machinery Health window opened at ship level: 

• Equipment View – the Equipment View tab is used to query the system for condition reports 

according to the parameters selected in the filters on the header. It displays the details of the condition 

monitoring summary report. The information can be filtered by equipment, date, source, or status.  

• Report View – the Report View tab is used to query the system for condition reports by date, source, 

and the identity of the condition monitoring type. It displays the basic information of the report such as 

the name of the condition monitoring company, the date the report was created, the name of the report, 

equipment, and the status.  

 

To open the Machinery Health functionality: 

 

1. Click the Machinery Health button on the Navigator pane toolbar of the Maintenance window from 

the fleet or ship view.  

 

The Machinery Health window opens. 

 
NOTE:  The Machinery Health window can also be opened by selecting Condition 

Monitoring →Equipment Status from the Maintenance gadget on the Navigator 

pane on the Maintenance window from either the fleet or ship level.  

2 Select the parameters according to equipment on the Equipment View tab or according to specific 

reports on the Report View tab. 
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OR 

 

 

3 Click the Refresh button on the Machinery Health window to display reports meeting the selected 

criteria. 

 

 

4 Click the equipment listed in the Equipment column of the Equipment View tab to open the 

Equipment window. 

5 Double click on the information in the CM Type, Status, Date, Problem, Recommendation or 

Attachment columns to display the CM Status Detail window.  

6 Click on the work order number to open the Work Order window.  

 

The menu bar and toolbar options for the Maintenance Health window on the fleet level are the same as the 

ones for the ship level when the Equipment View tab is active except the option for reports. The Reports menu 

bar option is not available at the fleet level. 
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  Equipment View Tab 

The Equipment View tab is a query of condition monitoring reports for selected equipment, time frames and 

status. Select the criteria for the query using the filter sections on the header of the tab.   At the fleet level there 

is also a filter for All Ships or selecting a specific ship. 

Filter Fields Description 

Equipment All check box The All check box is checked by default. The All check box indicates 

that all equipment is included on the list. The Choose Equipment 

check box becomes available when the All check box is unchecked.  

 Choose Equipment 

check box 

The Choose Equipment check box becomes available when the All 

check box is unchecked.  

Click the Choose Equipment check box to select what equipment 

condition monitoring reports are included on this query. The 

dropdown menu at the end of the Equipment field becomes available 

when the Choose Equipment check box is checked.  

 
NOTE:  Only equipment that is set up as condition 

monitored is available from this window.  
 

 Equipment Click the dropdown menu at the end of the Equipment field when 

the Choose Equipment check box is checked. 

 
NOTE:  Only equipment that is set up as condition 

monitored is available from this window.  

Click the dropdown menu at the end of the Equipment field to select 

the equipment. The Equipment Explorer window opens. Click the 

plus sign (+) preceding each system to display the equipment under 

the system. Click the check box for all equipment to be included in 

the query. Click the Select button to close the Equipment Explorer 

window and add the selections to the Equipment field. 

Date  All check box The All check box is checked by default. The All check box indicates 

that all dates are included on the list. The Last Year, Last Report 

and Range check boxes become available when the All check box is 

unchecked. 

 Last Year check box The Last Year check box becomes available when the All check box 

is unchecked.  

Click the Last Year check box to only include the past year’s 

condition monitoring reports for the selected equipment. The current 

date is selected for the End Date field and the same date from the 

previous year is selected in the Start Date field. The dates CANNOT 

be changed. Use the Range check box to custom select the start and 

end dates.  
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Filter Fields Description 

 Last Report check 

box 

The Last Report check box becomes available when the All check 

box is unchecked.  

Click the Last Report check box to only include the last condition 

monitoring reports for the selected equipment. The date of the last 

condition monitoring report is listed in the Start Date and End Date 

fields. Use the Range check box to custom select the start and end 

dates. 

 Range check box The Range check box becomes available when the All check box is 

unchecked.  

Click the Range check box to select a date range for the condition 

monitoring reports for the selected equipment. The Start Date and 

End Date fields become available when the Range check box is 

clicked.  

 Start Date / End 

Date 

The Start Date and End Date fields become available when the 

Range check box is checked. Click the Calendar buttons at the end 

of these fields to select the time frame for the reports. Reports with a 

date between the dates selected in the Start Date and End Date 

fields are included in the query.  

Source  All check box  The All check box is checked by default. The All check box indicates 

that condition monitoring reports created by both vendors and crew 

members for the selected equipment within the specified date range 

are included in the query. The other check boxes become available 

when the All check box is unchecked. 

 Vendor check box The Vendor check box becomes available when the All check box is 

unchecked. Click the Vendor check box to only include condition 

monitoring reports submitted by vendors.  

 Crew check box The Crew check box becomes available when the All check box is 

unchecked. Click the Crew check box to only include condition 

monitoring reports submitted by the crew.  

Status  Select All check box The Select All check box is checked by default. The Select All check 

box indicates that condition reports with all status types for the 

selected equipment and date range are included on the list. The 

Satisfactory, Marginal and Unsatisfactory check boxes become 

available when the Select All check box is unchecked. 

 Satisfactory check 

box 

The Satisfactory check box becomes available when the Select All 

check box is unchecked. 

Click the Satisfactory check box to include only those reports with 

a status of “Satisfactory”. 
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Filter Fields Description 

 Marginal check box The Marginal check box becomes available when the Select All 

check box is unchecked. 

Click the Marginal check box to include only those reports with a 

status of “Marginal”. 

 Unsatisfactory 

check box 

The Unsatisfactory check box becomes available when the Select 

All check box is unchecked. 

Click the Unsatisfactory check box to include only those reports 

with a status of “Unsatisfactory”. 

  

The options on the menu bar and toolbar of the Machinery Health window when the Equipment View tab is 

active are: 

Option Description 

File→ The File menu contains options to manipulate a file. 

 Open 

 

Select the Open option / button to open the CM Status Detail window for the 

highlighted selection. 

 

NOTE:  Double clicking on the information in the Date, CM 

Type, Status, Problem, Recommendation or Attachment 

columns opens the CM Status Detail window.   
 

      Save 

 

Select the Save option / button to save any changes made on the Machinery 

Health window. 

View→ The View menu contains options regarding what is displayed on the 

Machinery Health window. 

      Refresh 

 

Select the Refresh option / button to refresh the information on the window. 

This is used when filters have been changed.  

      Equipment Select the Equipment option to open the Equipment window for the 

equipment that is highlighted.  

Documents→ The Documents menu contains options regarding the documents available on 

the Machinery Health window.  
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Option Description 

      Open Work Order Select the Open Work Order option to open the Work Order window on the 

highlighted row.  

Double clicking on the work order number also opens the Work Order 

window. 

 

NOTE:  Work orders are added from the Condition Monitoring 

Report.  

 

 

For the Reports menu, refer to Section 21 – Miscellaneous Items for the detailed descriptions of each item. 

 Report View Tab 

The Report View tab is used to query the system for condition reports by date and the identity of the condition 

monitoring type. Select the criteria for the query using the filter sections on the header of the tab.  

 

Filter Fields Description 

Date Start Date / End Date Click the Calendar buttons at the end of the Start Date and 

End Date fields to select the time frame for the reports. 

Reports with a date between the time frame selected in the 

Start Date and End Date fields are included in the query. 
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Filter Fields Description 

Source All check box  The All check box is checked by default. The All check box 

indicates that condition monitoring reports created by both 

vendors and crew members for the selected equipment within 

the specified date range are included in the query. The other 

check boxes become available when the All check box is 

unchecked. 

 Vendor check box The Vendor check box becomes available when the All check 

box is unchecked. Click the Vendor check box to only include 

condition monitoring reports submitted by vendors.  

 Crew check box The Crew check box becomes available when the All check 

box is unchecked. Click the Crew check box to only include 

condition monitoring reports submitted by the crew.  

Index All check box  The All check box is checked by default. The All check box 

includes all condition monitoring types in the report. The CM 

Type field become available when the All check box is 

unchecked. 

 CM Type The CM Type field becomes available when the All check 

box is unchecked. 

Click the dropdown menu at the end of the CM Type field to 

select the condition monitoring types to be included on the 

report. The Condition Monitoring Type Selection window 

opens. Double click on a monitoring type on the left side of 

the window to move it to the right. More than one selection 

can be made. Click the OK button to close the type selection 

window and add the selections to the CM Type field.  

 

The menu bar and toolbar options available on the Machinery Health window when the Report View tab is 

active are: 

Option Description 

File→ The File menu contains options to manipulate a file. 

      Save Select the Save option / button to save any changes made on the Machinery Health 

window. 

View→ The View menu contains options regarding what is displayed on the Machinery Health 

window. 

      Refresh Select the Refresh option / button to refresh the information on the window. This is 

used when filters have been changed.  

 

For the Reports menu, refer to Section 21 – Miscellaneous Items for the detailed descriptions of each item. 
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        Update Condition Status 

The Update Condition Status is used to import the summary report from the condition monitoring vendor. 

This report can be imported from a URL provided by the vendor or from a file sent from the vendor. A message 

is sent to the appropriate user if the “Receive Condition Monitoring message” check box has been checked on 

the Ship Notifications view of the Notifications tab on the User window.  

 

 Record Condition 

The Record Condition option is used to update the condition monitoring status of equipment manually. This 

is used when importing the information is not available or when the information is not available in the correct 

file type. 

1. Select the Maintenance gadget→ Condition Monitoring → Update → Record Condition from the 

Navigator pane on the Maintenance and Purchasing module on the ship level. The CM Status Detail 

window opens. 
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2. Click the radio button in the Data Source section to select whether the information was reported by a 

crew member or the condition monitoring vendor. The CM Status Detail window changes slightly 

depending on the radio button clicked. 

 

Crew Collected  

The Crew Collected CM Status Detail window is the default view when the Record Condition option is 

selected.   

3. Type the name of the person making the report in the Recorder’s Name field. This is a required field. 

4.  Click the dropdown menu at the end of the Crew Position Title field to select the position title of the 

crew member reporting the information. The Crew Position Title window opens. 

5. Double click on the crew position title to close the Crew Position Title window and add the selection 

to the Crew Position Title field. This is a required field. 

6. Click the Calendar button at the end of the Date of Reading field to select the date the condition 

monitoring information was read.  

 7. Click the dropdown menu at the end of the CM Type field to select the condition monitoring type being 

recorded. The Condition Monitoring Type List window opens.  

8.  Double click on a condition monitoring type to close the Condition Monitoring Type List window 

and add the selection to the CM Type field. 

9 Click the dropdown menu at the end of the Reference Work Order field to select the work order 

associated with the report. This is a required field. 

The Work Order Selection window opens. Click the Search tab after selecting the parameters for searching 

for the work order associated with the report. 

 10. Click the check box preceding the work order associated with the condition monitoring report. More 

than one selection can be made. Click the Select button on the Work Order Selection window to close the 

window and add the selection to the Reference Work Order field.  
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11.  Click the Add Equipment button at the bottom of the CM Status Detail window to add the equipment 

associated with the report. Another CM Status Detail window opens. 

12. Repeat steps until all equipment associated with this condition report are added to the CM Status Detail 

window accessed from the Record Condition option.  

13. Click the OK button at the bottom of the CM Status Detail window for the condition report to close 

the window. The report is added to the Machinery Health window. 

 

Vendor 

The fields on the CM Status Detail window when the Vendor radio button is clicked is slightly different than 

the default window displayed with the Crew Collected radio button selected.  

 

1. Click the dropdown menu at the end of the Vendor field to select the condition monitoring vendor 

reporting the information. The CM Vendor window opens. Notice that the company type with the CM 

Analyst identity is listed by default in the Company Type field on the Search tab. 

Click the Search button. Companies with that company type are listed in the query results.  

Double click on the condition monitoring vendor filing the report to close the CM Vendor window and 

add the selection to the Vendor field. This is a required field. 

2. Click the Calendar button at the end of the Date of Visit field to select the date the vendor visited the 

vessel for the report. Navigate through the Calendar window to select the date. Click the date to close 

the Calendar window and add the date to the Date of Visit field. This is a required field. 

3. Click the dropdown menu at the end of the CM Type field to select the condition monitoring type being 

reported. The Condition Monitoring Type List window opens.  

Double click on a condition monitoring type to close the Condition Monitoring Type List window 

and add the selection to the CM Type field. This is a required field. 

4. Click the dropdown menu at the end of the Reference Work Order field to select the work order 

associated with the report. This is a required field. 
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 The Work Order Selection window opens. Click the Search tab after selecting the parameters for 

searching for the work order associated with the report. 

 Click the check box preceding the work order associated with the condition monitoring report. More 

than one selection can be made. Click the Select button on the Work Order Selection window to close 

the window and add the selection to the Reference Work Order field.  

5. Click the Add Equipment button at the bottom of the CM Status Detail window to add the equipment 

associated with the report. Another CM Status Detail window opens.  

6. Repeat steps until all equipment associated with this condition report are added to the CM Status Detail 

window accessed from the Record Condition option.  

7. Click the OK button at the bottom of the CM Status Detail window for the condition report to close 

the window. The report is added to the Machinery Health window. 

 Import from File 

The Import from File option is used to import the condition report in .xml format. No other format is supported. 

Images associated with the file are added if they have been placed in the same location as the .xml file.  

1. Select the Maintenance gadget→ Condition Monitoring → Update → Import from File from the 

Navigator pane on the Maintenance and Purchasing window on the ship level. The Import window 

opens. 

 

2. Click the dropdown menu at the end of the Input File field. The Open window opens on the default 

directory.  
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NOTE:  Notice that the only file type available is .xml. Any images with a .jpg extension 

associated with the .xml file in the same directory as the .xml are also imported. 

 

3. Navigate through the directory to find the summary report. 

4. Double click on the file. The Open window closes, and the file name is displayed in the Input File 

field.  

5. Click the OK button on the Import window to close the window and start the import process.  

• A log file in Notepad opens when the process ends with a message stating if the import was 

successful. 

 Import from Vendor  

 
NOTE:  The Vendor URL Configuration MUST be setup prior to using the Import from 

Vendor option. 

1. Select the Maintenance gadget→ Condition Monitoring → Update → Import from Vendor from 

the Navigator pane on the Maintenance and Purchasing window on the ship level. The Update 

Condition Status window opens. 

 

2.   Click the dropdown menu at the end of the CM Vendor field. The CM Provider window opens. Notice 

that the company type with the CM Provider identity is listed by default in the Company Type field 

on the Search tab. 

 Click the Search button. Companies with that company type are listed in the query results.  

3.   Double click on a vendor to close the CM Provider window and add the selection to the CM Vendor 

field. 

4.   Click the OK button to connect to the URL for the selected vendor and close the Update Condition 

Status window. 

• A log file in Notepad opens when the process ends with a message stating if the import was 

successful. 
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 CM Status Detail Window 

 
NOTE:   This Condition Status Detail window is not to be confused with the one that opens 

when the Maintenance gadget →Condition Monitoring →Update→ Record 

Condition option is selected. 

 

There are two types of CM Status Detail window. One is editable whereas the other is read-only. The read-

only version contains the information that was entered in the editable version.  

The CM Status Detail window displays the details on a condition monitoring report for a specific piece of 

equipment and the file attachments associated with the report. This window is accessed by double clicking on 

the information in the CM Type, Status, Date, Problem, Recommendation or Attachment columns on either 

the Condition sub-tab of the Maintenance History tab on the Equipment window or the Equipment View 

tab on the Machinery Health window.  

 

  Condition Monitoring Report 

The Condition Monitoring Report window is accessed from either the Report View tab of the Machinery 

Health window at the ship level or the Condition sub-tab on the Maintenance History tab of the Equipment 

window.  Click the information in the Report ID column / row of either window to open the window. 
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The Status Filter section can be used to change the list to view only those pieces of equipment with the selected 

status. The Select All check box MUST be unchecked to access the other check boxes. Click the Refresh button 

in the Condition Monitoring Report window toolbar to refresh the list with the selected status.  

The options on the menu bar and toolbar of the Condition Monitoring Report are: 

Option Description 

File→ The File menu contains options to manipulate a file. 

     Open 

  

Select the Open option / button to open the CM Status Detail 

window for the highlighted row.    

     Save 

  

Select the Save option / button to save any changes. 

View→ The View menu contains options regarding what is displayed on 

the Condition Monitoring Report window. 
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Option Description 

      Refresh 

  

Select the Refresh option / button to refresh the information on 

the window. This is used when filters have been changed.  

Process→ The Process menu contains options regarding a procedure. 

Generate WO for Selected 

Equipment 

Select the Generate WO for Selected Equipment option / 

button to create a work order for the highlighted equipment.  

Documents→ The Documents menu contains options regarding the documents 

available on the Condition Monitoring Report window.  

      Open Work Order Select the Open Work Order option to open the Work Order 

window on the highlighted row.  

Double clicking on the work order number also opens the Work 

Order window. 

  Work Orders and Condition Monitoring  

Work orders are associated with the Condition Monitoring Report in two ways: 

• Create a work order from the Condition Monitoring Report 

• Link a previously created work order to the Condition Monitoring Report  

 Create a New Work Order 

1. Click the Generate Work Order for Selected Equipment button on the Condition Monitoring Report 

window. 

  

• The Create Work Order wizard window opens. 
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2. Click the Finish button on the Create Work Order window to open the Work Order window. The 

Ship, Condition Based check box, Scheduled and Equipment fields are filled with information from 

the report. The Description tab is also pre-filled with the information from the Recommendations field 

on the report.   

3. Complete any other necessary information on the Work Order window.  

4. Click the Save button to save the work order and close the Work Order window. The work order 

number is listed in the Work Order Numbers column on the Condition Monitoring Report. 

 Link Previously Created Work Orders to Condition Monitoring Report 

Previously created work orders can be linked through the Condition Monitoring Report window. 

 
NOTE:  Only previously created work orders linked from the Work Order Selection window 

on the Condition Monitoring Report are associated with the report. 
 

1. Click the Query for Previous Work Orders button on the Condition Monitoring Report window 

toolbar.  

 

• The Work Order Selection window opens.  
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The Work Order Selection window has the same fields as the Work Order Search window. Only the menu 

bar and toolbar options are different. 

2. Select the criteria to locate the work orders to be linked to the Condition Monitoring Report.     

3. Click the Search button on the Work Order Selection window to initiate the query. 

4. Click the check box preceding the work orders to be linked to the Condition Monitoring Report. More 

than one selection can be made. 

5. Click the Select button to close the Work Order Selection window and add the selections to the report. 

The work order number is listed in the Work Order Numbers column or “Multiple” is listed if more 

than one work order is selected. Click on “Multiple” to open a Work Orders window listing the work 

orders.  
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Section 8 Serialized Items 

Work orders are associated with the installation and removal of Serialized Items. Landing Orders are used 

to move Serialized Items from one site to another.  This includes vessels, warehouses, and vendors.  See the 

Landing Orders section of this manual for details on moving serialized Items.  

The Transfer Order is integrated into the materials ordering cycle and the requisition approval process in NS 

Enterprise. The document trail of ordering materials and maintenance cycles is automatically maintained. 

NOTE:  Serialized Item record must already exist in the database. 

 Create a Serialized Item 

On the Serialized Items tab of the Equipment window, click on the dropdown menu at the end of the 

Reference field to open the Equipment SI Reference library, select the Reference.  

 

From the Serialized Item menu, select Create Serialized Item.   

 

• The Serialized Item – New window opens. 
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The fields on the new Serialized Item window are: 

Field Description 

Name Auto populates with the SI reference, however the user can add additional information 

to further identify the name of the serialized item. 

Serial No. Enter in the serial number of the item 

SI Reference Auto populates when the SI reference is chosen 

Date Acquired The date the serialized item was received/delivered. 

Model Enter in the model number for the serialized item 

Condition Clicking on the dropdown menu at the end of the field opens the serialized item 

condition list window.  Select the description that best fits the condition of the 

serialized item. 
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Field Description 

Expiry Date If the serialized item has a warranty/certification, enter in the date the 

warranty/certification will expire. 

Type Type of the Serialized Item 

Manufacturer Auto populates with the manufacturer based upon the SI reference. 

Value The value of the item at the time it was acquired. 

Size Enter in the dimensions of the items, e.g. 3x3x3 or 3-inch gauge steel 

Status Details Free form text field 

Remaining 

Hours 

If this is a serialized item that needs to be maintained on a maintenance schedule or the 

running hours need to be tracked, enter in the number of remaining hours before its 

next maintenance is required.  This also might be the number of remaining hours before 

the item is to be discarded in the case the serialized item is a one-time use item. 

Year Made The year the item was built. 

Stock This is a 25-character free text field to be used for further classification of the part. 

File This is a 25-character free text field to be used for further classification of the part 

HID Hierarchy Identification Number 

Class Name The name by which the equipment is referenced by the class society. 

Class Code The classification code which is the UID of the vessel. 

Current Status 

Section 

 

Site 
This field is tied to the “Where Installed” because the Serialized Part is currently 

installed in a Maintained Part, the Site field automatically sets to the Ship to which the 

Maintained Part belongs and cannot be changed.  

For a non-installed Serialized Part (i.e., which is not installed in any Maintained Part), 

the Site field is determined by the site where the item is physically located, e.g. on 

board the vessel or located at a warehouse or repair facility. 

Status Uses an index term called “Serialized Item” Status with pre-populated with values: 

“Installed”, “Repair Locally”, “Repair Ashore”, “Spare”, “Recommend Discard”, 

“Discarded”.   

There are restrictions and logic associated with selection of these values.  Default value 

for a new Serialized Part is “Spare”.   
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Field Description 

Where Installed A read only, calculated field.  It will display the equipment name and maintained part 

name where the serialized part is installed.  If the serialized part is not currently 

installed, it will be blank.   

Location This is required to display the location where the part is installed, stored, or located at 

any given time.  

Date  

SI Repair Status Tracks the status and progress of a serialized item which is being repaired ashore 

Vendor This is read only.  Auto populates with the vendor associated to the SI reference 

Current Site 

Date 

THIS IS A REQUIRED FIELD. 

If choosing today’s date and clicking save will return a message,  

 

Click Yes to save the new record, close the new Serialized Item window and a new 

row will display on the Serialized Item Tab of the associated equipment window. 

 

 

 Admin Info Tab 

Double clicking on the row of the serialized tab of the equipment record will open the Serialized Item record. 
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The fields on the Admin Info tab are: 

Field Description 

Criticality A, B, C, or D; A being the most and D the least. 

Subject Index Click on the dropdown menu at the end of the Subject Index field to open the Subject 

Index selection window. Select the subject index by clicking the arrows to move the 

item from the left to right side of window.  Clicking the OK button closes the subject 

index selection window and returns the value to the Admin Info Tab.   

ASTM Class This is the ASTM class associated equipment slot of the serialized item 

 Status History Tab 

The Status History tab captures the history throughout the lifecycle of the serialized item. 

 

 Work History Tab 

The Work History Tab auto populates with the work history associated to the serialized item throughout its 

life cycle. 

 

 Counter Setup Tab 

The Counter Setup tab is used to set the counter readings of the serialized item under this equipment in the 

hierarchy. This reading is used to schedule jobs by the amount of hours that the serialized item is used. This tab 

is applicable to maintenance. See Counter Setup Tab in the Equipment Explorer section of the NS 

Enterprise Maintenance Manual for details on this tab. 
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 Counter History 

The Counter History tab displays history counter readings that have been recorded and keeps count of the 

number of running hours between maintenance jobs. An entry is made on the tab whenever the running hours 

on the piece of equipment is updated.  The number of running hours displayed in the Job Counter field on the 

Standard Job window is taken from this tab. 

 

 

 Remarks Tab 

The Remarks tab is a free form text tab. Any comments or remarks pertaining to the serialized item are recorded 

on the Remarks tab. These comments and remarks are viewed by all who have access to this tab. 

 

 Landing Order Tab 

The Landing Order Tab will auto populate to keep all history for moves/transfers of the serialized item through 

the lifecycle of the slot for the associated equipment. 
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 File Attachments Tab 

Refer to Item 21.2 File Attachment Tab section of this manual 

 Message Tab 

Refer to Item 21.5 Messages Tab section of this manual. 

 Custom Forms 

Refer to Item 21.3 Custom Forms Tab section of this manual 

 Repair Jobs 

Repair Jobs relative to the serialized item are recorded in this tab. Right-click on the field under repair jobs to 

add a job. 

 

 Install a Serialized Item 

1. On the Maintenance gadget→Documents→ click the Create New Work Order link to open the 

Work Order - New window. 

2. Click on the dropdown menu at the end of the Ship field to Select Ship window.  Highlight the vessel 

and click the Select button to close the Select Ship window and add the value to the Ship field. 

3. Enter in Title and any other relevant information on the WO header and other WO tabs. 
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4. Click on the Serialized Items Tab. 

5. Right-click in an open area on the tab and select Link Serialized Item. 

 

• A message will display that a Work Order was created.   

6. Click the OK button to close the message window and open the SI Query window. 

7. Find the serialized item on the List window, highlight the item, and click on the Select icon on the tool 

bar menu to close the Query window and populate the Serialized tab on the work order. 

8. If the item selected for install/remove process does not have an Equipment/Maintained Part linked first, 

a message will display.  

9. Once item displays on the serialized tab, select Install from the Process menu options. 

10. The serialized item wizard opens.  

 

11. Select the serialized item to be installed and click the Next button.The Install Serialized Item window 

opens.  
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The fields include: 

Field Description 

Consider only Selected 

Equipment/ Maintained 

Part radio button 

The Consider only Selected Equipment/ Maintained Part radio button filters 

to only those equipment record that have been selected. 

Consider child 

Equipments/Maintained 

parts also  

radio button 

The Consider child Equipments/Maintained parts also radio button filters 

to only child equipment and maintain part records. 

Select a Work Order to 

begin Process section 
 

Work Order 
Select the dropdown menu at the end of the work order number field to open 

the Work Order Search window.  Using filters, find the work order that is 

associated to this install.  Highlight and click the select button to close the 

Work Order Search window and add the value to the SI installation wizard 

screen. 

Completion 

Date 
Enter in the date the install occurred.  This cannot be a date in the future. 

Selected 

Equipment/Maintained 

Part Section 

 

Type 
Identifies the types of item, e.g. MP for maintained part 

Code 
Identifier for the item, e.g. CYLLIN-01 for Cylinder 01 

Name 
Description for the item 
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Field Description 

Serialized Item 
SI Reference Index number 

Work Order 

Numberz 
Identifies the number of the work order that completed the install tasks. 

 
Remarks Icon 

This is a free form text field. 

 

12. Click the Finish button to open the Counter Reading window.  Enter in the Counter Reading and click 

OK button to continue through the SI Installation Wizard. 

 

13. A message will display to say the installation of the SI item was successfully completed.  Click the OK 

button to continue with the wizard. 

 

14. The Link previous maintenance history window opens. Select the radio button that is application to this 

installation task for the serialized item.  Click the OK button to continue with the wizard. 

 

15. Clicking the OK button closes the SI Installation Wizard window.  The Serialized Item Query 

window is still open. 

16. To verify the history, re-open the Serialized Item document and click on the Work History Tab. 
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17. Double clicking on the completion row will open the Work Order to review any information needed 

concerning the installation task. 

 Remove a Serialized Item 

Work orders are associated with the installation and removal of Serialized Items. Landing Orders are used to 

move serialized items from one site to another.  This includes vessels, warehouses, and vendors. 

When removing a Serialized Part, the user will designate what status it should have: Spares, Repair Locally, 

Repair Ashore, or Discard.  I.e., anything other than installed. Once the serialized item is removed it available 

to be installed in any other Maintained Part. 

   

1. If the “Serialized Item Required” checkbox on the Maintained Part screen was checked (see Maintained 

Part section below), the system will require that a new Serialized Item be installed into the Maintained 

Part before the Maintained Part screen is closed. 

2. Removal of a serialized part requires linking to a work order.  

3. When a serialized part is removed the user options include: 

 

a. Create New Work Order – If the user selects this option a new work order is created and linked to 

the Maintained part as well as the Serialized Part that is being removed.  

b. Select from existing Work Orders – If the user selects this option the work order query 

automatically sets the query filters set to only include Scheduled or Completed work orders for the 

current Maintained Part. The user can then select a single work order by tagging it and clicking the 

blue checkmark. The user can also install a new serialized part at this time using the same work 

order. 

4. From the Serialized Items Tab on the equipment window double click to open the serialized item 

record.  Choose Remove from the Process menu option to open the SI Removal Wizard. 
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5. Continue by clicking Next and then Finish to complete the wizard. 

 Edit a Serialized Item 

On the Equipment record→Serialized Items tab, double click to open the Serialized Item record.   
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Make appropriate changes to the serialized item record and save the changes before exiting the window and 

returning to the equipment record. 

 Search for a Serialized Item 

In the Maintenance gadget→Documents→Search→Serialized Item Query in the Maintenance and 

Purchasing module opens the Serialized Item Query Search Navigator pane. 
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The fields on the Search Navigator are: 

Field Description 

General Section 
 

Ship 
Allows the selection of the vessel.  More than one vessel can be selected. 

Item Type 
The two choices are a check box for Parts and a checkbox for Equipment.  Both 

can be selected. 

Installed/ Removed 
Allows the search to filter by only installed or only removed serialized items. 

Status 
Status options are:  Spare, Repaired Locally, Repaired Ashore, Recommend 

Discard, or Discarded.   

Serial No. 
The serial number of the item 

Manufacturer 
The manufacturer of the serialized item. 

Description Section 
 

Options 
The options to search the description field are: 

• All these words 

• Any of these words 

• The exact phrase 

Find Whole Word 

Only Checkbox 

Searches for the whole word in the description field 

Search String 
Searches for the string entered into the Search String field, e.g. *cylinder*  

Indexes Section 
 

SI Reference 
The Serialized Item Reference ID 

Repair Status 
This is an index term that is user defined.  Options might include: 

• At Repair Facility 

• At Warehouse 

• In Transit to Repair 

• Under Evaluation 

Condition 
This is an index term that is user defined.  Options might include: 

• 01 – New 

• 02 – Good 

• 03 – Fair 

• 04 – Poor 

• 05 – Reconditioned 

• 06 – Repairable 

• 07 – Unrepairable 
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Field Description 

Part Criticality 
The options are: 

• Critical 

• Critical - Operational 

Subject Index 
This is an index term that is user defined.  Options might include: 

• Equipment for GCC Install 

Date Range Section 
 

Expiry Date 
Enter in a date range to search for an expiration date of the serialized item. 

Miscellaneous Section 
 

Value 
Enter in a range for the cost (value) of the serialized item. 

Model 
This is a free form text field for the model number. 

Type 
This is a free form text field for the type of serialized item. 

Size 
This is a free form text field for the size of the serialized item. 

Year Made 
This is a free form text field for the year the serialized item was made. 

Equipment Criticality 
This is an index term.  The options are check boxes: 

A 

B 

C 

D 

Vendor 
Click on the dropdown menu at the end of the field displays a list of vendors for 

the serialized items with a check box preceding each name.  Multiple selections 

can be made. 

Custom Forms 
Click on the dropdown menu at the end of the field to display a list of custom forms 

associated to the serialized item.  Multiple selections can be made. 

 

Enter in filter criteria and click Search button to display search results in the List window.  Also available on 

the search list window is the ability to choose filters/columns to display on the list window.  To choose filters, 

left click on the dropdown menu next to the SI reference column and choose filter.  The choose filter box will 

display, by default all fields are checked.  Uncheck the columns that are not necessary for this search and click 

close. 

Searches can also be saved/bookmarked, just like those saved in other search navigator panes in NS Enterprise. 
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Section 9  Spaces 

Spaces are the cargo holds, service tanks, cabins and any other compartment of the ship included in the 

maintenance plan. The preventive maintenance plan must include those spaces listed in the classification society 

and / or other regulatory body requirements.  

The Space Standard Job title is created by combining the space name with an index term indicating the job 

size. This is similar to the PM standard job creation for equipment or maintained parts except that the job 

schedule can only be based on a calendar interval instead of running hours.  

 Create Spaces 

Space is created or defined from the fleet level by the central office, but it is edited from the ship level to apply 

to each individual ship. The newly created space is replicated to each ship’s database that it pertains to. 

However, the individualized information regarding the space is NOT replicated back to the central database. It 

remains in each ship’s database. 

From the Maintenance and Purchasing module, select Maintenance gadget → Tools → New Space  

 

      

• The Space - New window opens. 
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The fields on the Space window are: 

Field Description 

Name Type the name of the space in the Name field. This name can be specific to a ship or 

generic to apply to several ships. THIS IS A REQUIRED FIELD. 

Space Index Click the dropdown menu at the end of the Space Index field to open the Space 

Index window for a list of index terms that apply to space. Index terms are used for 

cross reference and query purposes. Authorized users can add new index terms to the 

Space Index window.  

Click to highlight an index term from the Space Index window.  

Click the Select button on the Space Index toolbar to select the highlighted space.  

The Space Index window closes, and the selected space is listed in the Space Index 

field. This is a required field. 

Ships Click the dropdown menu at the end of the Ships field to open the List of Ships 

window to select the ship or ships that have this space. This is a required field. 

 

NOTE:   Ships only see information that pertains to their ships. Only 

the ship viewing the Space window is listed once the central office has 

sent the information to the ships’ databases.  
 

Area Click in the Area field to type the area of the space in square meters. This field can 

be left blank if the area for the specified space differs from ship to ship in the fleet. 

It can be defined at the ship level.  

Capacity  Click in the Capacity field to type the capacity of the space in cubic meters. This 

field can be left blank if the capacity for the specified space differs from ship to ship 

in the fleet. It can be defined at the ship level. 

Unit Click on the dropdown menu at the end of the Unit field to open the Available Units 

List window.  Highlight the row to select the unit and click the Select button to close 

the Available Units List and return the value to the new Space window. 

Status Click on the dropdown menu at the end of the Status field to change the status of the 

space. The default value is “Active”. 

Remarks Type any remarks pertaining to the space in the Remarks field. The Remarks field 

is a free form text field and is editable at any time. This field can be left blank for the 

ship to complete unless the remark pertains to this space on all ships in the fleet. 

Confined Space 

checkbox 

If this box is ticked, user must indicate as well if it is: 

• Hazardous 

• Non-Hazardous 
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Field Description 

Voyage Management  This information is used in conjunction with the Voyage Manager module. The 

Voyage Management section identifies if the Space is associated with voyage-related 

activities that needs to be tracked. 

Radio buttons: 

• Participates in Ballast Water Management 

• Liquid Bulk Cargo 

• Dry Bulk Cargo 

• Engine Room Ambient Condition Tracking 

• None (The default value is None.) 

 

Pumps: This field becomes available if one of the radio buttons (other than None is 

selected.)  Click on the dropdown menu at the end of the Pump field to open a list 

of ships window to drill down to find the specific pump associated to the radio button 

selected.  Check the box to select the pump and click the OK button to close the list 

of ships window and display the pump on the new Space window. 

Tank Types:  Click on the dropdown menu at the end of the Tank Type field.  Check 

the box to select the tank type and click the OK button to close the list of ships 

window and display the tank type on the new Space window. 

 

Class Data section The Class Data section was added to include classification information. The fields 

in this section are: 

• Class Code – classification code which is the UID of the vessel  

• HID – Hierarchy Identification Number 

• Class Name – the name by which the space is referenced by the class society 

 

NOTE: Only authorized users can add or edit information in these 

fields. 
 

File Attachments tab The File Attachments tab is the only active tab on the Space – New window. 

Attachments pertaining to the defined space can be attached in the form of text, 

graphics, or Excel spreadsheet. 
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 List of Ships Window (from Ships dropdown menu) 

 

1.   Double click a ship on the left pane of the window to move it to the right pane of the window. Continue 

selecting and moving them until all ships that contain this space are listed on the right pane of the 

window.  

2.   Click the OK button to accept all selected ships, close the List of Ships window and list the ship or 

ships in the Ships field of the Space – New window. 

Unselect a Ship - Double click on a ship on the right pane of the window to move it back to the left pane of the 

window to unselect a ship. 

Select all Ships - Click the double right arrow to move all ships from the left side of the window to the right 

side of the window. 

 

Search for a Ship 

Some companies have an extensive list of ships. The List of Ships window contains a search field to help locate 

a ship. 

3. Click on the dropdown menu located at the Search field in the List of Ships screen.  Tag an item to 

which will be the basis of the search. 
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4. Type the beginning letters or numbers of the category of the ship to be located in the Search field. The 

cursor moves with every character typed to the ship meeting the search criteria according to the letters 

or numbers typed.  

 

5.   Continue typing until the specific ship is located.  

6.   Double click on a ship from the left side of the window to move it to the right side of the window. 

7. Click the OK button to accept all selected ships, close the List of Ships window and list the ship or 

ships in the Ships field of the Space – New window.  
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 Edit a Space  

Space can be edited and customized to a specific ship’s needs once it is created by the central database and 

replicated to the ship. This is done from the ship view. 

 
NOTE:   Only authorized users can make changes to the Space window. 

1. From the Maintenance and Purchasing module, select Maintenance gadget→ Tools → Spaces to 

open the Space Lists window. Click on the Search tab after selecting the parameters for the search.  

Select the Search button to initiate the search.  A list of all spaces that meet the criteria set for the search 

opens on the right side of the window.  This window lists all the spaces created for this specific ship.   

 

NOTE:  The Area and Capacity columns may have zeros (0) if this is a newly created space. This 

information can be added or changed in the Space window. 

 

 

 

2.   Double click on a space to be edited. The Space window for the selected space opens. 
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• The fields on the Space window at the ship level are the same as the space fields on the fleet level. 

 Standard Jobs Tab 

The Standard Jobs tab lists all the standard jobs for the specified space. Open the standard job listed on the 

Standard Jobs tab to view details of the job. 

Standard jobs are created by the central office. Some fields on the standard job can be edited by authorized users 

at the ship level.  

 

The columns on the Standard Jobs tab are: 

• Job Size Indicator – The job size indicator defines the relationship of the job compared to other 

jobs under the same equipment or space. This rating is from 0 – 99.  

• Job Size Index – The job size index describes the nature of the job. For example, overhaul or 

inspection. The name of the PM Standard Job is derived by combining the name of the physical 

item on which the job is performed with the job size term. For example, #1 Forward Tank - 

Tank Inspection – Visual. 
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• Interval – the time frame between this job and the next time it is to be performed.  

• Estimated Cost – the estimated price of performing the job that includes cost of personnel, tools, 

services, and materials. 

Double click the standard job in the Standard Job tab to open the job window.  

 Miscellaneous Work Tab 

Refer to Item 21.6 Miscellaneous Work Tab section of this manual. 

 Maintenance History Tab 

The Maintenance History tab lists all the documents associated with the maintenance on the specified space. 

These documents are work orders, service requisitions, no action jobs and service purchase orders. Some fields 

on these documents can be edited by authorized users at the ship level. Documents are automatically added to 

this tab when they are created if they specify this space. 

 

The fields on the Maintenance History tab are: 

• Document number – the maintenance document name and number. 

• Scheduled – the scheduled date of the maintenance 

• Completed – the date the maintenance was completed 

• Price – the cost of the job 

• Status - indicates whether the work is scheduled (SCHD or S), completed (CMPL or CP), closed 

(CLOS or CL) or cancelled (CANC or X).  

• Job Title – the title of the maintenance as listed on the work order or service purchase order 

• F (Findings) – An icon in the column indicates the entries are made on the Findings tab of the 

Work Order. Double click on the work order to open the Work Order window. 

Double click the document on the Maintenance History tab and to open the selected work order. 

 Compliance History 

This tab shows all Compliance Documents linked to the structure. Click to select a document and click the 

Open icon to view the record. 
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 File Attachments Tab 

Refer to Item 21.2 File Attachment Tab section of this manual. 

 Custom Forms Tab 

Custom Forms field allows the user to link Custom Form Templates to Spaces Documents. 

Refer to Item 21.3 Custom Forms Tab section of this manual. 

 Space Lists Window 

The Space Lists window contains all the spaces created for the specified ship. Click on the dropdown menu in 

the fields on the Search tab to define the parameters for finding the desired spaces.   

The options on the menu bar and toolbar for this window are explained in this section. 

Option Description 

Space→ The Space menu contains options to manipulate a selected space.  

 Open    
Select the Open option / button to open the space highlighted on the Space 

Lists window. 

 Refresh  
Select the Refresh option / button to refresh the view on the window. 

 Delete  
Select the Delete option / button to delete the space highlighted on the Space 

Lists window. 

Spaces can only be deleted if they have NOT been replicated. This option is 

only available for the central office. 

 Hide  
Select the Hide option / button to hide the space highlighted on the Space 

Lists window.  
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Option Description 

             Search  
This toolbar icon works as a toggle to display or hide the Bookmarks and 

Search tabs of the Space Lists window.  

             Help  

The option in the Help menu is Help. Select this option to open the online 

help. 

 Hide Spaces 

Spaces that have been created cannot be deleted, but they can be hidden. 

1. Select Maintenance gadget→ Tools → Spaces from the Navigator pane on the Maintenance and 

Purchasing module from the ship view to open the Space Lists window. Click the Search tab after 

selecting the parameters for the search.  Click the Search button to initiate the search.   

All the spaces that meet the specified criteria are listed on the right side of the window for this specific ship. 

2. Tag the space to hide and then click the Hide button. 

 

• A confirmation message box opens to verify that the space is to be hidden.  

 

3. Click the Yes button to close the message box and hide the selected space. 
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Section 10  Structures 

 Create Structures 

A structure is created or defined from the fleet level by the central office, but it is edited from the ship level to 

apply to each individual ship. The newly created structure is replicated to each ship’s database that it pertains 

to. However, the individualized information regarding the structure is NOT replicated back to the central 

database. It remains in each ship’s database. 

From the Maintenance and Purchasing module, select Maintenance gadget→ Tools → New Structure  

   

• The Structure - New window opens. The Structure window looks similar to the Space window.  
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The fields on the Structure window are: 

Field Description 

Name Type the name of the structure in the Name field. This name can be specific to a 

ship or generic to apply to several ships. This is a required field. 

Structure Index Click the dropdown menu at the end of the Structure Index field to open the 

Structure Index window for a list of index terms that apply to structures. Index 

terms are used for cross reference and query purposes. Authorized users can add 

new index terms to the Structure Index window.  

Click to highlight an index term from the Structure Index window.  

Click the Select button on the Structure Index toolbar to select the highlighted 

structure.  

The Structure Index window closes, and the selected structure is listed in the 

Structure Index field. This is a required field. 

Ships Click the dropdown menu at the end of the Ships field to open the List of Ships 

window to select the ship or ships that have this structure. This is a required field. 

 

NOTE:   Ships only see information that pertains to their ships. Only 

the ship viewing the Structure window is listed once the central office 

has sent the information to the ships’ databases.  
 

Area Click in the Area field to type the area of the structure in square meters. This field 

can be left blank if the area for the specified structure differs from ship to ship in 

the fleet. It can be defined at the ship level.  

Status Click on the dropdown menu at the end of the Status field to change the status of 

the structure. The default value is “Active”. 

Remarks Type any remarks pertaining to the structure in the Remarks field. The Remarks 

field is a free form text field and is editable at any time. This field can be left blank 

for the ship to complete unless the remark pertains to this structure on all ships in 

the fleet. 

Class Data section The Class Data section was added to include classification information. The fields 

in this section are: 

• Class Code – the UID of the vessel  

• HID – Hierarchy Identification Number 

• Class Name – the name by which the space is referenced by the class 

society 

 

NOTE: Only authorized users can add or edit information in these 

fields. 
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Field Description 

File Attachments 

tab 

The File Attachments tab is the only active tab on the Structure – New window. 

Attachments pertaining to the defined structure can be attached in the form of text, 

graphics, or Excel spreadsheet. 

 Edit a Structure 

A structure can be edited and customized to a specific ship’s needs once it is created by the central database and 

replicated to the ship. This is done from the ship view. 

NOTE:   Only authorized users can make changes to the Structure window. 

 

At Ship Level: 

1. From the Maintenance and Purchasing module, select Maintenance gadget→ Tools → Structures to 

open the Structure Lists window. 

2. The Ship field on the Search tab is filled by default with the vessel name. Click the Search button at 

the bottom of the Search tab to initiate the search. The structures created for this specific ship are listed 

on the right side of the window. 

 
NOTE:  The Area column may have zeros (0) if this is a newly created structure. This 

information can be added or changed in the Structure window.  
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3.   Double click on a structure to be edited. The Structure window for the selected structure opens.   

• The fields on the Structure window at the ship level are the same as the fields on the fleet level. 

 Standard Jobs Tab 

The Standard Jobs tab lists the standard jobs for the specified structure. Jobs are added to this tab when they 

are created for the specified structure. Open the standard job listed on the Standard Jobs tab to view details of 

the job. 

Standard jobs are created by the central office. Some fields on the standard job can be edited by authorized users 

at the ship level.  

The Standard Jobs option and drop-down menu options are added to the menu bar of the Structure window 

when the Standard Jobs tab is clicked. 

The columns on the Standard Jobs tab are: 

• Job Size Indicator – The job size indicator defines the relationship of the job compared to other 

jobs under the same equipment, space, or structure. This rating is from 0 – 99.  

• Job Size Index – The job size index describes the nature of the job. For example, overhaul or 

inspection. The name of the PM Standard Job is derived by combining the name of the physical 

item on which the job is performed with the job size term. For example, #1 Forward Tank - Tank 

Inspection – Visual. 

• Interval – the time frame between this job and the next time it is to be performed.  

• Estimated Cost – the estimated cost of the job 

Double click the standard job in the Standard Job tab to open the job window.  

 Miscellaneous Work Tab 

The Miscellaneous Work tab lists miscellaneous standard jobs. The miscellaneous standard job is a type of 

standard job and like the Standard Job tab; jobs are added to the tab when the structure is linked to the job on 

the Miscellaneous Equipment tab on the standard job. It is work of a general nature such as painting, 

sandblasting or anode replacement that is not associated with a specifically identifiable item on the ship like a 

piece of equipment, space. However, miscellaneous work can be cross-referenced with multiple items such as 

equipment, space, or structure so that when the standard job is completed, these areas are automatically updated 

with maintenance history. The job schedule can only be based on calendar interval.  

The fields on the Miscellaneous Work tab are: 

• Ship Name – the name of the ship  

• Job Name – the job title on the miscellaneous standard job 

• Dormant – the job status. A “No” indicates that the job is active. 

• Last Done – the date the last time the job was performed 
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• Interval – the time frame when the job was last performed until the next time it needs to be 

performed. 

Double click the standard job in the Miscellaneous Work tab and it opens. Only authorized users can enter or 

change information on the Standard Job window. 

 Maintenance History Tab 

The Maintenance History tab lists the documents associated with the maintenance on the specified structure. 

These documents are work orders, service requisitions, no action jobs and service purchase orders. Some fields 

on these documents can be edited by authorized users at the ship level. Documents are automatically added to 

this tab when they are created if they specify this structure. 

The fields on the Maintenance History tab are: 

• Document Number – the maintenance document name and number. 

• Scheduled – the scheduled date of the maintenance 

• Completed – the date the maintenance was completed 

• Price – the cost of the job 

• Status - indicates whether the work is scheduled (SCHD or S), completed (CMPL or CP), closed 

(CLOS or CL) or cancelled (CANC or X).  

• Job Title – the title of the maintenance as listed on the work order or service purchase order 

• F – an icon in the column indicates the entries are made on the Findings tab of the Work Order. 

Double click on the work order to open the Work Order window. 

Double click the document on the Maintenance History tab and it opens. 

 Compliance History 

This tab shows all Compliance Documents linked to the structure. Click to select a document and click the 

Open icon to view the record. 

 

 File Attachments Tab 

Refer to Item 21.2 File Attachment Tab section of this manual 
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 Custom Forms Tab 

Refer to Item 21.3 Custom Forms Tab section of this manual 

 Structure Lists Window 

The Structure Lists window contains the structures created for the specified ship. Click on the dropdown menu 

in the fields on the Search tab to define the parameters for finding the desired spaces. 

The fields on the Structures Search Navigator include the name of the Ship and the Structure Index. 

The options on the menu bar and toolbar for this window are explained in this section. 

Option Description 

Space→ The Space menu contains options to manipulate a selected space.  

 Open    
Select the Open option / button to open the space highlighted on the Space Lists 

window. 

 Refresh  
Select the Refresh option / button to refresh the view on the window. 

 Delete  
Select the Delete option / button to delete the space highlighted on the Space 

Lists window. 

Spaces can only be deleted if they have NOT been replicated. This option is 

only available for the central office. 

 Hide  
Select the Hide option / button to hide the space highlighted on the Space Lists 

window.  

             Search  
This toolbar icon works as a toggle to display or hide the Bookmarks and 

Search tabs of the Space Lists window.  

             Help  

The option in the Help menu is Help. Select this option to open the online help. 

 

The Structures Window includes Tabs for Standard Jobs, Miscellaneous Work, Maintenance History, File 

Attachments and Custom Forms.  Structure statuses are either Active or Inactive. 
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 Hide Structures 

Structures that have been created cannot be deleted, but they can be hidden. 

1. From the Maintenance and Purchasing module, select Maintenance gadget→ Tools → Structures 

to open the Structure Lists window. Click the Search tab after selecting the parameters for the search.  

Click the Search button to initiate the search.  All the structures that meet the specified criteria are 

listed on the right side of the window for this specific ship. 

2. Click to highlight the structure to be hidden.  

3.   Click the Hide button.  

 

• A confirmation message box opens to verify that the structure is to be hidden.  

4. Click the Yes button to close the message box and hide the selected structure. 
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Section 11 Maintenance Plan 

The Maintenance Plan is the centralized interface where the status of the ship’s maintenance can be examined 

and coordinated. 

 

Filters are used to query the scheduled jobs to enable crewmen to plan the maintenance. 

Click the Maintenance Plan toolbar icon or Maintenance Plan from the Navigator pane to open the 

Maintenance Plan. 

 

There is a prompt - "No materials usage was reported. Were parts consumed?" that appears when the system 

preference "Prompt Users for Work Order Materials Consumption" is set to "Work Orders with Materials 

Required" for both serialized and non-serialized parts. 

 Concept 

The Maintenance Plan looks at: 

• Standard Jobs 

• Work Orders 

• Service Requisitions 

• Service Orders 

• No Action Jobs 

 

The Maintenance Plan lists overdue, current, and future maintenance of actual or projected standard jobs based 

on schedule date and filtered as required. 

Counter based standard jobs have a job counter which accumulates running hours since the last time the 

maintenance was performed.  

On the Counter Setup tab of the Equipment Detail is the Average Daily Usage. 
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NS Enterprise makes the following calculation:   

(Counter Interval – Job Counter) / Average Daily Usage = Days to go 

So, in this example, we find: 

(1,500 – 835) / 9 = 73.9 

NS Enterprise will schedule this job in approximately 74 days. 

The job counter is updated when the running hours are updated. The job is scheduled based on the most current 

information when the Maintenance Plan is recalculated.   

The calculation is straight forward for calendar-based maintenance intervals:  the maintenance interval is added 

to the Last Done date and the job is placed in the Maintenance Plan schedule. 

 Queries  

The Maintenance Plan has many filters to help narrow searches. Filters can be based on department, job 

category, date, position, or equipment. Almost every aspect of the maintenance is available to filter against. 

Uncheck the All checkbox and click the dropdown menu of the filter/s to open a selection window. 

Choose the items to filter for from the selection window and add them to the right side of the filter box. There 

is neither a minimum nor maximum for the number of filters that a user can select. 

Click the OK button. 

Choose a date range (this week, next 90 days, last month) or enter custom dates. The Maintenance Plan 

automatically defaults to the current week.    

 

Click the Refresh button when all the filters are tagged, and a date range is selected. The filters are applied.  

Clicking the column headers will sort the data after it has been filtered. All column headers may be sorted. 
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 Reports 

Multiple reports can be accomplished and printed from the Maintenance Plan. 

 

One method is choosing Reports from the Maintenance Plan menu bar and printing some of the preformatted 

reports.  These reports detail the specified information, such as Materials Requirements, Materials Shortages or 

Materials Usage. The report can be for all jobs or only for the jobs which have been tagged in the Maintenance 

Plan. 

Tagging filters and refreshing the Maintenance Plan can create a report with the “filtered” information.  

 

 Recalculating 

The Maintenance Plan should be recalculated daily and more often if deemed necessary.   

From the Navigator, select Maintenance gadget → Tools → Recalculate Maintenance Schedule to perform 

a user-initiated recalculation. 
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The 3 options include: 

• Calculate Through – if selected, click on the calendar icon to select an end date. 

• Complete Calculation – Completes the calculation for those jobs on the maintenance plan that are 

tagged/selected. 

• Revise Calculation – for the user to determine a manual revision for each selected job on the 

maintenance plan. 

NS local system administrator can set up to recalculate jobs automatically each night. 

The date of the last recalculation is shown in the topmost part of the Maintenance Plan. 

 

 

 Process Menu Options 

There are several options under the Process menu of the Maintenance Plan: 

 

Option Description 

   Create WO Creates a WO from the selected Standard Job. 

   Create NAJ Creates a No Action Job from the selected Standard Job that can be 

utilized for planning purposes. 

   Create SR Creates a Service Requisition to be performed by an outside contractor. 

   Create Requisitions Creates a Requisition from the selected WO based on the information on 

the Materials tab. 

   Re-Schedule WO Creates a new Reschedule Request for the selected WO. 

   Complete Jobs Completes the selected WO. 
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   Complete WO from Wizard Completes the selected WO using a Wizard. 

   Close WO Closes the selected WO. 

 Manage your Class Jobs 

Class Jobs can be displayed in the Maintenance Plan by selecting the appropriate filters.  

 

This list can be printed and delivered at the Class Surveyor as a first thing when he boards the vessel. 

 Create Worklists 

The Maintenance Time Plan can be filtered to print specific jobs or to allow personnel to view their jobs for 

a particular period as jobs are ready for distribution. There are several ways to filter these jobs. 

 
NOTE:   Past due, uncompleted scheduled jobs are listed at the top of the list no matter what 

filter parameters are set unless the Overdue Jobs check box is unchecked. The Status 

(ST) column is highlighted in pink for these jobs. The Display Overdue Jobs check 

box is in the section displayed when the Advanced Search button is clicked. 

1.   Column Headings – Click on any of the column headings to sort by that column heading in ascending 

or descending order. 

2.   By Period – Click on the dropdown menu in the Period field to select a time frame. The scheduled jobs 

on the Maintenance Plan change to meet the time frame criteria. The Start Date and End Date fields 

also change to meet the time frame criteria.  

 Click the Refresh button on the Maintenance Plan window toolbar to refresh the window after 

selecting the parameters. 

3.  By Department/Equipment/Position/Job Category – Click to uncheck the All box corresponding to  

Departments, Equipment, Positions or Job Categories fields to filter the scheduled jobs by one of 

these parameters.  

 Click the Refresh button on the Maintenance Plan window toolbar to refresh the window after 

selecting the parameters. 

4 By Advanced Search button section options – Click the Advanced Search toggle for more filter 

options.  
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Click the check box to select or unselect an option. Several options are checked by default. 

Click the Refresh button on the Maintenance Plan window toolbar to refresh the window after selecting the 

parameters. 

 Reschedule Work Orders, Service Requisitions, No Action Jobs or 

Service Purchase Orders 

Sometimes work orders, service requisitions, no action jobs or service purchase orders need to be rescheduled.  

 
NOTE:   Standard jobs cannot be rescheduled with this process. 

1.   Select a scheduled job from the job list on the Maintenance Plan window. 

 -- OR – 

 Click one of the options in the Tag menu on the Maintenance Plan window menu bar. 

2. Click Reschedule WO/SR/NAJ/SO from the Process menu.  
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• A confirmation message will be shown on the screen, Click Yes. 

 

• A Reschedule Request for Work Orders window opens. 

3. Select a Proposed Re-schedule Date from the calendar. Enter the Reason for Re-schedule. 

 

4.   Click Save. This will automatically Submit the re-schedule request and pending for acceptance / 

approval. 

   

NOTES:  

• If multiple WOs are tagged none of the work orders were being submitted if the scheduled 

date of any of the selected work orders was later than the proposed reschedule date. 

• Users can search for work orders using a filter criterion “Rescheduled Declined” on the 

work order search navigator screen. 

• The system allows Work Orders to be rescheduled before system schedule date through the 

new system preference “Allow Rescheduling Earlier than Scheduled by System Date”, 

This preference must be set to “Yes” for the functionality to take effect. Default value is 

“No”. 

 Complete and Close Work Orders 

Scheduled jobs must be completed before they can be closed. The Maintenance Plan can be used to complete 

and close scheduled jobs. 
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 Complete a Work Order 

1. Open a scheduled workorder by double clicking on it.  

2. Enter details on the appropriate tabs: 

a. Findings tab - to record the findings, if any.  

• Type the applicable information on the tab OR click the Copy Standard Text button on the 

Work Order toolbar to copy previously accepted text. 

 

• The Work Order Findings Text window opens.  Select text from the hierarchy panel on the 

left side of the Work Order Findings Text window. The text detail is displayed on the right 

panels of the Work Order Findings Text window. 

 

• Click Select on the Work Order Findings Text toolbar. The text is copied to the Findings tab 

of the selected work order.  

   

 

 

b.   Materials tab - to list the materials used to complete the work order.  

• Click Record Usage tab on the Work Order toolbar. The Equipment Explorer window opens 

by default on the equipment selected on the work order.  
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• Click through the hierarchy of the Equipment Explorer window to find the equipment and 

part used to complete the work order. Details of the highlighted equipment are shown on the 

right side of the window. 

• Enter the number of the selected part used to complete the work order in the Used field. 

 

• Repeat steps until all materials used are recorded. The system “remembers” the parts marked 

even when another equipment is selected with different parts. 

• Click Select on the Equipment Explorer toolbar. All parts with a value in the Used column 

are copied to the Materials→Required/Used tab of the Work Order window. 

 

9. Click the Completed field on the Work Order window to enter the completion date once all 

information have been entered. A message box opens verifying that the work order is complete.  

 

10. Click Yes to close the message box and enter the date into the Completed field. 
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NOTES:     A Work order can be completed with a date which is on or after the latest approval date of 

a linked JSA.  If the JSA approval process is disabled, then the work order completion date 

should be on or after the latest completion date of linked JSA. 

11. Click Save on the Work Order window to close the completed work order.  

 

 The Maintenance Plan window changes to display the completed work order. The ST field on this 

scheduled job is shaded green with a “CP”. 

  

 

 

 

 

 

     Then click Process → Complete Jobs from the menu bar. The selected job is displayed as 

             completed on the Maintenance Plan window with a “CP” in the green shaded ST field. 

 

 Close a Work Order 

Work orders MUST be complete before they can be closed. 

1.   Click the check box to select a completed work order. The ST field is shaded green with a “CP” for a 

completed work order. 

2.   Click Process → Close WO from the Maintenance Plan window menu bar. The closed work order is 

removed from the Maintenance Plan window.   

NOTE:   Click to select a scheduled job on the Maintenance Plan window if your organization does 

not require findings and materials to complete a job.  
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NOTE: When closing a work order, the system will check to ensure that material usage has been 

recorded if the related system preference is enabled.  If material usage has not been 

recorded a message will display requesting the information before closing the WO. 

 



  Nautical Systems Enterprise Maintenance User Manual 

©2020 American Bureau of Shipping and affiliated companies. All rights reserved. This document contains proprietary and confidential information for review and discussion 

purposes only. No part of this document may be used, disclosed, copied, or distributed, by any form or any means, without the express written consent of the American Bureau 

of Shipping.   

       PROPRIETARY AND STRICTLY CONFIDENTIAL. DISTRIBUTION TO THIRD PARTIES IS STRICTLY PROHIBITED.          P a g e  | 181 

Section 12 Planning and Recording Maintenance 

The Maintenance Plan is the centralized location where work can be planned and recorded.  All scheduled 

maintenance is found here, as well as service requisitions, service purchase orders and previously entered 

corrective maintenance that is still outstanding. 

  Planned Maintenance 

Opening the Maintenance Plan and choosing filters to zero-in on the maintenance for which a particular 

position or job category is responsible. 

Click the Refresh button and the filters are applied. 

The PM column indicates whether or not the job is planned. These could be standard jobs that are scheduled; 

or work orders, service requisitions or service purchase orders that were created from a standard job. 

These line items are corrective maintenance if the PM column is empty. 

The user can double click on any of these line items to see the work description and other details of the job. 

 Create a Work Order 

Tag one or more standard jobs in the Maintenance Plan.  These are jobs that the user wants to have 

performed/scheduled. 

Choose Process in the main menu bar. 

The user can choose to create a work order, a no action job or a service requisition. 

• WO: Work Order – This is work that the ship’s staff performs. 

• NAJ: No Action Job – NAJ is to be utilized for planning purposes, i.e. jobs associated to a budget or 

MOC which is still in the planning phase. The NAJ is changed to either a work order or service 

requisition once finalized, and work is to proceed.  

• SR: Service Requisition – This is when the work is to be performed by an outside contractor. The 

work order becomes the requisition for the contractor. 
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The status changes to WO after clicking Create WO (or NAJ or SR depending on what type was selected). 

 

  Corrective Maintenance 

NS uses the work order to capture corrective maintenance.  A corrective maintenance work order is the same 

as a work order created from a standard job, except that a crewman fills out the job description, designates a 

scheduled date, link equipment and resources. 

When creating a new Work Order document, the Perform By field has the same three options that have already 

been described in the previous Planned Maintenance section. 

• WO: Work Order  

• NAJ: No Action Job 

• SR: Service Requisition 

Work orders and no action jobs are contained in this section. 

 Create a Work Order – WO/Crew or No Action Job 

From the Maintenance gadget, select Documents → Create → Work Order. This opens the Work Order 

document detail. Fill out the applicable fields in the main header. 

1. Give the work order a Title. Be sure that the title is descriptive to provide others with a brief indication 

as to the nature of the work. For instance, “Engine #1 Governor Change Out” is preferable to “#1 

Engine Repairs.” 
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2. The Scheduled Date field automatically enters today’s date, but this can be changed to any date. This 

date is used for placing the WO in the Maintenance Plan.  The scheduled date must be set to when 

the work is expected to actually be performed with consideration given if materials are required or 

operations presently prevent this work from being conducted immediately. 

 

3. Connect equipment to the work order. Click the dropdown menu at the end of the Equipment field 

and an Equipment Explorer window opens. 

a. Drill down through the hierarchy and tag the equipment to be associated to the Work Order.  The 

unit (Parent) should also be linked to the work order when linking a work order to a component 

or maintained part.  This ensures that all maintenance is recorded in the parent equipment 

maintenance history.  Be sure to tag the Child before the Parent. Then click the Select button and 

the work order is linked to this equipment. 
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• A window opens if selected equipment has any standard jobs associated with that equipment, 

the user can link a standard job to the WO if any of the standard jobs encompasses the work 

planned to perform or schedule.  

• Most often the user will choose to close the window or select Do Not Link SJ.  This means 

the Work Order will be a non-PM job and it is not connected to any Standard Job. 

• Linking a standard job to a work order adjusts the schedule for the standard job. If an 

equipment has a Standard Job linked to it, below pop-up will be displayed. Select the 

appropriate action. 

• Linking a standard job to a work order adjusts the schedule for the standard job. If an 

equipment has a Standard Job linked to it, below pop-up will be displayed. Select the 

appropriate action. 

 

b. The Perform By field identifies who will be performing the work.  Designate the WO as 

WO/Crew or No Action.   

c. Choose a Priority for the WO: 

• A -   Critical 

• B - Urgent 

• C -   Important 

• D - Normal 

          The work order defaults to D. 

d. The next field is a Failure check box.  Failure codes must be entered on the Failure tab if the 

box is checked.  The Failure box is tagged only when equipment fails or breaks down. This 

includes failures in which equipment fails to meet operational parameters. 

e. Click the Event radio button to link the work order to an event. 

Description Tab 

Enter the work to be performed. Be as complete as necessary, especially considering that this work may be 

performed in the future when original crewmen are no longer onboard.   
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The user can also link text from the text library to use as a template. Choose Description → Copy Text from 

the menu bar. 

A Job Description text library opens where the user can choose a template as applicable. 

 

Job Safety Analysis / Work Permit Tab 

The Job Safety Analysis (JSA) feature includes custom risk matrices incorporated into a job safety worksheet 

that can be linked to work orders, service requisitions, service orders, equipment, maintained parts, spaces, and 

corrective action requests.  

Permit to Work is used to provide controlled process for documentation and approval of necessary 

preparations before maintenance activities can be performed where applicable. It is considered an integrated 

part of the JSA workflow. 

Refer to the HSQE manual for a detailed information on JSA and Permit to Work functionalities. 

 
 

Work Certificates Tab 

Displays all the certificates associated with the workorder. 

 

Findings Tab 

The Findings tab is where the user can write down all work performed and any relevant information that should 

be included in the work history. This is done when completing the WO.   

 

 

 



  Nautical Systems Enterprise Maintenance User Manual 

©2020 American Bureau of Shipping and affiliated companies. All rights reserved. This document contains proprietary and confidential information for review and discussion 

purposes only. No part of this document may be used, disclosed, copied, or distributed, by any form or any means, without the express written consent of the American Bureau 

of Shipping.   

       PROPRIETARY AND STRICTLY CONFIDENTIAL. DISTRIBUTION TO THIRD PARTIES IS STRICTLY PROHIBITED.          P a g e  | 186 

Questionnaire Tab 

This tab shows the details of the Questionnaire that was selected in the Questionnaire dropdown menu, which 

is located in the WO screen header. 

 

If the user has not yet selected a job category for the work and clicks the dropdown menu on the questionnaire 

field on the new work order screen a message will be shown as below: 

 

Job Category is designated on the Admin Info Tab.  Is user clicks Yes, and a job category is selected the 

dropdown menu for the questionnaire field becomes enabled.  Selecting a questionnaire populates the 

Questionnaire tab with the questions/checklist associated to the questionnaire. 

Observation Tab 

Clicking on the Observation tab and selecting new will first save the work order and allow the user to create a 

finding and add their observation comments related to the questionnaire and a specific question. 

 

If a finding was previously created, it will be displayed as a row on the Observation tab. 
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Admin Info Tab 

Go to the Admin Info tab.  Designate a Job Category and Cause.  The account code is automatically populated; 

if not, select the appropriate account code manually. 

The user can link a Project, which are used to connect financially related WO’s, requisitions, purchase orders 

and invoices that have a different budget. 

The Department field is for the department that is responsible for completing the work order. Third party 

contractors generally do not have access to the ship’s database so DO NOT use “Third Party” as a department; 

the department for overseeing the work should be entered instead. 

 
 

Materials Tab 

a. On the Materials tab, right-click on the field and choose New Required Item. 

• This opens an Equipment Explorer window in the Purchasing view.  The Purchasing View 

displays the spares for that equipment if there is equipment connected. The list starts at the top of 

the hierarchy if no equipment is connected. 

b. Update the quantity of the spares required to complete the job. 

• The item the user linked is listed in the Required/Used section of the Materials tab, as well as the 

current inventory level. 

If necessary, create a requisition linked to the WO from the Materials tab for any missing items. See Creating 

a Requisition from a Work Order in the Purchasing User Manual. 
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Resources Tab 

Refer to Item 21.4 Resources Tab section of this manual. 

NOTE:  All resources required to perform the work (including recording information in NS) must be listed. 

 

Status Tab 

The status of the WO, as well as the date and identity of status changes, such as created, completed, and closed 

are listed on the Status tab. 

 

Message Tab 

Refer to Item 21.5 Messages Tab section of this manual. 

 

Safety Observation Tab 

User can add a new or open a Hazard Report. On the Safety Observation tab, right-click on the field provided 

and select the appropriate action. 
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Equipment/Space/Structure Tab 

The Equipment tab lists the equipment/space/structure that is connected in the Main Header. 

a. On the Equipment/Space/Structure Tab, right-click on the field provided and choose Link/Unlink 

Equipment/Maintained Part to add more equipment.  This does not change the account code but does 

put this WO into the maintenance history of the linked equipment. User may also link/unlink Space or 

Structure. 

 
 

File Attachments Tab 

Refer to Item 21.2 File Attachment Tab section of this manual 
 

Readings Tab 

The Readings tab contains tables that have been linked to the standard job from the Tables Template Setup 

window. These tables are used to record readings taken during the job. 

Double click on a row to enter in the values for the item. 
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CARs Tab 

The CARs tab listed all CARs associated to the work order.  The CARs tab columns include: 

• CAR Number 

• Title of the CAR 

• Type of CAR 

• Corr/Verified 

• Created Date 

• Status 

• Created by 

• Class Findings 

• Documents  

 

Failures Tab 

The Failures tab opens when the user tags the Failure check box in the Main Header.  

NOTE:  The Offline times shall be entered if equipment is taken offline during the job for all maintenance 

(Planned and/or Corrective). This information allows us to evaluate the equipment offline time in relation to 

man hours. 

Select the Failure Mode and Cause. 

Connect the failed part to the work order for a more complete work history.   

Click the right mouse button in the Failed Parts section and link the part that actually failed. Failed parts are 

different than required parts; required parts are those parts necessary to carry out the maintenance, as well as 

to restore inventory levels. The failed part is the actual part that failed. 
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Hull Manager Tab 

The Hull Manager tab lists inspections and anomalies associated with the work order. The information on this 

tab is system generated when anomalies are added in the Hull Manager module. 

 
 

Sub-Items Tab 

The Sub-Items tab is primarily used for Drydock jobs, but it can be used for other types of work.  It explains 

how many of the part or equipment associated with the job are involved in the procedure.  

 

 
 

The Sub-Items tab has a listing for removing the bearing shells but specifies that there are 2 – one upper and 

one lower that need to be removed.  

The Sub-Items tab is a free form text tab. 

 

Change Orders Tab 

The Change Orders tab is associated with the Drydock records. 
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Daily Logs Tab 

The Daily Logs tab is associated with the Drydock records.  

Tracking Tab 

The Tracking tab is primarily used for Drydock jobs, but it can be used to track the progress of other jobs. The 

functionality of making pre-payments on invoices based on percentage of job completion is only available with 

Drydock jobs. 

The Tracking tab is used to track the progress of the work order or any sub-items of the service. These items 

are listed on the Sub-Items tab of the Service Item window.  Any items listed on the Sub-Items tab are listed 

in the Sub-Item Tracking section of the Tracking tab 

 
 

DMS Link Tab 

Refer to Item 21.8 DMS Link Tab section of this manual. 

 

Custom Forms Tab 

Refer to Item 21.3 Custom Forms Tab section of this manual 
 

NOTE:       If the work order was created from a Standard job that had a custom form templated linked, it will  

                   copy to the work order when it is created. 

 

Serialized Items Tab 

The serialized items tab allows the user to link/unlink serialized items to the work order. 

 

Related Work Tab 

The related work tab displays work orders that are created as a result of the work order.  To link a work order 

that is related to the selected/displayed work order, click on the process menu, and choose Link Work Order. 
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Save 

Click the Save button when the WO is filled out completely.  This closes the WO window. 

The WO can be found again by performing a search from the Navigator or in the Maintenance Plan 

 Rescheduling a PM Work Order 

At times it may be necessary to reschedule a work order.  Work orders that have been created from standard 

jobs need permission from the office to be rescheduled. 

1. Open the work order that need to be rescheduled.  Users can find the work order in the Maintenance 

Plan.    Double click the work order to open it. 

The user can also perform a search from the Navigator. From the Maintenance gadget, select Documents → 

Search → Work Orders. Select filters and click Search. 

2 Click the button next to the Scheduled field.  Choose a new Scheduled date.  

 

NOTE:    

• A work order can be rescheduled anytime. However, a maximum number of re-schedules can be  

                    set in the System Preference. 

• When the deferral is based on length of deferral, the system looks at the total number of days a 

work order has been deferred from the original scheduled date rather than the latest scheduled date. 

This ensures the proper level of oversight and prevents a single user from deferring a work order 

indefinitely a few days at a time. 

 

4. A window opens asking for the reason to reschedule. Enter an explanation and click Submit. 
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NOTE:      A warning box opens if the user attempts to re-schedule a work order that has already been  

                   rescheduled. 

 

5. The authorized user in the Office can find work orders with a rescheduling request.  From the 

Maintenance gadget, select Documents → Search → Work Orders. Tag the To be Re-scheduled 

box and click Search. 

6. Double click on the work order to open it.  Choose Process → Re-Schedule → Accept or Decline from 

the menu bar. 

A window opens asking for a Reason for Acceptance if user chooses Accept.  Enter an explanation and click 

Submit.  Note that the user can change the Re-Schedule date at this point. 

A window opens asking for a Reason for Decline if user chooses Decline. Enter an explanation and click 

Submit. 

7. The work order is placed in the Maintenance Plan at the re-scheduled date. 

 Completing a Work Order 

All work orders get completed after the work is performed regardless if the work order is for planned or 

corrective maintenance.  Completing the work order changes its status from “Created” to “Completed”.   

NOTE:    Completing a work order cannot be undone 

 Findings Tab 

Click on the Findings tab and enter information about the work performed.  Every work order, whether planned 

or corrective, must have Findings entered. 

NOTE:     Be sure to enter meaningful findings.  Do not just enter “done” as this is not helpful in establishing  

                 useful maintenance history 
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 Resources Tab 

Refer to Item 21.4 Resources Tab section of this manual. 

 Changing Status to Complete 

  1. Click on the Completed date field and a Calendar window opens. 

2.    Select the completion date. This date cannot be in the future. 

 

• A warning box opens. Completing a work order cannot be undone. If the user wants to complete the 

WO, then click Yes.  This completes the work order. 

 

 Closing a Work Order  

The final step in recording the maintenance performed is to Close the work order.  It is the responsibility of the 

Chief Engineer to review all completed work and close each work order individually after confirming all 

required data is recorded. 
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1. From the Maintenance gadget, select Documents → Search → Work Orders to find work orders to 

be closed. By using the filters, users can select work orders that have been Completed. Remember that 

this search can be saved and put it on user’s Workspace area for easy future access. 

The work order could also be opened from the Maintenance Plan by filtering for Completed Work Orders. 

This is the last opportunity to edit the Findings tab.  The Findings tab is locked once the WO is closed. 

2. Go to Process → Close to close the work order. 

 

The work order is now closed and will no longer appear in the Maintenance Plan unless the user filters for 

closed WO’s. 

After the user closes the work order there may be additional findings that the user wishes to report. 

Open the work order and choose the Findings tab.  There is a field at the bottom of the tab labeled Enter 

additional findings here.  The user can enter the information here. 
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 Cancel a Work Order 

Sometimes there may be a need to cancel an unscheduled work order.  Work orders can be cancelled if they 

have not yet been completed. When an unscheduled work order is cancelled it gets hidden but can still be found 

in the system. 

             

Instead of canceling a work order, the user can change the title, link different equipment, and reuse the document 

for the next unplanned maintenance action. 

 Creating a Service Requisition 

Service Requisitions are a combination of a work order and a requisition.  Service requisitions are used to 

schedule work that is to be performed by a contractor or technician, such as a service or troubleshooting call, 

an inspection or certification of equipment. 

A service requisition is created when the user selects SR/Contractor in the Perform by field in creating a work 

order. 

1. From the Maintenance gadget, select Documents → Create → Work Order. 

2. Select SR/Contractor in the Perform by field.  This creates a service requisition rather than a 

traditional work order. 

 

• The biggest difference between a work order and a service requisition is that a service requisition needs 

to be both Authorized and Approved. 

• The creation of a service requisition is more or less the same as the creation of a work order. However, 

there are a few differences. 
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 Description Tab 

The instructions written on the Description tab need to be extremely detailed and thorough.  This is because 

the Description tab contains the information that potential vendors use to price the job, as well as to prepare 

for the work. 

If the description is not complete, the contractor may not anticipate the complete scope of the job and may not 

be able to carry out the work. 

1. Select Description → Copy Text from the menu bar. 

 

• A Job Description text library opens.  

2. Drill down to find SERVICE REQUISITION.   

3. Highlight it and select from one of the 3 templates available to the right.  

4. Highlight the desired template and click the Select button. This copies the template information to the 

Description tab. The Job Description can now be filled in, point by point, to ensure all relevant 

information is entered into the service requisition. 
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 Department Responsibility 

It is important to ensure the Department responsible for overseeing the contractor has been is set.  The 

department also indicates who is responsible for the completing the service order item. 

Click the Admin Info tab in the Service Requisition. Then click on the dropdown menu to select the 

Department. 

 

  Authorization 

Since a service requisition is a requisition as well as a work order, the service requisition needs to be authorized. 

Once the SR has been prepared, a message is sent to the Head of Department / Chief Engineer to review the SR 

for technical content. The HOD and/or Chief Engineer then send a message to the OIM for authorization of the 

service requisition. 

From the Maintenance gadget, select Documents → Search → Work Orders to find service requisitions to 

be authorized. Select service requisitions that have been scheduled using the filters. Remember searches can be 

saved and put it on the user’s Workspace area for easy future access. 

Authorization is the signal to the office that the requisition is ready for them to take action. 
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 Approval 

The Approval process takes place in the office.  A service purchase order is created once the service requisition 

is approved.  This is shown in the Maintenance Plan.  

From the Maintenance gadget, select Documents → Search → Work Orders.  Select service requisitions that 

have been authorized using the filters.  Remember that searches can be saved and put it on the user’s 

Workspace area for easy future access. 

             

 Converting a Service Requisition into a Service Purchase Order 

A service purchase order can be created when a service requisition is authorized and approved. This is a 

conversion process in which the service requisition is turned into a service purchase order. In other words, once 

a service requisition is converted into a service purchase order, it is listed as service order items (SO) in the 

work order search. The service requisition number is still listed in the query, however when the document is 

opened, it is a service order item on a purchase order. 

The Service Requisition cannot be completed until the Service Purchase Orders is issued. 

 

The Materials tab is first on a materials purchase order. 

Purchase orders for materials and service purchase orders are on the Purchase Order window. The main 

distinction between them is which tab appears first when the Purchase Order window is opened. The Service 

tab is first on a service purchase order.  
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 Completing a Service Order 

Completing a service order is very similar to completing a work order.  Please note that only Heads of 

Department, Chief Engineers or Technical Supervisors can complete a service order. 

NOTE:    Do not enter the Completion Date until all other information is entered.  The service order is closed  

                 for editing once the Completion date is entered. 

 

1.   Open the service order from the Maintenance Plan.   

• Notice that the detail is called a Service Item because it is a line item on a service purchase order. 

Completing the Service Item takes delivery of the line Item on the purchase order.  A purchase 

order may have more than one service line item.  They each need to be completed individually. 

2. Enter findings on the Findings tab. This can be the text of the Contractors Service Report or a user 

defined report. 
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3. Attach the Contractors report as a file attachment.  Go to the File Attachments tab, click the right 

mouse button in the tab and choose Attach. 

 
 

4. Report any spares consumed on the Materials tab. 

 
 

5. Click on the Completed date field and a Calendar window opens.  Choose the completion date. This 

date cannot be in the future.  The service item is closed for editing once a completion date is entered. 

            

 

 NOTE:  If the Completion Date field is grayed out the user cannot complete the service item if the 

purchase order to which the service item is connected has not been issued. 
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 No Action Jobs 

No Action Jobs are jobs that are used as placeholders for jobs not assigned yet to a crew member or a contractor. 

They can also be used as reminders for jobs that they are not rescheduled based on an interval or running hours. 

A job can be identified by the Perform By field where its value is No Action as per below: 

 

 Converting a Standard Job to Work Order 

A Standard Job is converted into a Work Order before it is carried out, to properly record all information that 

goes with the task. Follow below steps if also converting SJ to other forms (NAJ, SR. Just select the correct 

form in the Process menu.) 

1. Go to Maintenance & Purchasing Module ➔ Maintenance ➔ Maintenance Plan 

2. Search and tag the Standard to be converted into Work Order. 

3. Go to Process menu and select Create WO. 

 

Converted Document 
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Section 13 Maintenance Events 

Event based maintenance consists of standard jobs that are neither calendar nor counter based but must be 

carried out when certain operations occur, such as dry docking or port calls. Users can organize this maintenance 

by creating a maintenance event and then connecting these jobs to the event within NS.  

A Maintenance Event is used to organize related jobs, purchases, and services. The event can be compared to 

a folder holding a group of jobs, SO’s or PO’s that are planned for a particular time and place. All jobs within 

a maintenance event have the same scheduled date. 

Create a maintenance event. Then connect work orders to the event.  The Logistics Coordinator can connect 

purchase orders that are related to this work. Service orders are also connected.   

Maintenance events can be linked to jobs either directly from the job window or from the maintenance event 

itself. The two most important features of the maintenance event are: 

• Grouping and accessing any number of diverse maintenance tasks. The workload of jobs can be planned 

or searched within a particular event. 

• Scheduling of any number of jobs together. NS automatically reschedules all the associated work when 

a single date is changed in a maintenance event. The system recalculates the Ship’s Maintenance Plan 

to adjust to the change. 

An event does not have to be a physical place. For instance, an event can be created called Next Port Call.  Use 

the event to organize work or purchasing. 

 Create a Maintenance Event 

1. Select Documents → Search → Maintenance Events from the Maintenance gadget on the Navigator. 

• Previously created maintenance events are listed on the Event List window. Use the Search 

function to find a particular event. 

 

2. Click the New Event button on the Event Lists window.  The Event – New window opens. 
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3. Enter the details concerning the event on the Events Particulars tab of the Events – New window.   

4. Click the Job List tab to add jobs to the event. 

5. Click the Save button to save the event and close the Events – New window. 

 

 Search for a Maintenance Event 

1. Select Documents → Search → Maintenance Events from the Maintenance gadget on the Navigator. 

2. Tag various search terms or search for an event name.  Use wildcards (*) to broaden the search. Use the 

“Since” function to search for events after a certain date.  Click the Search Button.  Search Results will 

display in the Event Lists window. 
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3. The fields that display in the search results include:  Start Date, Port, Event Name, Number of Days and 

Number of Jobs. 

 Link a Job to an Event 

1.   Search for the Maintenance Event and double click to open the Maintenance Event document from the 

Event Lists search results. 

2.   Click the Job List tab on the Event window. Jobs associated with this event are listed in the bottom 

section of the window. 

3. Click Add from the Event menu bar.  There are several items available to add to the job list of the 

event.  For purposes of this example select Find Work Order/SR/NAJ. The Work Order Selection 

window opens. 

 

4. Use the options available on the Work Order Selection window to locate the job to be added to the 

event.   

 
NOTE:  Click the Refresh button on the Event toolbar or the Search button on the Work Order 

Selection window if there are no jobs listed on the right side of the Work Order Selection 

window. 

5.  Click in the check box to select the job to be added. 

6.  Click the Select button to add the job to the Job List tab on the Event window. 

 

 Processing Jobs Associated with an Event 

1.   Search for the Maintenance Event and double click to open the Maintenance Event document from the 

Event Lists search results. 

2.   Click the Job List tab on the Event window.  

3. Use the various filters as necessary to locate the job to be processed. 
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4. Click the dropdown menu at the end of the selected field to select an option. A selection window opens. 

The information is different depending on the category selected; however, the functionality is the same.  

5.   Double click on a selection on the left side of the window to move it to the right side of the window. 

Continue making selections until all desired options are moved to the right side of the selection window. 

 
NOTE:  Double click on an option on the right side of the window to move the selection back 

to the left side of the window to remove the selection. 

6.   Click the OK button to close the selection window. 

7. Click the Refresh button on the Event window to refresh the window after setting the parameters. 

 

 Convert the Jobs to Work Orders 

NS adds the jobs to the event as service requisitions.  

Open the service requisitions one by one and convert them to work orders by choosing WO/Crew in the 

Perform By field. 

Click Save and move to the next SR until all are converted. 

 

NOTE:      The event can be edited to the correct date once the date of the Next Dry Dock is known and renamed  

                  something relevant.  The maintenance can be entered as the jobs are carried out. 
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Section 14 Standard Jobs 

 Create Standard Job 

Select the Maintenance gadget→ Documents→ Create → Standard Job from the Maintenance and 

Purchasing module at the Fleet level to create a new standard job. Only authorized users can create standard 

jobs. The standard job created by the central office for the fleet is a general template for the actual job. Any or 

all options can be changed by the ship as necessary, but only by authorized users. 

The Standard Job – New window opens.   

 
 

The fields on the Standard Job – New window are: 

System preferences can enable auto creation of documents.  Contact your ABS Account Manager if you have 

questions on auto creation. 

Standard Job to Work Order Conversion System Preferences below: 

• Turn On Standard Job Auto Conversion   

• Days to auto convert Machinery SJ to WO   

• Days to auto convert Spaces SJ to WO   

• Days to auto convert Structure SJ to WO   

• Days to auto convert Survey SJ to WO   

• Days to auto convert Miscellaneous SJ to WO  

• Days to auto convert Services SJ to WO   

• Days to auto convert Condition Monitoring SJ to WO 
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Fields Description 

Job Type 

section: 

 

Click a radio button in the Job Type section to select the type of job for the standard job. 

The options are: 

Machinery – These jobs are based on the ship’s-maintained machinery equipment 

contained on the ship’s hierarchy. The machinery equipment PM standard job combines 

the equipment name with an index term indicating the job size. The job schedule is based 

on either a calendar or running hour interval.  

Spaces – Spaces on the ship that are listed in the classification society and other regulatory 

body requirements need to be maintained. These spaces include cargo holds, service tanks 

and cabins. A standard job is created to perform this maintenance. The standard job name 

is a combination of the space name and an index term indicating the job size. The job 

schedule can only be based on a calendar interval. 

Surveys/Certificates – Regulatory requirements defined by organizations such as 

government agencies, coast guard and classification societies are another job type for 

standard jobs. These jobs are based on a survey index term and the job schedule can only 

be based on a calendar interval. 

Services – These are services provided to the ship to facilitate other work. For example, 

dry-dock services such as compressed air, shore power, tugs, dry-dock days and others. 

The dry-dock services are a significant portion of the overall dry-dock cost. The job 

schedule can only be based on a calendar interval. 

Condition Monitoring – These are jobs that monitor the condition of selected equipment 

according the condition monitoring types associated with the equipment. The job schedule 

is based on either a calendar or running hour interval. 

Miscellaneous – This is work of a general nature such as painting, sandblasting or anode 

replacement that is not associated with a specifically identifiable item on the ship like a 

piece of equipment or space. However, miscellaneous work can be cross-referenced with 

multiple items such as equipment or space so that when the standard job is completed these 

areas are automatically updated with maintenance history. The job schedule can only be 

based on calendar interval. 

Structures – Structures within compartments on the ship that are listed in the classification 

society and other regulatory body requirements need to be maintained. These structures 

include girders, brackets, and stiffeners. A standard job is created to perform this 

maintenance. The standard job name is a combination of the structure name and an index 

term indicating the job size. The job schedule can only be based on a calendar interval. 

Do not 

schedule 

during lay-up 

period check 

box 

The Do not schedule during lay-up period check box is related to the Drydock module. 

The check box is available on the Standard Job window regardless of whether the 

Drydock module is available or not.  
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Fields Description 

Inherent 

Predecessors 

check box 

Click the Inherent Predecessors check box to indicate that this job is an inherent 

predecessor.  

The Inherent Predecessors check box is used to prioritize jobs within the same machinery 

or space. It tells NS how to schedule these jobs. All jobs under the same equipment are 

scheduled according to their Job Size Indicator. When the Inherent Predecessor is indicated 

on a job it means that a job with the larger size indicator covers the requirement of jobs 

with lesser indicator values. For example, when the larger job is completed, the smaller 

jobs are also credited. 

All jobs under the same equipment or space MUST have the Inherent Predecessors check 

box checked for this procedure to work correctly. 

The inherent predecessor is indicated when the standard job is created at the central office 

level, however it can be changed at the ship level.  

This check box is only available for Machinery, Space or Structure job types. 

Job Constraint 

section 
Click a radio button in the Job Constraint section to select whether the standard job is 

calendar or counter based.  

• Calendar-Based – job intervals based on number of days, weeks, or months. This 

radio button is enabled for all job types.  

• Counter-Based - job intervals based on a single counter. This radio button is 

enabled if the Job Type is “Machinery” or “Condition Monitoring”. 

• Calendar vs. a Single Counter – standard jobs with a schedule based on a 

combination of calendar and a single counter. For example, a job can be scheduled 

for every 12 months or 3,000 hours whichever comes first. This radio button is 

enabled if the Job Type is “Machinery”.  

• One Counter vs. Another Counter – standard jobs with a schedule based on a 

combination of two counters. For example, a job can be scheduled for every 3,000 

hours or 20,000 tons of fuel consumption whichever comes first. This radio button 

is enabled if the Job Type is “Machinery”. 

The Job Constraint field restricts the modification of Job Constraint once a Standard Job 

has been created. 

System Preference:  Prevent change of job constraint between calendar and counter".  If 

this preference is set to "No", only users that have the authorization "Edit Job Constraint" 

can edit the Job Constraint of the standard Job between calendar based and counter based. 

If this preference is set to "YES", the Job Constraint cannot be changed regardless of user 

authorizations. 

Schedule Based 

On section 

Click a radio button in the Schedule Based On section to select whether the schedule is 

based on the completion date or the due date. 
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Fields Description 

Maintenance 

Trigger 
The Maintenance Trigger section is used when the Job Type is “Condition Monitoring” 

and the Job Constraint is “Counter-Based”. 

Click the radio button to select which counter is to be used for the job.  

• Grouped Counter – this is the default value.  Only one vessel can be selected. 

The Grouped Counter is used when multiple pieces of equipment are using a 

single counter. For example, the job is taking oil samples from engine support 

equipment and shafting when the main engine counter reaches a specified number.  

The selected counter determines when the standard job is scheduled on the 

Maintenance Plan. One standard job is created.  

• Individual Counter – The Individual Counter is used when multiple pieces of 

equipment use the same counter interval. Multiple vessels and equipment can be 

selected. Each piece of equipment has its own counter, but these counters MUST 

have the same counter interval. A separate standard job is created for each piece 

of equipment.   

PTW 

Requirement 
The PTW Requirement section is used to indicate whether the job requires permit to 

work. Click the check box to indicate that it is.  

Click the dropdown menu at the end of the Template field to select the PTW template to 

be used with the job. 

JSA 

Requirement 
The JSA Requirement section is used to indicate whether the job is required for Job Safety 

Analysis. Click the check box to indicate that it is.  

Click the dropdown menu at the end of the Template field to select the JSA template to 

be used with the job. 

Calendar 

Interval 
Click in the Calendar Interval field to type the frequency in weeks or months that this 

job is to be performed.  The maximum value is 999,999. 

Click the radio button to indicate whether this value is in weeks or months. 

Counter 

Interval  
Click in the Counter Interval field to type the frequency in running hours that this job is 

to be performed. The maximum value is 999,999.  

Grace 
Click in the Grace field to type the number of weeks in excess of the interval period that 

is allowed for a grace period. The maximum value is 999,999. 

The default value is zero. 

 Job Type Details Tab 

The Job Type Details tab specifies information about the job such as job category, size and specific equipment, 

space, surveys/certificates, and ships.  Fields on the Job Type Details tab change depending on the type of job 

selected, but the general information remains the same.  All fields on the Job Type Details tab are REQUIRED.  
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Machinery Job Type 

 

NOTE:    The Job Size Index and Job Size Indicator fields MUST be completed before the  

                 Equipment / Maintained Parts button will work. 

 

The fields on the Job Type Details tab for the Machinery job type are: 

Field Description 

Job Size Index Click the dropdown menu at the end of the Job Size Index field to select 

the job size index. The Job Size Index List window opens. 

Select a job size index term. Authorized users can create a new job size 

index term from this window.  

 

NOTE:  The job size index term becomes part of the job title.  

Double click on a selection to close the Job Size Index List window and 

copy the term into the Job Size Index field. Only one selection can be 

made. 

The Job Size Indicator field opens for editing. 

This is a required field. 

Job Size Indicator Click in the Job Size Indicator field to type a value. The Job Size 

Indicator defines the relationship of the job compared to other jobs under 

the same equipment or space. This rating is from 0 – 99. 

This is a required field. 
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Field Description 

Equipment/Maintained 

Parts button 

Click the Equipment/Maintained Parts button to add equipment or 

maintained parts to the job. The Equipment Explorer window opens with 

all ships identified in the fleet.  

Click the + sign in front of each ship to expand the hierarchy tree.  

Continue clicking the + sign in front of each item to view the equipment 

and parts for each ship. 

Click the check boxes preceding the equipment or maintained part to 

select.  

Click it again to unselect any equipment or part. 

Click the Select button on the Equipment Explorer window to close the 

Equipment Explorer window and add the items to the Job Type Details 

window. 

 

NOTE:  Equipment and parts can be selected from multiple 

ships at the same time. However, each ship only sees their 

equipment and parts. 

This is a required field. 

Last Done Click the Calendar button at the end of the Last Done column to select 

the date this job was last done on this ship. 

 

Last Due Click the Calendar button at the end of the Last Due column to select the 

date this job is due to be done on this ship. 

 

Job Counter Click in the Job Counter column to type the number of hours on the 

equipment/maintained part job counter since the last time the job was 

done. 

 

NOTE:  The Job Counter column is applicable if this is a 

counter-based job.  

 

 

 

Spaces Job Type 

 

The fields on the Job Type Details tab for the Spaces job type are similar to the ones for the Machinery job 

type.  

NOTE:      The Job Size Index and Job Size Indicator fields MUST be completed before the Spaces 

                   button will work. 
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1.   Click the Spaces button to select the spaces needed for the standard job. The Space List window opens.  

2. Click the Search tab. Select the parameters to find the defined space. At least one parameter MUST be 

selected. Click the Search button at the bottom of the Search tab. All spaces meeting the selected 

parameters are listed on the right side of the window.  

3.   Click the check box preceding each defined space to select. Click the check box again to unselect any 

space. Multiple selections from multiple ships can be selected. 

 
 

4. Click the Select button on the Space List window to close the window and add the spaces to the Job 

Type Details window. 

  
 

5. Click the Calendar button at the end of the Last Done column to select the date this job was last done 

             on this ship.  

 

6. Click the Calendar button at the end of the Last Due column to select the date this job is due to be 

done on this ship.  
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Surveys / Certificates Job Type 

 

The fields on the Job Type Details tab for the Surveys/Certificates job type are a little different from the 

previous tabs.  

NOTE:   The Surveys/Certificates Index and Title fields MUST be completed before the Ships button will 

                work 

1.   Click the dropdown menu at the end of the Surveys/Certificates Index field to select an index term. 

The Survey/Certificate Index window opens. Authorized users can add new index terms from this 

window. 

2.   Click to highlight a survey or certificate.  

3.   Click the Select button on the Survey/Certificate Index window to close the index window and add 

the selection to the Surveys / Certificates Index field. This selection is also entered into the Title field 

of the Job Type Details tab. The Title field can be edited. 

 

NOTE:  Surveys and certificates are defined on the Surveys / Certificates Index window. New surveys and 

               certificates can be defined by authorized users from this window or from the General Data module. 

 

4.   Click the Ships button to select the ships that the survey or certificate applies to. The List of Ships 

window opens with all the ships defined in the fleet.  

5.   Select a ship from the List of Ships window. Double click on a selection from the left side of the 

window to move it to the right side. Continue making selections until all ships to be included in this 

standard job are listed on the right side of the window. 

6.   Click the OK button on the List of Ships window to accept all selected ships, close the window and list 

the selected ship or ships on the Job Type Details tab. 
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7.   Click the Calendar button at the end of the Last Done column to select the date this survey or certificate 

was last acquired on this ship.  

8.   Click the Calendar button at the end of the Last Due column to select the date this survey or certificate 

is due for this ship.  

 

 

The fields on the Job Type Details tab for the Services, Condition Monitoring and Miscellaneous job types 

are similar to the ones for the Surveys/Certificates job type.  

 

Services Job Type 

Refer to the Surveys/Certificates Job Type process in this section, but this time, Service Index will be selected 

from the dropdown menu instead of Surveys/Certificates. 

 

Condition Monitoring Job Type 

Refer to the Surveys/Certificates Job Type process in this section, but this time, CM Type will be selected 

from the dropdown menu instead of Surveys/Certificates. 

 

Miscellaneous Job Type 

Refer to the Surveys/Certificates Job Type process in this section, but this time, Misc. Work Index will be 

selected from the dropdown menu instead of Surveys/Certificates. 

 

Structure Job Type 

Refer to the Machinery Job Type process in this section, but user will have to select Structures instead of 

Equipment / Maintained Part. 

 Job Description Tab 

The Job Description tab contains an index term and text data selected from the Job Description window to 

describe the standard job.  

 NOTE:     Job description text MUST be defined prior to linking to the Job Description tab 
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1.   Click the Link button from the Job Description tab toolbar. 

 The Job Description window opens. 

2.   Click to highlight the job description index term and text detail to be added to the Job Description tab. 

3.   Click the Select button from the Job Description window toolbar to close this window and add the 

index term and text data to the Job Description tab. 

This same procedure can be followed to open or change the index term and text data. 

 

  Admin Info Tab 

The Admin Info tab contains general information regarding the standard job. This includes the department 

responsible for the job, account the job is charged to and job list index. Fields are available regarding the 

Drydock feature but are NOT available if this feature is not a part of the company’s suite of NS modules. These 

fields are discussed in the NS Drydock manual. 
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The fields on the Admin Info tab are: 

 

Field  Description 

Account  There are two sections in the Account field. Either field can be filled first. The other 

field completes with referenced information from the Available Accounts window. 

Type the account number in the first section (shaded white) if it is known. The account 

name automatically fills the second section if this account has been created in the 

Available Accounts window.  

Click the dropdown menu at the end of the second section to open the Available 

Accounts window.  

Double click on the account that the job is charged to close the Available Accounts 

window and list the selection in the Account field. Once an account is associated with 

the job, this account number is the default number included in any requisition for this 

job.  

Department Click the dropdown menu at the end of the Department field for a list of departments. 

The Department List window opens. 

Double click on the department responsible for the job to close the Department List 

window and add the selection to the Department field.  

NOTE: 

1) When creating a new SJ based on machinery the department from the equipment 

copies to the SJ 

2) When creating SJ based on maintained part the system copies the department from 

the parent equipment 

3) When copying SJ to WO the department copies to WO 

4) When linking Equipment to WO the department copies to WO from equipment. 

Job Category Click the dropdown menu at the end of the Job Category field for a list of job 

categories. The Job Category List window opens. 

Double click on the category of the job to close the Job Category window and add 

the selection to the Job Category field.  

Class No. check 

box and field 

Click in the Class Number check box to indicate that this job is required by the 

classification society. The field next to the check box opens.  

Type the number assigned to this job by the classification society in the Class 

Number field. 

Coast Guard No. 

check box and field 

Click in the Coast Guard Number check box to indicate that this job is required by 

the coast guard. The field next to the check box opens.  

Type the number assigned to this job by the coast guard in the Coast Guard Number 

field. 
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Field  Description 

Priority Click on the dropdown menu in the Priority field to select the priority of the job. The 

options are A, B, C and D with “A” being the highest priority. The default selection 

is “D”.  

It is suggested that the value “A” be used to designate the jobs which are critical from 

a safety standpoint in connection with the ISM code requirements. “B” can be used 

to designate a job which is critical from an economic/quality standpoint, which is 

related to the goals of ISO. The “C” and “D” designations can be used for less critical 

jobs. 

Event Job Only Click the Event Job Only check box if this job is only associated with a maintenance 

event. Any job designated as an “Event Job Only” is ignored by the process functions 

in the Maintenance Plan.  This means that the functions for creating work orders, no 

action jobs and service requisitions, as well as those for completing work orders and 

rescheduling jobs, do not have any effect on jobs designated “Event Job Only”.  Event 

Job Only jobs are skipped by these functions. 

Job List Index 

Terms 

Click the Link icon on the Standard Job window toolbar to link job list index terms 

to the Job List Index Terms section.  
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Field  Description 

Drydock section The Drydock section contains fields associated with a Drydock.  

 

NOTE: Fields in the Drydock section are not available if the NS Drydock 

module is not part of the suite of NS products.  

• Click to check the Standard Drydock Item check box to designate this job 

as a standard Drydock job. All standard jobs with this check box checked are 

listed when the DDK Items radio button is selected on the Other Criteria 

tab of the Standard Job query window.  

• Click to check the Include in Shipyard RFQ check box to include this job 

in the shipyard request for quotation as a job to be done by the shipyard. 

• Click on the dropdown menu at the end of the ABC Indicator field to select 

the priority of this job within the maintenance event. 

The options are: 

A – Will do – this job will be done during the drydocking event 

B – Might do – this job might be done during the drydocking event 

C – Contingency – this job probably will not be done; however, a quote is 

requested in case the job becomes necessary. 

D – Additional – this job will be done if there is additional time / budget left on 

the Drydock 

• Click the dropdown menu at the end of the DDK Job Category field to 

select the Drydock job category. 

• Type a number in the Initial Sequence Number field to establish the default 

order of the job within the Drydock Job Category. There may be several 

jobs within the Drydock event with the same Drydock job category. The 

Initial Sequence Number indicates the order this job appears in the event 

job list.  This field is optional, and the sequence number can be changed. 

Add Job List Terms to Admin Info Tab 

Job list terms are used for reporting purposes, job queries and to classify standard jobs. The standard job list is 

more customized than the job category index terms. These terms can be those that may only have meaning 

within individual organizations. Authorized users can add new job list terms from the Standard Job List 

Selection window or from the General Data module 

1. Click the Link button from the Admin Info tab toolbar. The Standard Job List Selection window 

opens.  
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2.   Double click on a job list index term on the left side of the Standard Job List Selection window to 

move the term to the right side of the window. Continue selecting terms and moving them until all 

desired terminology are listed in the right section of the window.  

3.   Click the OK button on the Standard Job List Selection window to accept all selections, close the 

window and list the job terms on the Admin Info tab. 

 

 

Delete Job List Terms from the Admin Info Tab 

1.   Click to highlight a job list term on the Job List Index Terms section of the Admin Info tab.  

2.   Click the Unlink button from the Admin Info tab toolbar. The highlighted job list term is removed 

from the Admin Info tab. 
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 Questionnaire Tab 

The Questionnaire Document tab lists the sections and sub-sections of the questionnaire selected in the header 

of the Standard Job or Compliance Job document.  Questionnaires can also be versioned, and responses can 

be configured.  The Questionnaire Document tab is also a tab on Audits, Inspections, Meetings and Drills. 

The system will pick up the version based on the scheduled date and which version is active.  Once the 

questionnaire is copied it will not get updated again if the questionnaire has a newer version. However, the 

system allows questionnaire to be linked to existing standard job which do not have any assigned questionnaire 

yet. 

 

See your local system administrator for how to create answer template for questionnaires and how to import a 

questionnaire 

 Resources Required Tab 

The Resources Required tab is only available when the Standard Job is created. It becomes the Resources 

tab after the Standard Job is created. 

The Resources Required tab is for specifying who will perform the job – the crew or an outside contractor. 

Positions, skills, and estimated man hours are indicated if the job is to be done by a crew member. Estimated 

cost is the only requirement if the job is done by an outside contractor. Specifics about the outside contractor 

are included in the work order or service requisition on the Labor tab.   
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The fields on the Resources Required tab are: 

Field  Description 

Skills The Skills field can be completed whether the job is done by the crew or by an 

outside contractor. 

Click the dropdown menu at the end of the Skills field to select the skills 

necessary to perform this job. The Skill Selection window opens. 

Authorized users can add new skills from the Skill Selection window or the 

General Data module.  

Double click on the skill needed from the left side of the Skill Selection window 

to move it to the right side of the window. Continue moving selections to the right 

side of the window until all skills needed for this job are listed in the right section 

of the window. 

Click the OK button on the Skill Selection window to close the window, accept 

the selections made and list the skills in the Skill field on the Resources Required 

tab.  

Estimated Cost The Estimated Cost field is completed if the job is performed by an outside 

contractor. 

Click in the Estimated Cost field to type the approximate cost of the job in the 

default currency set in the General Data module. 

Generate Estimate 

button 

This button is NOT applicable for this tab. It becomes active after the job is 

created and the Resources Required tab becomes the Resources tab. Error! R

eference source not found. 

Usual Method of 

Execution 

Click the radio button to select who normally performs this job – the crew or an 

outside contractor. 

 

NOTE:  This option can be changed on the ship level if 

necessary. Only authorized users can make this change. 
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Field  Description 

List Positions   

Click the Ellipse/browse button  at the end of the table to list the positions 

on the crew necessary to perform this job.  

The List of Crew Position Titles window opens.  

Authorized users can add new crew position titles from the List of Crew Position 

Titles window or the General Data module.  

Double click on the position title needed from the left side of the List of Crew 

Position Titles window to move the selection to the right side of the window. 

Continue moving selections to the right side of the window until all position titles 

needed for this job are listed in the right section of the window. 

Click the OK button on the List of Crew Position Titles window to close the 

window, accept the selections made and list the positions in the table on the 

Resources Required tab. 

The Estimated Man-Hrs. column becomes active when the positions titles are 

listed on the table. Click in each column to list the estimated man hours this 

position title needs to perform the job. 

Total Estimated Man 

Hrs. 

NS automatically calculates the total estimated man hours needed to perform this 

job as the Estimated Man-Hrs. column is filled in the table. 

 Materials Required Tab 

The Materials Required tab becomes active when the information in the Job Type Details tab is completed. 

Select the materials needed to complete the job on the Materials Required tab. 

Add Job Materials to the Materials Required Tab 

1. Click the New button on the Standard Job – New toolbar. The Equipment Explorer window opens 

listing all the ships designated on the Job Type Details tab when the Equipment / Maintained Parts 

section was completed. 

  

2.   Navigate through the Equipment Explorer to find the parts or materials needed for the job.   

3.   Click in the Quantity column of the parts listed in the right section of the Equipment Explorer window 

to type the quantity of the part needed for this job. 
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NOTE:    Only parts with a non-zero value in the Quantity column are listed on the Materials   

               Required tab even though all check boxes selecting the parts are checked by default. 

 

4 Continue navigating through the Equipment Explorer window to select parts and materials needed for 

the standard job. 

NOTE:     NS keeps track of all selected parts even when the list of parts changes as users move through 

                 the hierarchy 

 

5. Click the Select button on the Equipment Explorer toolbar when all parts and materials are selected 

to close the Equipment Explorer window and list the parts on the Materials Required tab. 

 

   
 

Other Functions 

The other options listed on the menu bar and toolbar of the Materials Required tab are: 

Option Description 

Open 

 

Click the Open option / button to open the Standard Job Materials 

Requirements window for the highlighted part. Change the quantity of the 

part needed in this window. This action also changes the quantity required on 

all the appropriate windows such as the Materials Required tab and the 

Equipment Explorer.  

The Standard Job Materials Requirements window displays the information 

contained on the Parts window for the selected part. The only field that can be 

edited on this window is the quantity required. 

Part 

 

Click the Part option / button to open the Part window for the highlighted 

part. This window displays basically the same information that is displayed on 

the Standard Job Materials Requirements window except these fields are 

editable for authorized users. 
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Option Description 

Delete  

 

Click the Delete option / button to delete the highlighted part from the 

Materials Required tab.  

 File Attachments Tab 

Refer to Item 21.2 File Attachment Tab section of this manual 

 Sub-Items Tab 

The Sub-Items tab of the Standard Job window is available when the Standard Drydock Item check box is 

checked on the Admin Info tab. 

 

The Sub-Items tab explains how many of the part or equipment associated with the job are involved in the 

procedure. For example, the standard job for examining the pump and motor set. This is described in general 

on the Description tab of the standard job.   

The Sub-Items tab can have a listing to check the pump but specifies that there are 3 pumps that need to be 

checked.  

NOTE:    The item on the Sub-Item tab should be labeled the same as the sub-job it is linked to on the  

                 Description tab. For example, “Check pump for leaks…” sub-job on the Description tab in the   

                 figure above has a list number of “A” preceding it. The item on the Sub-Item tab associated with  

                 this sub-job is listed as “A”. 

 

1. Type a procedure associated with the equipment or part in the Title column.  

2. Type the quantity of the equipment or part associated with the procedure involved in the Quantity 

column. 

3.  Click on the dropdown menu in the Unit of Measure column to select the unit of measure used for the 

equipment or part. The dropdown menu in the Unit of Measure column is NOT visible until the field 

is clicked. 
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Delete an Item from the Sub-Items Tab 

1.   Highlight an item on the Sub-Items tab to be deleted. 

2. Click the Delete button on the Standard Job window. A message box opens verifying the delete 

process. 

 

3. Click the Yes button to close the message box and delete the item. 
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 CM Equipments Tab 

The CM Equipments tab is only available if the Condition Monitoring radio button is selected as the Job 

Type in the header of the Standard Job window. The CM Equipments tab lists equipment or spaces whose 

conditions are to be monitored for the selected condition monitoring type. The work order created from this 

standard job copies the equipment and spaces from the standard job by default. Additional equipment or spaces 

can be linked from the Equipment / Spaces tab on the work order as well.  

 

The Grouped Counter radio button can be used in the Maintenance Trigger section in the header of the 

Standard Job window for equipment listed on the CM Equipments tab. The Grouped Counter selection is 

used when multiple pieces of equipment are using a single counter on a single vessel. 

 

1. From the CM Equipments tab, right-click on the space provided and select Link / Unlink Equipment 

/ Maintained Part option.  

 

The Equipment Explorer window opens for the ships that were selected on the Job Type Details tab.  

NOTE:  Remember, only equipment that has been set up for condition monitoring can be selected on 

this tab 

2. Navigate through the Equipment Explorer window to locate the equipment or maintained parts to be 

monitored. 

3. Click the Select button on the Equipment Explorer toolbar to close the window and add the selections 

to the CM Equipments tab. 
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Using Grouped Counter Maintenance Trigger 

The CM Equipments window changes slightly when the Grouped Counter radio button is selected in the 

Maintenance Trigger section in the header of the Standard Job window. The Grouped Counter is used when 

multiple pieces of equipment are using a single counter. The selected counter determines when the standard job 

is scheduled on the Maintenance Plan. One standard job is created.  

4. Add equipment to the tab.  

5. Click the radio button in the Counter Preferred column to designate the counter to be used. The 

equipment listed first on the CM Equipments tab is selected by default as the counter preferred. 

However, this can be changed by clicking the radio button on another piece of equipment. Only one 

selection can be made. The Last Done, Last Due and Job Counter fields are only available for the 

counter preferred equipment. 

6. Click in the Last Done and Last Due columns to select the appropriate dates. The Calendar button 

becomes available when the column is clicked. 

7. Type the number of hours in the Job Counter field. This is the current reading on the counter preferred 

equipment. The job is scheduled when the running hours of the equipment are equal to the number of 

hours recorded in the Counter Interval.   

 

 DMS Link Tab 

Refer to Item 21.8 DMS Link Tab section of this manual. 

 Job Description Window 

Standard text that can be used for job descriptions throughout the NS Enterprise system are defined on the Job 

Description window. This text includes an index term to help find the text and text data that is commonly used. 

An index term can have several different pieces of text data. Text data can be instructions, notations or any 

other piece of information that can be shared regarding the job. 

The Job Description window has three sections: 

• List of job description index terms 

• Job Detail section 

• Text Data section 

 



  Nautical Systems Enterprise Maintenance User Manual 

©2020 American Bureau of Shipping and affiliated companies. All rights reserved. This document contains proprietary and confidential information for review and discussion 

purposes only. No part of this document may be used, disclosed, copied, or distributed, by any form or any means, without the express written consent of the American Bureau 

of Shipping.   

       PROPRIETARY AND STRICTLY CONFIDENTIAL. DISTRIBUTION TO THIRD PARTIES IS STRICTLY PROHIBITED.          P a g e  | 230 

The options on the Job Description window menu bar and toolbar are: 

 

Option Description 

File→ The File menu contains options to manipulate a file.  

Save Select the Save option / button to save any changes made on the Job 

Description window. 

Tools→ The Tools menu contains options that are useful to add text to the Job 

Description window. 

 New Index Term Click the New Index Term option / button to add a new job 

description index term to the Job Description Index Term section. 

Only authorized users can add new index terms. 

 

NOTE:  Index terms CANNOT be deleted. They can be 

hidden from view.  
 

 New Text Data Click the New Text Data option / button to add new text data to the 

index term selected. 

 

NOTE:  The first 100 characters in the Text Data field 

are used as the Text Detail.  

 

 Delete Text Data Click the Delete Text Data option / button to delete the text data of 

the text detail highlighted in the Text Detail section. 
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Option Description 

 Import New Text Click the Import New Text option / button to import information 

from another source into the Job Description window.   

 

NOTE:  Only data with a .txt extension can be 

imported. 

 

 Import (Replace) Click the Import (Replace) option / button to replace existing text 

data.  

 

NOTE:  Only data with a .txt extension can be 

imported. 

 

 Export Text Click the Export option / button to export the text data to another 

location as a text file.  

 Link / Unlink Indexes Click the Link / Unlink Indexes option to copy text data from one 

Job Description index term to another.  

 
Click the Select button to close the Job Description window and add 

the selected job description index term and text data to the Job 

Description tab. 

Help 

 

The option in the Help menu is Help. Select this option / button to 

open the online help. 

   

 Add Text Data 

1.  Select a job description index term from the Job Description Index Term section of the Job 

Description window. 

2.   Click the New Text Data button from the Job Description toolbar.  

 
NOTE:  The previous text data disappears when the New Text Data button or option is 

selected, but it is NOT overwritten. This becomes evident when the Save button is 

clicked. A second text data selection is added to the Text Detail section of the Job 

Description window. 

3.   Type any text describing the procedures for the job. The text data section holds approximately 200 lines. 

4.   Click the Save button to save the information. A new entry is made to the Text Detail section.  
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 Delete Text Data 

1.  Select a job description index term from the Job Description Index Term section of the Job 

Description window. 

2.   Select the text from the Text Detail section to be deleted. 

3.   Click the Delete Text Data button from the Job Description toolbar. A delete confirmation message 

box opens. 

 

4 Click the Yes button on the message box to delete the selected text. The text detail and text data for the 

selected text are deleted. 

 

 Import Text Data 

1.  Select a job description index term from the Job Description Index Term section of the Job 

Description window. 

2.   Click the New Text Data button from the Job Description toolbar. The cursor appears in the Text 

Data section. 
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3.   Click the Import New Text button from the Job Description toolbar. The Open window opens with 

files from the default directory.  

 

4.   Browse the directories for the appropriate text file. 

5.   Select the text file. 

6.   Click the Open button on the Open window. The selected text from the file is displayed in the Text 

Data section of the Job Description window. 

 

 

7 Click the Save button to save the imported data. A new entry is made to the Text Detail section. 
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Add Imported Data to Existing Text Data 

The imported text is added to any previous text contained in the text data section. 

 Export Text Data 

1.  Select a job description index term from the Job Description Index Term section of the Job 

Description window. 

2.   Click the Export Text button from the Job Description toolbar. The Save window opens with files 

from the default directory.  

 

3.   Browse the directories for the appropriate directory for the exported text data file. 

4.   Type the name of the text data file in the File Name field of the Save window. Be sure to give it a .txt 

extension. 

5.   Click the Save button. The selected text data from the Job Description window is copied as a text file 

to the selected directory. Click Yes to the Job Description message box. 
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 Copy Text Data 

1.  Select the job description index term from the Job Description Index Term section of the Job 

Description window whose text data is to be copied. 

2.   Select the Text Detail to be copied. 

3.   Highlight the text data in the Text Data section to be copied. 

4.   Right-click and select Copy from the options. 

 

5.  Navigate through the Job Description Index Term section to find the index term and Text Detail 

where the text data is to be copied. 

6. Click in the Text Data section. 

7. Right-click and select Paste from the options. 

 

8 Click the Save button to save the copied data. A new entry is made to the Text Detail section. 
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 Standard Job Query 

All PM standard jobs for a ship can be located from the ship view of the Maintenance and Purchasing module. 

A ship can only view its own standard jobs. It CANNOT view the standard jobs for other ships. 

1.   Select Documents → Search → Standard Job from the Maintenance gadget on the Navigator pane 

in the Maintenance and Purchasing module. The Standard Job Query window opens. 

2.  Click to select the parameters of the standard job to be located on the Search tab. The Search tab 

contains a number of options and sections for search criteria. 

3.    Click the Search button at the bottom of the Search tab of the Standard Job Query window to conduct 

a search for the standard jobs meeting the criteria of the options selected. The jobs meeting these criteria 

are listed on the right side of the Standard Job Query window when the search is completed. 

4.    Double click on a standard job listed from the search results to open the Standard Job window for that 

job. 

 

The options / buttons on the Standard Job Query window menu bar and toolbar are: 

Options Description 

Standard Job→ The Standard Job menu contains options on manipulating the selected 

standard job.  

 Open Select the Open option / button to open the highlighted standard job. 

 

NOTE:  Multiple tagged items cannot be opened. Only the 

HIGHLIGHTED document can be opened.  

 

 Delete Click the Delete option / button to delete the standard job highlighted in the 

search results. A confirmation message box opens for verification that the 

job is to be deleted. 

 

NOTE: Standard jobs can only be deleted before they are 

replicated. After replication they CANNOT be deleted. 

 

 Close Select the Close option to close the Standard Job Query window. 

Tag → The ability to tag and make multiple standard jobs active or dormant. The 

Tag menu option works with the Process menu option.  

Click the check box preceding the standard jobs to select the jobs to be made 

dormant or active.  

 Tag All Select the Tag All option to tag all standard jobs.  
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Options Description 

 Untag All Select the Untag All option to untag all selected standard jobs.  

Process →  The ability to make multiple jobs active or dormant. The Process menu 

option works with the Tag menu option.  

Make Selected Active Select the Make Selected Active option to make all selected jobs active. 

Make Selected Dormant Select the Make Selected Dormant option to make all selected jobs 

dormant.  

Edit JSA 

Requirement 
 

 

NOTE:  JSA or job safety analysis is a feature included with the 

HSQE module.  A company MUST have the HSQE module in 

its suite of NS products to use the JSA functionality in the 

Maintenance module. Contact the ABS Nautical Systems 

account manager for details.   

Click the check box preceding the standard jobs whose Job Safety Analysis 

requirement is to be changed. 

Select the Edit JSA Requirement option. The Edit JSA Requirement 

window opens.  

Click the JSA Required check box to indicate that a job safety analysis is 

required for this job. Click the dropdown menu at the end of the Template 

field to select a template. The Template search window opens. The Ship 

and Template fields are filled by default, so the Template search window 

opens with the templates meeting the parameters preselected on the right 

side of the window.  

Click to select a template. Click the Select button on the Template search 

window to close the window and add the selection to the Edit JSA 

Requirement window.  

Click the OK button to close the Edit JSA Requirement window and add 

the information to the selected standard jobs.   

Reports→ The Reports menu contains general information reports pertaining to all 

standard jobs. 

Reports are created from the results of a query. Standard jobs MUST be 

listed on the right pane of the Standard Job Query window (search results) 

to run a report. 

Any report selected opens the Report Options window. Click the radio 

button to select where this report should be sent.  

Advanced 

Search  
Click the Advanced Search button to open or close the Bookmark and 

Search tabs of the Standard Job Query window. 
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Options Description 

Help     The option in the Help menu is Help. Select this option to open the online 

help. 

  

There are five tabs to select specific criteria for the standard job query. Click the arrow on the right side of the 

section tab to expand the tab.  

 General Section 

 

The fields in the General section of the Standard Job Query window are: 

Field Description 

Ship Click on the dropdown menu at the end of the Ship field to select which vessels' 

standard jobs are to be included in the query if the window is accessed at the fleet 

level.  The name of the vessel is entered by default if the window is accessed at the 

ship level. 

Job Type  Click on the dropdown menu at the end of the Job Type field to select which job type 

standard jobs are to be included in the query. 

Click the check box preceding all job types to be included in the query.    

Click the OK button to close and add the selections to the Job Type field. 

 Job Criteria Section 

The fields on the Job Criteria section of the Standard Job Query window are: 
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Field Description 

Equipment  Click the dropdown menu at the end of the Equipment field to display a list 

of the ships (when at fleet level), equipment name and equipment code that 

have standard jobs associated with selected equipment. This includes any 

standard job for work to be done on equipment or maintained parts.  

Click the check box preceding the equipment to select. Continue selecting 

equipment until all equipment whose standard jobs are to be included in the 

search are selected. The check box MUST be checked to select – 

highlighting a part or equipment does NOT select it.   

Click the OK button to close the menu and add the selections to the 

Equipment field. 

CBM Equipment Click the dropdown menu at the end of the CBM Equipment field to locate 

standard jobs associated with condition monitoring equipment. The options 

listed are only those that have been designated as condition monitored.  

Click the check box preceding the equipment to select. Continue selecting 

equipment until all equipment to be included have been selected.   

Click the OK button to close the menu and add the selections to the CBM 

Equipment field. 

Maintained Part  Click the dropdown menu at the end of the Maintained Part field to locate 

standard jobs associated with maintained parts.  

Click the check box preceding the maintained parts to select.  Continue 

selecting parts until all parts to be included have been selected.   

Click the OK button to close the menu and add the selections to the 

Maintained Part field. 

Space Click the dropdown menu at the end of the Space field to locate standard 

jobs associated with spaces.  

Click the check box preceding the space to select. Continue selecting spaces 

until all spaces whose standard jobs are to be included in the search are 

selected.   

Click the OK button to close the menu and add the selections to the Space 

field. 

Surveys Click the dropdown menu at the end of the Surveys field to locate standard 

jobs associated with surveys.  

Click the check box preceding the survey to select.  Continue selecting 

surveys until all surveys whose standard jobs are to be included in the search 

are selected.   

Click the OK button to close the menu and add the selections to the Surveys 

field. 
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Field Description 

Service Click the dropdown menu at the end of the Services field to locate standard 

jobs associated with services.  

Click the check box preceding the service to select.  Continue selecting 

services until all services whose standard jobs are to be included in the 

search are selected. 

Click the OK button to close the menu and add the selections to the Services 

field.  

Miscellaneous Work  Click the dropdown menu at the end of the Miscellaneous Work field to 

locate standard jobs associated with miscellaneous work.  

Click the check box preceding the jobs to select.  Continue selecting jobs 

until all jobs whose standard jobs are to be included in the search are 

selected.   

Click the OK button to close the menu and add the selections to the 

Miscellaneous Work field. 

Condition Monitoring 

(CM) Type 

Click the dropdown menu at the end of the Condition Monitoring Type 

field to locate standard jobs associated with types of condition monitoring.  

Click the check box preceding the monitoring types to select.  Continue 

selecting monitoring types until all that are to be included in the search are 

selected.   

Click the OK button to close the menu and add the selections to the 

Condition Monitoring Type field. 

Structure  Click the dropdown menu at the end of the Structure field to locate standard 

jobs associated with structures.  

Click the check box preceding the structures to select.  Continue selecting 

structures until all that are to be included in the search are selected. 

  

Click the OK button to close the menu and add the selections to the 

Structure field. 

 

NOTE: 

 For Standard Job of type Surveys/Certificates, Services, Miscellaneous Work and Condition 

Monitoring, the title field is editable, depending on the “Edit Standard Job” authorization set. 

 Indexes Section 
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The fields on the Indexes tab of the Standard Job Query window are: 

Field Description 

Job Size 

Index 

Click the dropdown menu at the end of the Job Size Index field to select the job size index 

terms of the standard job.  

Click the check box preceding the job size to select. Continue selecting indexes until all job 

sizes whose standard jobs are to be included in the search are selected. 

Click the OK button to close the menu and add the selections to the Job Size Index field. 

Department Click the dropdown menu at the end of the Department field to select the department 

responsible for the standard job.  

Click the check box preceding the department to select. Continue selecting until all 

departments whose standard jobs are to be included in the search are selected.   

Click the OK button to close the menu and add the selections to the Department field.  

Job Category Click the dropdown menu at the end of the Job Category field to select the job category of 

the standard job.  

Click the check box preceding the job category to select. Continue selecting until all job 

categories whose standard jobs are to be included in the search are selected.  

Click the OK button to close the menu and add the selections to the Job Category field.   

Job List  Click the dropdown menu at the end of the Job List field to select the job list index terms of 

the standard job.  

Click the check box preceding the job list index terms to select. Continue making selections 

until all job list index terms whose standard jobs are to be included in the search are selected. 

Click the OK button to close the menu and add the selections to the Job List field. 

Job 

Description  

Click the dropdown menu at the end of the Job Description field to select the job description 

index term of the standard job.  

Click the check box preceding the description to select. Continue selecting until all 

descriptions whose standard jobs are to be included in the search are selected. 

Click the OK button to close the menu and add the selections to the Job Description Index 

field. 
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 Miscellaneous Section 

 

 

The fields on the Miscellaneous tab of the Standard Job Query window are: 

Field Description 

Equipment Code Type the equipment code for the equipment 

Equipment Name Type the name of the equipment 

Class Number Type the classification number of the vessel in the Class Number field to 

search for jobs required by a classification society. 

Coast Guard Number Type the coast guard number of the vessel in the Coast Guard Number field 

to search for jobs required by the coast guard. 

Type Click on the dropdown menu on the Type field to select whether the standard 

job is calendar based or counter based.  

Click the appropriate check box.  

Click the OK button to close and add the selection to the Type field.  
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Field Description 

Class Click on the dropdown menu on the Class field to select whether the standard 

job is: 

• Class job - classification required standard job 

• Non-class job - not a classification required job 

Click the appropriate check box. 

Click the OK button to close the and add the selection to the Class field.  

 

NOTE:  Class jobs are indicated if a classification 

number is given on the Admin Info tab of the 

Standard Job window. 

 

Status Click on the dropdown menu on the Status field to select whether the status of 

the standard job is: 

• Active 

• Dormant 

Click the appropriate check box. 

Click the OK button to close the and add the selection to the Class field. 

NOTE: Users cannot mark a standard job as dormant if there is a 

scheduled work order associated with it. A validation message will be 

displayed to the user if he tries to mark the Standard Job as dormant having at 

least one active Work Order. User must cancel or complete the linked PM work 

order. 

NOTE:  A dormant standard job can only be viewed from standard 

job query.  NS Enterprise restricts the linking of Dormant standard jobs in the 

following areas: 

1. Table Templates 

2. Events 

3. Dry dock 

4.  Work Orders  

5. Standard Job as defined predecessor job 
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Field Description 

Min. Priority Click the arrow on the Min. Priority field to select the minimum level of 

priority of the standard job. All jobs with a priority higher than the one selected 

are also displayed in the search results. The options are: 

• A – highest priority 

• B 

• C 

• D – lowest priority and default 

Click the selection to close option box and add the selection to the Priority 

field. Only one selection can be made.   

Equipment Criticality Click on the dropdown menu on the Equipment Criticality field to select the 

minimum level of criticality for the standard job. All jobs with a level of 

criticality higher than the one selected for this field are included in the search 

results. The options are: 

• A – ISM compliant 

• A+B – ISO compliant 

Click the appropriate check box. 

Click the OK button to close the and add the selection to the Criticality field. 

“Due” Cutoff Date Click on the dropdown menu on the “Due” Cutoff Date field to select the 

cutoff date for the standard job.   

Click the Calendar button at the end of the “Due” Cutoff Date field to select 

the date a standard job is due.  

Click the OK button to close the window and add the selection to the “Due” 

Cutoff Date field.  

JSA  Click on the dropdown menu at the end of the JSA field to select the JSA 

template used for the standard job.  

Click the check box preceding the template to select. Continue selecting until 

all templates whose standard jobs are to be included in the search are selected.

  

Click the OK button to close the menu and add the selections to the JSA field. 

Serialized Item 

Reference 

Click on the dropdown menu at the end of the Serialized Item Reference field 

to identify if it is a serialized piece of equipment or a serialized part. 

Serialized Parts Click the check box to include Standard Jobs for Serialized Parts. 



  Nautical Systems Enterprise Maintenance User Manual 

©2020 American Bureau of Shipping and affiliated companies. All rights reserved. This document contains proprietary and confidential information for review and discussion 

purposes only. No part of this document may be used, disclosed, copied, or distributed, by any form or any means, without the express written consent of the American Bureau 

of Shipping.   

       PROPRIETARY AND STRICTLY CONFIDENTIAL. DISTRIBUTION TO THIRD PARTIES IS STRICTLY PROHIBITED.          P a g e  | 245 

Field Description 

Custom Forms Click on the dropdown menu at the end of the Custom Forms field to select 

the Custom Form templates used for the standard job. 

Click the check box preceding the template to select. Continue selecting until 

all templates whose standard jobs are to be included in the search are selected. 

Click the OK button to close the menu and add the selections to the Custom 

Forms field. 

 Drydock Section 

 

All the fields in the Drydock section are only available if the Drydock module is part of the NS suite of 

products. 

 Standard Job Window – Ship View 

The ship view of the Standard Job window is slightly different than the Standard Job window on the fleet 

view. The basic information is the same because it applies across the fleet, but there are some fields and tabs 

that contain information that is specific to each ship. 

Options Description 

File→ The File menu contains options to manipulate a file. 

 Copy Standard Job Select the Copy Standard Job option / button to create a new 

standard job. The Standard Job – New window opens with all 

the parameters of the original standard job. All these parameters 

can be changed.  

 

NOTE:  Only authorized users can create a new 

standard job. The standard job created in this 

procedure only applies to this ship. 
 

 Save Select the Save option / button to save any changes made on the 

Standard Job window. 

             Relog  
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Options Description 

Job Description The Job Description menu contains options pertaining to the 

Job Description tab. 

 Link Select the Link option / button to link a job description to the 

job.  

 Open Select the Open option / button to open the Job Description 

window. 

Authorized users can add new job descriptions or change 

information about a job description on this window.  

Reports The Reports menu contains options to generate different types 

of reports.  

Any report selected opens the Report Options window. Click 

the radio button to select where this report should be sent. 

             Print Standard Job Select the Print Standard Job option to print all the information 

contained in the fields and tabs for the standard job in report 

form. 

             Standard Job Description Select the Standard Job Description option to print just the 

basic information about the job and the job description. 

 Job Schedule Select the Job Schedule option to print the basic information 

about the job and the scheduling information. 

Help The option in the Help menu is Help. Select this option to open 

the online help. 

 

The fields on the Standard Job window – Ship view are completed from information provided when the job 

was created. This information was on the header portion of the Standard Job – New window as well as the 

Job Type Details tab.  Authorized users can change much of the information in these fields or tabs.  

The job type, name of the ship, system and equipment are displayed at the top of the Standard Job window. 

These fields are NOT editable.  

 Job Description Tab 

The Job Description tab on the Standard Job window has the information from the Job Description tab when 

the standard job was created. This information can be changed by authorized users. 
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A Vessel Specific Description section has been added to the Job Description tab on existing standard jobs. 

This section is a free form text area to be used to add specific standard job addendums, comments, and notes by 

authorized users.  

 

1. Type information in the Vessel Specific Description section of the Job Description tab. 

2. Click the Save button. A Remarks window opens.  

 

3 Add remarks regarding these instructions.  

 

4. Click the OK button to close the Remarks window.  The remarks are recorded on the Change Log tab. 

Text from this section is added to the Description tab of the work order and the Standard Job Report. 

 Resources Tab 

Refer to Item 21.4 Resources Tab section of this manual. 
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 Admin Info Tab 

The Admin Info tab on the Standard Job window has the information from the Admin Info tab when the 

standard job was created. This information can be changed by authorized users. 

The Standard Job Code field is added to the Admin Info tab on the Standard Job window on the ship view. 

The Standard Job Code field is a 20 alpha numeric character that is unique to the vessel. The same code 

CANNOT be used more than once for the same vessel; however, the same code can be used on a different 

vessel. The Standard Job Code is the main field used to gather data for the Key Standard Job Data export.   

Refer to Item 14.1.3 Admin Info Tab section of this manual, for a detailed explanation of each field and of 

the processes.   

 Questionnaire Tab 

Refer to Item 14.1.4 Questionnaire Tab section of this manual. 

 Materials Required Tab 

Refer to Item 14.1.6 Materials Required Tab section of this manual, for a detailed explanation of each field 

and of the processes. 

 Change Log Tab 

The Change Log tab records any changes made to the standard job. A Remarks window opens when the Save 

button is clicked on an existing standard job when any changes have been made. The type of action, user and 

date of the change are system generated on the Change Log tab. An icon is added at the end of the row that 

contains any remarks that were entered by the user that were specific for the row.  Click on the icon to open the 

Remarks window. 

 

 Counter History Tab 

The Counter History tab is only available if the standard job is counter based. It displays history counter 

readings that have been recorded and keeps count of the number of running hours between maintenance jobs. 

An entry is made on the tab whenever the running hours on the piece of equipment is updated.  The number of 

running hours displayed in the Job Counter field on the Standard Job window is taken from this tab.  
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NOTE:   The counter is automatically adjusted to zero whenever a work order or service 

purchase order is completed.  

 

Sometimes the running hours listed on the Counter History tab are not correct. These hours can be adjusted 

by following these steps: 

1.   Click the Counter History tab. 

2.   Click the Adjust Counter button on the toolbar.  

 

• The Standard Job Counter Adjustment window opens. 

3 Click in the Adjusted Counter Value field to type the number of running hours needed for the 

adjustment.   

4.   Click the Calendar button at the end of the As Of field to set the date the running hours were adjusted. 

5.   Click the OK button on the Standard Job Counter Adjustment window to close the window and add 

the information to the Counter History tab. 

 

The new line added to the Counter History tab reflects the date the reading was entered, the counter value 

entered on the Standard Job Counter Adjustment window is shown in the New Counter Value column and 

the number of hours added for this adjustment is in the Hours Added column. 

 
NOTE:   The adjusted counter value is NOT reflected on the Job Counter field of the 

Standard Job window until the changes have been saved. However, the Standard 

Job window closes when the job is saved and needs to be reopened from the 

Standard Job Query window. 

 Miscellaneous Equipment Tab 

The Miscellaneous Equipment tab is only available for miscellaneous work standard jobs. Equipment 

associated with the miscellaneous work standard job is specified on this tab.  
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Link Equipment or Parts 

1. Click the Miscellaneous Equipment tab. 

2. Click the Link Equipment button from the Standard Job window toolbar.  

 

• The Equipment Explorer window opens. 

3. Drill down to the equipment/maintained part and tick the check boxes preceding the equipment or 

maintained part to select. More than one piece of equipment or maintained part can be selected at one 

time. 

• Click the check box again to unselect any equipment or part. 

4 Click the Select button on the Equipment Explorer window to close the Equipment Explorer window 

and add the items to the Miscellaneous Equipment tab. 

 

5 Click the Save button on the Standard Job toolbar to save the information. 

 

 

Link/Unlink Space 

1. Click the Miscellaneous Equipment tab. 

2. Click the Link/Unlink Space button from the Standard Job window toolbar. 
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The List of Spaces window opens with all the defined spaces. 

3. Double click a space from the left side of the List of Spaces window to move the space to the right side 

of the window. Continue selecting spaces and moving them until all spaces needed for this 

miscellaneous work standard job are listed on the right side of the window.  

4. Click the OK button to accept all selected spaces, close the List of Spaces window and list the space 

on the Miscellaneous Equipment tab of the Standard Job window. 

 

• Click the double right arrow to move all spaces from the left side of the window to the right side of 

the window. 

• Double click on a space from the right side of the window to move the space back to the left side 

of the window to unselect it. 

 

Search for a Space 

Some ships have an extensive list of spaces. The List of Spaces window contains a search field to help locate 

a space. 

1. Click on the dropdown menu at the end of the By field on the List of Spaces window to select the 

category to search by.  

 
NOTE:  The scroll bar at the bottom of column can be moved to reveal more columns. 
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2. Type the beginning letters or numbers of the category of the space to be located in the Search field. 

The cursor moves with every character typed to the space meeting the search criteria according to the 

letters or numbers typed.  

3. Double click on that space to move it from the left side of the List of Spaces window to the right side 

of the window.  

4. Click the OK button to accept all selected spaces, close the List of Spaces window and list the space 

on the Miscellaneous Equipment tab of the Standard Job window. 

 

 

Open Equipment or Space Window 

1. Go to the Miscellaneous Equipment tab and click to highlight equipment or space on the 

Miscellaneous Equipment tab.  

2. Click the Open button from the Standard Job window toolbar. 
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Unlink Selected Space or Equipment 

1. Go to the Miscellaneous Equipment tab and click to highlight equipment or space on the 

Miscellaneous Equipment tab.  

2. Click the Unlink button from the Standard Job window toolbar.  

 

 Tables Tab 

Any tables that have been created are listed on the Tables tab. These tables can contain any type of information 

that might be useful pertaining to the standard job. This information can include engine readings, types of 

measurements, temperature, and pressure.  
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Tables are created at the fleet level and the properties of that table can be viewed at the ship level on this tab.  

 

NOTE:  Tables are only listed on this tab if the standard job has been linked to the table.   

Select Tools → Table Entries from the Maintenance gadget on the Navigator pane of the Maintenance 

module window at the Ship level. 
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 Related Jobs Tab 

 

Jobs that are similar to this job can be listed on the Related Jobs tab. There are three sub-tabs at the bottom of 

this tab which have different parameters that define the jobs that are similar to this job.  

NOTE:    Job Description from Predecessor Jobs in PM Work Orders are system preference based.  If user 

                 set the system preference to “Yes’, then like defined predecessor job descriptions from inherent  

                 predecessor jobs will be copied to work orders. The default option is set to "No". 

 

The three sub-tabs at the bottom of the Related Jobs tab are: 

• Defined Predecessors 

• Comparable Jobs 

• Jobs with Same Job Description 

Defined Predecessors Sub-Tab 

The Defined Predecessors sub-tab displays all the jobs to be completed prior to the start of this job.  

1. Click the Link button from the Standard Job window toolbar. The Standard Job Query window 

opens with all the standard jobs. 
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2. Select the parameters on the Search tab to find the predecessor jobs that are to be done prior to this 

standard job. 

3. Click the Search button at the bottom of the Search tab to generate the search. The jobs meeting the 

parameters are listed on the right side of the Standard Job Query window. 

4. Click the check box to select the standard job that needs to be completed prior to starting this job. More 

than one selection can be made at a time. 

5. Click the Select button on the Standard Job Query window. The Standard Job Query window 

closes, and the selected job(s) is listed on the Related Jobs tab → Defined Predecessors sub-tab. 
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Open a Predecessor Job 

1. Click to highlight a job on the Related Jobs tab → Defined Predecessors sub-tab. 

2. Click the Open button from the Standard Job window toolbar. A message box opens warning that any 

changes made to this Standard Job window can have consequences for any jobs linked to it. 

 

3 Click the Yes option to open the predecessor standard job. A Remarks window opens. Type the reason 

that the predecessor job is being added in the Remarks window. Click the OK button to close the 

Remarks window and open the Standard Job window.  

             

These remarks are listed on the Change Log tab of the original standard job.  

 

 

Unlink a Predecessor Job 

1. Click to highlight a job on the Related Jobs tab → Defined Predecessors tab. 

 

2. Select Predecessors→ Unlink from the Standard Job window menu bar. A Remarks window opens. 

Type the reason why the predecessor job is being removed in the Remarks window. Click the OK 

button to close the Remarks window and remove the job from the Related Jobs tab → Defined 

Predecessors sub-tab. 
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Comparable Jobs Sub-Tab 

Comparable jobs are those that are essentially the same and whose costs are about the same. For example, a 

pump overhaul in one location and pump overhauls on identical pumps in other locations would be comparable 

jobs. This is useful when planning a job because a review of the price history of all comparable jobs can give a 

good estimate of what the job might cost. These jobs can be on the same ship or on other ships within the fleet. 

The definition of a comparable job depends on the type of standard job: 

• Equipment or maintained parts based standard jobs are comparable if their equipment or parts are cross 

referenced or the same AND the job size index term is the same 

• Survey or service based standard jobs are comparable if the ships are the same ship class and the jobs 

have the same survey index term or service index term 

• Space based standard jobs are comparable if the ships are of the same ship class, the spaces have the 

same name AND the job size index term is the same 

• Miscellaneous work based standard jobs are not comparable. 

All standard jobs that meet any of the above criteria are listed on this tab.   

Double click on a standard job listed on the Comparable Jobs sub-tab to view that job.  

 

Copy Particulars to Comparable Jobs 

The Copy Particulars to Comparable Jobs function should only be used in the initial setup of the standard 

jobs to prevent typing the same information to several jobs. 
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This function copies the following information from the original job on the Standard Jobs window to all the 

jobs listed on the Comparable Jobs tab.  

• Interval     

• Grace 

• Priority 

• Est. Man-hours 

• "Inherent Predecessors" checkbox 

• Job Description text 

• Account 

• Job Category 

• Skills 

• Position Titles (Grades) 

• Department 

 

NOTE:  BE CAREFUL!  ALL of the information listed above is overwritten on ALL the 

standard jobs listed on the Comparable Jobs tab with the information on the 

original standard job. 

 

Click the Copy Particulars to Comparable Jobs button on Standard Jobs toolbar. 
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NOTE:  BE CAREFUL! No confirmation or warning is given. The procedure begins as 

soon as the Copy Particulars to Comparable Jobs button is pressed. 

Jobs with Same Job Description Tab 

The Jobs with Same Job Description tab contains all jobs that have the same text in the Job Description tab. 

This list of jobs is normally the same as the Comparable Jobs tab list. It can also include other jobs if the job 

description is generic. For example, several different types of pumps which are physically different can have 

the same general description. The description might be "open pump, check and replace worn ball bearings, etc."  

This description is general enough to apply to many different types of pumps even though the jobs might not 

be comparable by our definition. 

 

 Work Orders Tab 

All work orders associated with this standard job are listed on the Work Orders tab. Work orders are added to 

this tab automatically when the PM Job button is clicked on the work order to associate the standard job to the 

work order.  
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New work orders for this standard job can also be created from this tab.  

 

Open a Work Order 

All work orders associated with the standard job are listed. Any of these work orders can be viewed and 

information on work orders that are still active can be edited. Information on cancelled or closed work orders 

CANNOT be changed.  

Double click on a work order on the Work Orders tab to open the work order. 

 

Create a New Work Order 

New work orders can be created for the standard job from the Work Orders tab. Information from the standard 

job is automatically inserted into the work order. Most of this information can be edited.  

The information copied from the standard job to the work order includes: 

• Ship name  

• Title of work order  

• Equipment 

• Counter – if this is a counter-based job. This number is copied from the counter value of the last 

work order completed for this standard job.  

• Due Date – if this is a calendar-based job. This date is calculated using the Calendar Interval 

information from the Standard Job window and the date it was last performed according to the 

last work order completed. 
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NOTE:    Due Dates on new created Work Order (without a link to standard job) enables a user to 

                 provide a due date for non-PM work orders and track their overdue status vs. the due  

                 date in the maintenance plan. 

 

• Description – the text on the Job Description tab of the standard job is copied to the Description 

tab of the work order. 

• Admin Info – the information on the Admin Info tab of the Standard Job window is copied to the 

Admin Info tab of the work order.  

• Materials - the information on the Materials Required tab of the Standard Job window is copied 

to the Materials tab of the work order.  

• Labor - the information on the Resources tab of the Standard Job window is copied to the Labor 

tab of the work order.  

 

Click the New button on the Standard Jobs toolbar. The Work Order – New window opens.  

 

 Certificates Tab 

The Certificates tab is only available for Surveys/Certificates type of standard jobs. All certificates related to 

the standard job are viewable from this tab. 

 Sources Tab 

The Sources tab lists the vendors who performed this job in the past and all related cost information.  

 Messages Tab 

Refer to Item 21.5 Messages Tab section of this manual. 

 File Attachments Tab 

Refer to Item 21.2 File Attachment Tab section of this manual. 
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 Sub -Items Tab 

The Sub-Items tab of the Standard Job window is available when the Standard Drydock Item check box is 

checked on the Admin Info tab. 

Refer to Item 14.1.8 Sub-Items Tab section of this manual, for a detailed explanation of each field and of 

the processes. 

 CM Equipments Tab  

Refer to Item 14.1.9 CM Equipments Tab section of this manual, for a detailed explanation of each field and 

of the processes. 

 DMS Link Tab 

Refer to Item 21.8 DMS Link Tab section of this manual. 

 Table Templates 

Maintenance of ships involves several items of information that must be entered and stored for reference. These 

are generally stored in a table format. NS Enterprise allows the user to create customized tables. Several 

different types of tables can be created as templates and used repeatedly without recreating a new table every 

time. Column lengths and widths can be set along with column headings and a range of values through the 

template. Equipment and spaces can be selected through the template to be included on the table. Access to 

certain templates can be given by ship and by work orders through the standard job.  

Table templates are created at the Fleet Level from the Maintenance and Purchasing modules.  

NOTE:   Export the information on a table for selected ships for a specified date range to an Excel     

                spreadsheet. 

 

Entries are made to these tables on the ship level. This is done either from the Maintenance and Purchasing 

modules or from a work order.  

 Create a Table Template 

Templates for tables are created from the Fleet level. 

 
NOTE:   A table can only be deleted if it has NOT been used. It CANNOT be deleted 

once it has been used. 

1.   Select Tools → Table Template Setup from the Maintenance gadget on the Navigator pane in the 

Maintenance module. The Table Template Setup window opens. The right section of the window 

displays the setup for the template highlighted on the left section of the window if previously created 

tables are listed on the Table Template Setup window.  
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2 Click the New button on the Table Template Setup window toolbar. The information on the right side 

of the table template window is removed and no tables are highlighted on the left side of the window. 

 

 

 

 

3.   Type the name of the table in the Name field on the Table Definition tab of the Table Template Setup 

window. This is a REQUIRED field. 

4.   Type a description of the table in the Description field.   

5.   Click the dropdown menu at the end of the Diagram field to attach a diagram or any other visual aid to 

the table. Proceed to step 6 if no diagram is to be attached. 

 

a.   The Select a File window opens to the NS Enterprise directory. Find the file to be attached. The 

only file types that are displayed on this window are graphic files.  



  Nautical Systems Enterprise Maintenance User Manual 

©2020 American Bureau of Shipping and affiliated companies. All rights reserved. This document contains proprietary and confidential information for review and discussion 

purposes only. No part of this document may be used, disclosed, copied, or distributed, by any form or any means, without the express written consent of the American Bureau 

of Shipping.   

       PROPRIETARY AND STRICTLY CONFIDENTIAL. DISTRIBUTION TO THIRD PARTIES IS STRICTLY PROHIBITED.          P a g e  | 265 

 
NOTE:  Make a copy of the attachment into the NS Enterprise directory on the 

server. This ensures that the attachment is available to anyone accessing 

the table. The file is not available to the office or other workstations if the 

file is on the local hard drive.  

 

b.   Click to highlight the file to be attached. The file name is displayed in the File Name field on the 

Select a File window.  

c.   Click the Link button on the Select a File window to close this window and insert the file name in 

the Diagram field of the Table Template Setup window. 

 

6.   Click the Print on Work Order check box to print the graphic listed in the Diagram field with the 

work order using this table.  

7.   Click the dropdown menu at the end of the Index field to add a table index term. The Table Index List 

window opens. Index terms are used to build a list of keywords for classifying user defined tables. For 

example, these terms might include Logbooks or Tank Soundings.  

 

 Authorized users can create new index terms from this window. 

a.   Click to highlight an index term on the Table Index List window. 

b.   Click the Select button to close the Table Index List window and add the term to the Index field 

on the Table Template Setup window. 
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8 Click the Applies to non-PM Jobs check box to include this table on the Readings tab of all non-

preventive maintenance work orders. 

 

9. The next steps will be to Link Ship(s), Equipment/Spaces/Structures or Standard Job(s).  Before linking 

a message will display asking to save the template.  Click Yes to close the message and proceed to 

linking appropriate records to the template. 

 
 

Link Ships to a Table Template 

The Linked Ship(s) sub-tab at the bottom of the Table Definitions tab is used to link ships to the table. Linking 

a ship makes this table available to that ship for use. For example, the table that is created is for fuel oil 

consumption. A ship that is linked to this table can use it when a work order is created to record readings for 

fuel oil consumption.  

 

1. Click the Linked Ship sub-tab on the Table Definition tab if it is not already active. 

2. Select Ships → Link from the Table Template Setup window menu bar. The List of Ships window 

opens.  
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3. Double click on a ship on the left side of the List of Ships window to move it to the right side of the 

window. Continue making selections until all that are to be included on the report are listed on the right 

side of the window. 

4. Click the OK button to close the List of Ships window and list the selections on the Linked Ships sub-

tab. 

 
 

Remove a Ship from the Linked Ship sub-tab 

1.   Click to highlight the ship to be removed from the Linked Ship sub-tab.  

2.   Click Ships → Unlink from the Table Template Setup window menu bar. A confirmation message 

box opens.  

 

3. Click the Yes button to delete the selected ship from the Linked Ship sub-tab.  

 

   NOTE:     Only one ship at a time can be selected to be removed from the Linked Ship sub-tab. 

4. Repeat steps until all ships that no longer use this table are removed from the Linked Ship sub-tab.  
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Link Equipment / Spaces / Structures to a Table Template 

The Linked Equipment / Spaces / Structures sub-tab at the bottom of the Table Definitions tab is used to 

add equipment, spaces and / or structures to the table. This is a little different from linking ships or standard 

jobs to the table. The name of the equipment, space and / or structure is listed as a row on the table of the Table 

Entries window. For example, a table is created that takes readings from different pieces of equipment. This 

equipment can be linked on the Linked Equipment / Spaces / Structures tab so that they automatically appear 

on the table without having to type them in every time readings are taken. 

 

Link Equipment or Maintained Part 

1.  Click the Linked Equipment / Spaces / Structures sub-tab on the Table Definition tab. 

2.   Select References → Link Equipment / Maintained Part from the Table Template Setup window 

menu bar.  

 

The Equipment Explorer window opens. 

 
NOTE:   Maintained parts listed under equipment can also be added to the table. 

3.   Drill through the Equipment Explorer window to find the equipment or maintained part to be listed 

on the Linked Equipment / Spaces / Structures sub-tab. 

4.  Click the check box preceding the equipment and/or parts. More than one selection can be made at one 

time. 

5.  Click the Select button on the Equipment Explorer window to close the Equipment Explorer window 

and add the selections to the Linked Equipment / Spaces / Structures sub-tab. 
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Link a Space 

1.   Click the Linked Equipment / Spaces / Structures sub-tab on the Table Definition tab. 

2.   Select References → Link / Unlink Space from the Table Template Setup window menu bar. The 

List of Spaces window opens. Authorized users can add a new space from this window. 

 

3. Double click on a space from the left side of the window to move it to the right side of the window. 

Continue selecting spaces and moving them until all spaces to be displayed on this table are listed on 

the right side of the window.  

4. Click the OK button to close the List of Spaces window and list the space or spaces in the Linked 

Equipment / Spaces / Structures sub-tab of the Table Template Setup window. 

 

 
 

Link a Structure 

1.   Click the Linked Equipment / Spaces / Structures sub-tab on the Table Definition tab. 

2.   Select References → Link / Unlink Structures from the Table Template Setup window menu bar. 

The List of Structures window opens. Authorized users can add a new space from this window. 
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3 Double click on a structure from the left side of the window to move it to the right side of the window. 

Continue selecting structures and moving them until all structures to be displayed on this table are listed 

on the right side of the window.  

4 Click the OK button to close the List of Structures window and list the structures in the Linked 

Equipment / Spaces / Structures sub-tab of the Table Template Setup window. 

 

Remove Equipment, Space or Structure from Linked Equipment / Space / Structures 

Sub-tab 

1.  Click to highlight the equipment, maintained part, space or structure to be removed from the Linked 

Equipment / Space / Structure sub-tab.  

2.   Select References → Unlink from the Table Template Setup window menu bar. A confirmation 

message box opens.  

3.  Click the Yes button to delete the selected items from the Linked Equipment / Space sub-tab.  

 NOTE:    Only one item at a time can be selected to be removed from the Linked Equipment / Space / Structures          

                              sub-tab.   

 

4 Repeat steps until all spaces or structures no longer used by this table are removed from the Linked 

Equipment / Space / Structures sub-tab. 

 

Link Standard Jobs to a Table Template 

The Linked Standard Jobs sub-tab at the bottom of the Table Definitions tab is used to link standard jobs and 

in turn work orders to the table. Linking a standard job adds this table to the Tables tab on the Standard Job 

window and the Readings tab on the Work Order window. The Linked Standard Jobs sub-tab is only 

available when the Applies to Non-PM Jobs check box is NOT checked.  

NOTE:   A standard job for a ship can be linked to a table without the ship being linked to the same  

               table. The table is listed on the standard job and any work orders associated with the standard  

               job, but entries can only be made to the table from the Readings tab on the Work Order  

               window. The table is not listed on the Table Entries window from Tools → Table Entries  

               on the Maintenance and Purchasing module at the ship level. 
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1.   Click the Linked Standard Jobs sub-tab on the Table Definition tab if it is not already active. 

2.   Select Standard Jobs→Link from the Table Template Setup window menu bar.  

 

The Standard Job Query window opens. This Standard Job Query window lists all standard jobs created for 

all ships within the fleet. The Ship Code field in the results portion of the Standard Job Query window aids 

in the selection of a standard job by displaying the ship associated with the standard job without having to open 

the Standard Job window.  

3.   Click the check box preceding the standard job to select. More than one selection can be made.  

4.   Click the Select button on the Standard Job Query window to close the Standard Job Query window 

and add all the selected standard jobs to the Linked Standard Jobs sub-tab.    

 
 

Link Work Orders Not Associated with a Standard Job to a Table 

Tables can be linked to work orders that are not associated with a standard job. Click the Applies to non-PM 

Jobs check box in the upper fields of the Table Definition tab of the Table Template Setup window. This 

table is listed on the Readings tab of all work orders that are not associated with a standard job. 

 

Remove Standard Jobs from the Linked Standard Jobs sub-tab 

1.   Click to highlight the standard job to be removed from the Linked Standard Jobs sub-tab.  

2.   Click Standard Jobs → Unlink from the Table Template Setup window menu bar. A confirmation 

message box opens.  
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3 Click the Yes button to delete the selected items from the Linked Standard Jobs sub-tab.  

 

 NOTE:   Only one item at a time can be selected to be removed from the Linked Standard Jobs sub- 

                      tab. 

 

4 Repeat steps until all jobs no longer used by this table are removed from the Linked Standard Jobs 

sub-tab. 

 

Column Definitions 

Columns for the table are created on the Column Definitions tab. 

 NOTE:     Columns MUST be defined before table entries can be made at the ship level. 

 

1. Click the Column Definitions tab on the Table Template Setup window.  

2. Type the column heading for the first column in the Name column on the Column Definitions tab. 

 

3. Click in the Type column for a drop-down list of choices. This list defines the type of characters in the 

column. 
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The options are: 

• Numeric – only numbers can be entered. The Pre-Decimal Digits and Post Decimal Digits 

columns open for input when Numeric is selected. The default value for the Pre-Decimal Digits 

column is 6. 

The Standard Control Values and Specific Control Values sub-tabs open for input for columns 

with a numeric type.  

• Alphanumeric – letters and numbers can be entered. 

• Boolean – adds a check box to the column. 

• Date – adds a Calendar button when the column is clicked. 

• Multi-line text – adds a Remarks button that opens a Remarks window when clicked. Multiple 

lines of text can be entered in the Remarks window. 

4. Click in the Column Width column to type the width of the column. The default value is 10. 

 

5. Click in the Description sub-tab at the bottom of the Column Definition tab to type a description of 

the column. 

 

6. Click the Add button on the Table Template Setup window toolbar to add another column. 

 

7.   Repeat steps to add and define columns until all columns for the table are specified.  
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Standard Control Values Sub-tab 

 

The Standard Control Values sub-tab is only available if the value in the Type column of the Column 

Definitions tab is “Numeric”. The minimum, maximum, base, and alarm values for each column with a numeric 

type are set on the Standard Control Values.  

1.   Click a column with a numeric column type. 

2.   Click the Standard Control Values sub-tab.  

3.   Click the check box preceding each field on the Standard Control Values sub-tab to set a value in the 

field following the field description. All fields do NOT need to be filled. Only check the boxes for the 

values needed.   

 

• Minimum Value – type the minimum value accepted for this field. For example, if the minimum 

value is 100 then no value less than 100 is accepted in this field. 

• Maximum Value – type the maximum value accepted for this field. For example, if the maximum 

value is 1000 then no value more than 1000 is accepted in this field. 

• Base Value – type the average value for this field. This is used for reference purposes. These values 

are displayed on the Table Entries window when information is added to the table. This way the 

person entering values can see what the base value of this field is and determine if there might be a 

problem. 

• High Alarm Value – type the high alarm value for this column. If the number entered in this column 

is this value or higher, there is a problem. 

• Low Alarm Value – type the low alarm value for this column. If the number entered in this column 

is this value or lower, there is a problem. 

4.   Click the next column definition with a numeric column type.  

5.   Follow step 3 to set the control values for this column. Repeat steps until the standard control values 

are set for all columns with a numeric column type.   
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Specific Control Values Sub-tab 

 

The Specific Control Values sub-tab defines the minimum, maximum, base, and alarm values for each column 

of a row on the table. Like the Standard Control Values sub-tab, it is only available if the value in the Type 

column of the Column Definitions tab is “Numeric”.  

 NOTE:     These control values are defined for each row of the table. The values set for the first row  

                               do NOT set the values for all rows in the table. 

 

The rows on the table are defined by information entered on the Linked Ships and Linked Equipment / Spaces 

sub-tabs on the Table Definition tab.  

1.   Click the row name in the Reference section of the Specific Control Values sub-tab.  

2.   Click the check box preceding the value to be entered on the right side of the Specific Control Values 

sub-tab to set a value in the field following the field description. All fields do NOT need to be filled. 

Only check the boxes for the values needed.   

• Minimum Value – type the minimum value accepted for this field. For example, if the minimum 

value is 100 then no value less than 100 is accepted in this field. 

• Maximum Value – type the maximum value accepted for this field. For example, if the maximum 

value is 1000 then no value more than 1000 is accepted in this field. 

• Base Value – type the average value for this field. This is used for reference purposes. These values 

are displayed on the Table Entries window when information is added to the table. This way the 

person entering values can see what the base value of this field is and determine if there might be a 

problem. 

• High Alarm Value – type the high alarm value for this column. If the number entered in this column 

is this value or higher, there is a problem. 

• Low Alarm Value – type the low alarm value for this column. If the number entered in this column 

is this value or lower, there is a problem. 

3.   Click the next row name in the Reference section to define the values for the columns in that row. 

4.   Continue defining values for all rows named in the Reference section until all control values are 

defined. REMEMBER – setting the values for one row do NOT set the values for the other rows in the 

table. 
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 Export Past Entries 

Export past table entries for selected ships for a selected time frame to an Excel spreadsheet are available at the 

fleet and ship levels, but at different capacities. The Fleet level option allows information from multiple ships 

to be exported whereas the ship level option allows only the information for that ship to be exported.  

1. Select the table whose entry information is to be exported from the left side of the Table Template 

Setup window.  

2. Click the Export Past Entries button on the Table Template Setup window toolbar. 

 

• The Export window opens. 

 

3 Click the dropdown menu at the end of the Ships field to select the ships whose table information is to 

be exported.  

  NOTE:    The Ship field is automatically filled with the name of the ship if this procedure is done from 

                       the ship level. 

 

• The List of Ships window opens. 

4. Double click on a ship from the left side of the List of Ships window to move it to the right side of the 

window. Continue selecting and moving ships until all ships whose past entries for the selected table 

are to be exported are selected.  

5. Click the OK button to close the List of Ships window and add the selections to the Ships field on the 

Export window. 

6.   Click the Calendar button at the end of the Start Date field and the End Date field to select the date 

range for the report. 

7.   Click the OK button. An Excel spreadsheet opens containing the information from the selected table. 
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 Modify a Table 

A table is restricted from modification if it has been used. Items can only be added to the table, but NOT deleted 

or removed if a table has been used. Otherwise, the integrity of the information entered on the table when it was 

used prior to modification is compromised.  

Ships, equipment, spaces, standard jobs, and columns can be added to a table even if it has been used. 

 Make Table Entries 

Entries to a table are made on the Ship level. There are two places where these entries can be made: 

• Tools → Table Entries from the Maintenance gadget on the Navigator pane in the Maintenance 

module. This option is available if the ship is listed on the Linked Ships sub-tab on the Table 

Template Setup window. 

• Readings tab on the Work Order window – This option is available if the standard job that the 

work order is associated with is listed on the Linked Standard Jobs sub-tab on the Table 

Template Setup window.  

 

The table is also available on the Readings tab of a work order not associated with a standard job if the Applies 

to non-PM jobs check box has been checked on the Table Template Setup window. 

 

Table Entries from Tools→Table Entries 

The Table Templates of window opens when Tools → Table Entries is selected from the Maintenance gadget 

on the Navigator pane in the Maintenance module on the ship level.   
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The Table Templates of window displays all tables available to this ship. It also displays past entries to each 

table in the lower portion of the window when the table is highlighted in the top section. Select a table entry, 

click the Open button on the Table Templates of window toolbar and the Table Entries window opens with 

the entries that were made to this table on that date. 

1.   Select a table on the top section of the Table Templates of window. 

2.   Click the New button on the toolbar to add entries to the table. The Table Entries window opens. 

 

 

NOTE: The table name and name of the ship entering information are 

automatically entered and CANNOT be edited. The defined columns and 

rows are listed on the table. A description of the column with the control 

values for the first column are listed in the lower section of the Table 

Entries window.  

 

3.   Click the Calendar button at the end of the Entry Date field to change the date on the table. The default 

value is the current date. 

4.   Click in the Time field to change the time. The default value is the current time. 

5.  Fill in the appropriate information in the table.  

6.   Click the Save button on the Table Entries window to save the table. 
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Table Entries from a Work Order 

Table entries can be made from the Readings tab of a work order if the table is linked to the work order through 

a standard job or from the Applies to non-PM Jobs check box. 

Only the tables associated with the work order can be opened from the Work Order window. 

1.   Double click on the table listed on the Readings tab of the work order. The Table Entries window 

opens. 

 

 
NOTE:   This Table Entries window is similar to the one opened from the 

Maintenance and Purchasing module except the work order number is 

also listed on this window.   

 

2.   Click the Calendar button at the end of the Entry Date field to change the date on the table. The default 

value is the current date. 

3.   Click in the Time field to change the time. The default value is the current time. 

4.   Fill in the appropriate information in the table.  

5. Click the Save button on the Table Entries window to save the table. 
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Section 15 Running Hours 

Running hours need to be updated regularly. The more often the running hours are updated, the more accurately 

the Maintenance Plan can predict when standard jobs should be scheduled. The Maintenance Supervisor (Chief 

Engineer), 1st Engineer and Chief Mechanic have permissions to update Running Hours. 

 Updating Running Hours 

Running hours are only updated on equipment to which a counter based standard job is linked.  Running hours 

should be updated weekly. They should be updated for each piece of equipment, whether or not the counter has 

changed. This is for more accurate scheduling. 

1. Go to Tools →  Record Elapsed Running Hours in the Maintenance gadget on the Navigator to 

update current running hours. 

• A window opens where running hours can be recorded. 

          

2.   Highlight the equipment and enter the counter reading and the date. 

3.   Ensure counter readings for all equipment are entered, whether or not the counter has changed since the 

last entry. The counter may not have changed, but the date has changed, and NS needs this information 

to accurately schedule counter based standard jobs. 
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 NOTE: 

        Record Elapsed Running Hour List screen will not include the Units which are marked as Inactive. 

 Correcting Running Hours 

Sometimes the wrong counter reading is entered, but not discovered until the next week when the next set of 

readings is entered.  The user can correct this easily in NS. 

1.   Choose Tools →  Record Elapsed Running Hours in the Maintenance gadget on the Navigator. 

2.   Click the Counter History tab. 

3.  Click the Delete Last button to delete the update entries one by one until the user returns to the last 

correct entry.   

4.   Enter the current correct value and date as described in the previous section. 
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Section 16  Landing Orders 

Landing Order is the document used to facilitate and record the movement of Serialized items. 

The destination can be a warehouse, another rig, or a vendor. 

It includes the below workflow stages: 

• External approval before the shipment (optional) 

• Shipment tracking 

• Transit tracking 

• Delivery tracking 

 Create Landing Orders (LO) 

1. Select the Maintenance gadget →  Documents → Create → Landing Order from the Navigator 

pane on the Maintenance module.  The Landing Order – New window opens. 

      

2.   Click the Calendar button at the end of the LO Date field to select the date for the Landing Order. 

3.   Complete all applicable fields and tabs. 

4.   Click the Save button on the Landing Order window toolbar to save the Landing Order.  
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 Link/Unlink Items to LO 

Select Maintenance gadget→ Search → Landing Orders from the Navigator pane on the Maintenance and 

Purchasing module from the ship view to open the Landing Orders Search window.  

1. Click the Search tab after selecting the parameters for the search.  Click the Search button to initiate 

the search.  All the landing orders that meet the specified criteria are listed on the right side of the 

window for this specific ship. 

2. Double click on the Landing Order to open the Landing Order window to Link/Unlink items. 

3. Right-click on the LO Items tab and choose Link Items to open the Serialized Item Query Navigator 

window. 

 

4. On the Serialized Item Query window enter in the filter criteria and click on the Search Button.  By 

default, the installed/removed field will be populated with the value of Removed. 

5. Find the item to be linked by highlighting the row and clicking the select toolbar icon.  Selecting the 

item from the List window closes the Serialized Item query window and returns the value to the LO 

Items Tab. 

 

6. Click the Save button on the Landing Order window toolbar to save the changes on the Landing Order. 
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 Authorize LO 

1. Select Maintenance gadget→ Search → Landing Orders from the Navigator pane on the 

Maintenance and Purchasing module from the ship view to open the Landing Orders Search 

window. Click the Search tab after selecting the parameters for the search.  Click the Search button to 

initiate the search.  All landing orders that meet the specified criteria are listed on the right side of the 

window for this specific ship. 

2. If only authorizing a single landing order, double click on a Landing Order in the List window to open 

the Landing Order.  From the Process menu select Authorize.   

 

• A message will display asking if this is the Landing Order is to be authorized. 

3. Click the OK button to authorize the Landing Order. 

 

 NOTE:    If the Landing Order contains no line items a message will display. 

 

     

4. If authorizing multiple Landing Orders from the Landing Order List Window, check the box preceding 

the Landing Order and from the Process menu select Authorize. 

5. A message will display asking to Proceed with Authorization.  Click the OK button to authorize the 

selected Landing Orders. 

NOTE:    If the selected Landing Orders does not contain any linked items or is missing information a  

                 message will appear to correct the selected documents before trying the steps again to  

                 authorize. 
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 Approve LO 

1. Select Maintenance gadget→ Search → Landing Orders from the Navigator pane on the Maintenance 

and Purchasing module from the ship view to open the Landing Orders Search window. Click the 

Search tab after selecting the parameters for the search.  Click the Search button to initiate the search.  

All of the landing orders that meet the specified criteria are listed on the right side of the window for this 

specific ship. 

2. If only approving a single landing order, double click on a Landing Order in the List window to open 

the Landing Order.  From the Process menu select Approve.   

A message will display asking if this is the Landing Order is to be approved. 

 

3. Click the OK button to approve the Landing Order. 

 

4. If approving multiple Landing Orders from the Landing Order List Window, check the box preceding the 

Landing Order and from the Process menu select Approve. A message will display asking if the selected 

documents are to be approved. 

5. Click the OK button to approve the selected documents. 

 Cancel Landing Order 

1. Select Maintenance gadget→ Search → Landing Orders from the Navigator pane on the Maintenance 

and Purchasing module from the ship view to open the Landing Orders Search window. Click the 

Search tab after selecting the parameters for the search.  Click the Search button to initiate the search.  

All the landing orders that meet the specified criteria are listed on the right side of the window for this 

specific ship. 

2. If only cancelling a single landing order, double click on a Landing Order in the List window to open 

the Landing Order.  From the Process menu select Cancel.  A message will display asking if this is the 

Landing Order is to be cancelled. 
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3. Click the OK button to cancel the Landing Order. 

 

4. If cancelling multiple Landing Orders from the Landing Order List Window, check the box preceding the 

Landing Order and from the Process menu select Cancel. A message will display asking if the selected 

documents are to be cancelled. 

5. Click the OK button to cancel the selected documents. 

NOTE:      Cancelled documents on the search list screen are visually distinctive (using a strikethrough  

                   font) from other records displayed on the search results.  

 Ship & Deliver LO 

1. Select Maintenance gadget→ Search → Landing Orders from the Navigator pane on the Maintenance 

and Purchasing module from the ship view to open the Landing Orders Search window. Click the 

Search tab after selecting the parameters for the search.  Click the Search button to initiate the search.  

All the landing orders that meet the specified criteria are listed on the right side of the window for this 

specific ship. 

2. If only shipping a single landing order, double click on a Landing Order in the List window to open the 

Landing Order.  From the Process menu select Shipped.   

 

• A message will display asking if this is the Landing Order is to be shipped. 
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3. Click the OK button to change the Landing Order to Shipped. 

 

4. If changing the status on multiple Landing Orders from the Landing Order List Window, check the box 

preceding the Landing Order and from the Process menu select Shipped. A message will display asking 

if the selected documents are to be changed to Shipped. 

5. Click the OK button to change the status to Shipped on the selected documents. 

NOTE:     Before a Landing Order status can be changed to a status of delivered it must be in a status of      

shipped. 

 

6. Select Maintenance gadget→ Search → Landing Orders from the Navigator pane on the 

Maintenance and Purchasing module from the ship view to open the Landing Orders Search 

window. Click the Search tab after selecting the parameters to search for Landing Orders in a status of 

Shipped.  Click the Search button to initiate the search.  All the landing orders that meet the specified 

criteria are listed on the right side of the window for this specific ship. 

7. If only delivering a single landing order, double click on a Landing Order in the List window to open 

the Landing Order.  From the Process menu select Delivered. 

 

• A message will display asking if this is the Landing Order has been delivered. 

8. Click the OK button to change the Landing Order to Delivered. 

 

9. If changing the status on multiple Landing Orders from the Landing Order List Window, check the box 

preceding the Landing Order and from the Process menu select Delivered. A message will display asking 

if the selected documents are to be changed to Delivered. 

10. Click the OK button to change the status to Delivered on the selected documents. 
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• The Deliverables window will be shown on screen.  

11. Click dropdown menu under the Storage Location column to assign a location for the deliverables. 

12. Click Ok to close the Storage Location window. 

13. Click Ok to close the Deliverables window. 

 

 Search for LO 

1. Select Maintenance gadget→ Search → Landing Orders from the Navigator pane on the 

Maintenance and Purchasing module from the ship view to open the Landing Orders Search 

window.  

2. The fields on the Landing Order window are: 

Field Description 

General Section  

Source Ship The vessel or warehouse the item is being shipped from 

Source Vendor The vendor the item is being shipped from. 

Destination 

Ship 

The vessel or warehouse the item is being shipped to 

Destination 

Location 

The name of the ship or vendor where the Landing Order is being delivered. 

LO No. Landing Order Number, this can be entered in manually or automatically 

generated by the system. 

SI Status Status of the part or equipment, e.g. Repair Ashore 
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Field Description 

Status This is a search for the Landing Order (LO) status. 

SI Reference SI Reference of the part or equipment 

Authorizer The name of the seafarer that authorized the Landing Order. 

Approver The name of the seafarer that approved the Landing Order. 

Date Range Section  

Created The date the Landing Order was created. 

Authorized The date the Landing Order was authorized. 

Approved The date the Landing Order was approved. 

Shipped The date the Part or Equipment listed on the Landing Order was shipped. 

Delivered The date the Part or Equipment listed on the Landing Order was delivered. 

3. Select search criteria and click on the Search button to have the search results display in the List window 

to the right of the navigator pane. 

 Landing Order Report Form 

1. Select Maintenance gadget→ Search → Landing Orders from the Navigator pane on the 

Maintenance and Purchasing module from the ship view to open the Landing Orders Search 

window.  

2. Click the Search tab after selecting the parameters for the search.  Click the Search button to initiate 

the search.  All the landing orders that meet the specified criteria are listed on the right side of the window 

for this specific ship. 

3. Double click to open the selected Landing Order. 

4. From the process menu, select Reports→LO Form.  Select the report option and click the OK button. 
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Section 17 Job Safety Analysis ( JSA ) 

Job Safety Analysis (JSA) feature includes custom risk matrices incorporated into a job safety worksheet that 

can be linked to work orders.  

JSA is used to identify, analyze and record: 

1. The steps to be taken to perform a specific job  

2. The existing or potential safety and health hazards associated with each step 

3. The recommended action or procedures to eliminate or reduce these hazards, and   the risk of workplace 

injury or illness  

Job safety analysis information is on the Job Safety Analysis tab of the work order. 

Configuration and setup for Job Safety Analysis includes index terms and creating a risk matrix.  See your local 

system administrator for information how these are created/maintained. 

 JSA Templates 

Any JSA document can be used as a template for other JSA documents. Note: Only authorized users can create 

a template.  For more details on JSA templates see the HSQE User Manual. 

Templates can be used as a “jump start” to creating other JSA documents that may be using the same matrix, 

steps to complete tasks or safeguards. All the information on the template is editable. Specific information has 

been deleted from the template such as the vessel, voyage, and JSA Number, as well as the participants, any 

documents, attachments, remarks, messages, work orders, equipment, spaces, and corrective action requests.  

NOTES:    

• Templates have a Change Log tab instead of a Status tab. Entries are made on the Change 

Log when changes are made to the template and it is resaved as the same template. 

• There is an authorization in authorization profiles that allows users to open a template and 

make changes will save the changes as a new JSA and not make changes to the original 

template. 

 Perform JSA Quick Check-Questions 

Authorized users can create or edit the questions listed on the JSA quick-check questions that are displayed 

on the Work Order window. These questions, which will recommend a user if a JSA for a given work order 

needs to be carried out; JSA needs to be generic to fit any job safety situation. 

ABS Consultants will assist local administrator with creating the Quick Check Questions at initial 

implementation and then are maintained by local system administrator. 

Quick-Check Questions can be created to determine if a JSA for a given workorder is required. This can be 

done in General Data. (Refer to the HSQE manual for the details on creating JSA Quick-Check Questions) 
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NOTE:  Questions can be added or deleted; the order of the questions cannot be changed. 

 

Select Maintenance gadget→ Documents → Search → Work Order on the Navigator pane of the 

Maintenance and Purchasing module.  

1. Find the Work Order, open it and navigate to the Job Safety Analysis tab 

2. Answer the JSA Quick-Check questions with either Yes or No selecting the appropriate option. 

3. Click the Run Quick-Check button. 

4. You will notice that JSA Recommended? box is now displaying Yes, meaning that a JSA is 

recommended. 

5. JSA process should start from this point. 

NOTES:   

• The questions are only displayed on the Work Order window if the “JSA Quick-Check 

Required” system preference is set to “Yes”.    

• Questions can be added or deleted; the order of the questions cannot be changed. 

 

 Create a Job Safety Analysis Document 

A JSA document can be created from the HSQE tab or from the Work Order window in the Maintenance 

module.   

A JSA can be created in three options. All three options follow the same process when it comes to 

accomplishing the JSA document, they just differ in the manner of how these are started. 

1. Select Documents → Job Safety Analysis → Create from the HSQE gadget on the Navigator pane of 

the HSQE module.  

NOTE:  The questions are only displayed on the Work Order window if the “JSA Quick-Check 

Required” system preference is set to “Yes”.    
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2. On the Create JSA screen, 3 options are available: 

• Using Template 

• New JSA 

• Create Template 

17.3A     Using Template option 

Below is the Create JSA screen Using Template. User needs to select a template from the dropdown menu. 

This is the only step different from the other two options – New JSA and Create Template. Once a template is 

selected, the system populates the fields with information already setup in the template. 
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17.3B     New JSA option 

Below is the Create JSA screen using New JSA. User needs to manually select and input all field information. 

JSA No. can be Auto generated or manually entered depending on the System Preference setup. 

 

 

17.3C     Create Template option 

Below is the Create JSA screen using Create Template. User needs to manually select and input all field 

information. JSA No. is set as Template. 
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Field Name Description / Action 

Risk Matrix Select the Risk Matrix from the dropdown menu. 

Title Enter a Title for the New JSA. 

JSA No. This is driven by System Preference. It could be system generated or manually entered. 

JSA Type Click the dropdown menu at the end of the JSA Type field to select the type of JSA 

document. The JSA Type List window opens. Double click on a selection to close the 

JSA Type List window and add the selection to the JSA Type field.  

JSA Category Click the dropdown menu at the end of the JSA Category field to select the category 

that the JSA document is part of. The JSA Category List window opens. 

Ship The Ship field is automatically filled if the document is created from the Ship level. 

Click the dropdown menu at the end of the Ship field to add a vessel to the document if 

it is created from the Fleet level. The Select Ship list window opens. Double click on a 

vessel to close the Select Ship window and add the selection to the Ship field.  

Department 
Click the dropdown menu at the end of the Department field to select the name of the 

department(s) affected by the JSA. More than one department can be selected. The 

Department Selection window opens. 

Double click on a department on the left side of the window to move the selected 

department to the right-hand side.   

Continue selecting and moving departments until all departments affected by this JSA 

are listed on the right side of the Department Selection window 

Click OK on the Department Selection window to close this window and add the 

selections to the Department field. 

Next 
Click this button to move to the next step. 

Finish 
Click this button once done providing the required information. 

 

Below are the other fields in a newly created JSA, apart from the ones mentioned in the previous table. 
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Field Description 

Approver Populates with the Approver Name set up in the JSA Document Approval Setup 

configuration. 

Approve by Date when the JSA is approved. 

Identifier The identifier is used when configuring approvals for JSA documents. 

SMM 

Reference 

Click the dropdown menu at the end of the SMM Reference field to open the SMM 

Reference List window.  

Double click on the appropriate safety management reference on the SMM Reference List 

window. The window closes, and the selection is added to the SMM Reference field. 

There is a system preference that when configured allows the SMM Reference field to be 

an index term or a text field.  The SMM Reference added in Questionnaire is copied to 

Findings. 

Voyage The Voyage field is automatically populated with the appropriate voyage name / number 

if the Voyage module) is part of your NS suite of products. The system uses the Ship and 

Event Date fields to determine which voyage to select for the Voyage field.  

Click the dropdown menu at the end of the Voyage field to change the automatic selection.  

The Voyage Lists window opens. Double click on a selection to close the Voyage Lists 

window and add the selection to the Voyage field. 

Standard 

Reference 

Click the dropdown menu at the end of the Standards Reference field to select a 

reference. The Standards Reference window opens. 

• Highlight the desired text description. 

Click Select on the Standards Reference window. The window closes, and the selection 

is added to the Standards Reference field. 

Residual Risk  

Permit to 

Work Type 

Select the PTW type from the dropdown menu. 

PTW 

Required 

checkbox 

Determines if the JSA requires PTW or not. If this box is ticked, the Permit to Work Type 

dropdown menu will be activated. 

View Matrix 

button 

Click View Matrix to display the matrix selected in the Risk Matrix field.  

 

NOTE:  Post Risk Ranking Enabled, JSA Quick Check Required and JSA Approval Process 

Enabled must all be set to Yes in System Preferences from the System Administration 

module to see the necessary information.   
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   Safety Analysis Tab 

NOTE:  Information cannot be added to the Safety Analysis tab unless a matrix has been selected in 

the Risk Matrix field.   

The Safety Analysis tab contains the important information associated with the JSA. It is divided into several 

sections.  

 

 

 

 

The fields on this tab are: 
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Section Field Description 

Hazards and 

Safeguards  

sub-tab  

Hazards section 

 The Hazards section of the Safety Analysis tab contains steps 

to complete the task and the hazard associated with the step. It is 

divided into the following two sections: 

• The Initial Ranking section contains the steps within a 

task, the possible hazards associated with the step, the severity 

of the hazard, the likelihood of the hazard occurring, and the 

safeguards needed to reduce the risk.  

• The Post Ranking section is completed if the “Yes” 

option is selected for the Post Risk Ranking Enabled system 

preference.  

NOTE: There is a system preference “Require hazard to 

Complete JSA” that a can be set to require hazards for a specific 

JSA. 

Initial Ranking Steps to 

Complete Task 

Enter steps to complete the task in the Steps to Complete Task 

column by clicking Add/Remove button from the menu bar and 

selecting Add Task/Hazard. 

Initial Ranking Hazard Enter the hazard associated with the step in the Hazard column 

by clicking Add/Remove button from the menu bar and selecting 

Add Task/Hazard. 

Initial Ranking Severity Click in the Severity column for a dropdown menu of the 

severity levels as defined by the matrix selected in the Risk 

Matrix field. Select the level of severity of the hazard.  

 NOTE:  Another row is added to the Hazards section 

when a severity level is selected.  
 

Initial Ranking Likelihood Click in the Likelihood column for a dropdown menu of the 

likelihood levels as defined by the matrix selected in the Risk 

Matrix field. Select the level of likelihood that the hazard can 

occur. 

Initial Ranking Risk The value in the Risk column is inserted by the system according 

to the intersection of the Severity level and Likelihood level on 

the selected risk matrix. 

This value is the Risk Label that was defined when the matrix 

was created.  

Post Ranking Safeguard Enter the safeguard that can be implemented to reduce the risk 

associated with the hazard in the Safeguard column by clicking 

Add/Remove button from the menu bar and selecting Add 

Safeguard. 
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Section Field Description 

Post Ranking Severity The Severity column in the Post Ranking portion of the 

Hazards section is only available if the “Yes” option is selected 

for the Post Risk Ranking Enabled system preference. 

Click in the Severity column for a dropdown menu of the 

severity levels as defined by the matrix selected in the Risk 

Matrix field. Select the level of severity of the hazard with the 

safeguard implemented.  

Post Ranking Likelihood The Likelihood column in the Post Ranking portion of the 

Hazards section is only available if the “Yes” option is selected 

for the Post Risk Ranking Enabled system preference. 

Click in the Likelihood column for a dropdown menu of the 

likelihood levels as defined by the matrix selected in the Risk 

Matrix field. Select the level of likelihood of the hazard 

occurring with the safeguard implemented. 

Post Ranking Risk The value in the Risk column is inserted by the system according 

the intersection of the Severity level and Likelihood level on the 

selected risk matrix. 

This value is the Risk Label that was defined when the matrix 

was created.  

Hazards and 

Safeguards sub-

tab  

Safeguards 

section 

 The Safeguards section on the Safety Analysis tab is used to 

specify if the safeguards exist, the position title responsible for 

implementing the safeguards and the actions taken to implement 

the safeguard. 

 No. Number sequence 

 Safeguard The Safeguard column is completed as safeguards are entered 

in the Hazards section.  

 Existing Click in the Existing column for a drop-down menu of options 

to indicate whether the safeguard exists or not.  

 Responsibility Type the position responsible for implementing the safeguard in 

the Responsibility column. 

 Action Item Type the action taken to implement the safeguard in the Action 

Item column.  
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Section Field Description 

Participants 

sub-tab 

 Participants needed to accomplish the tasks listed on the JSA in 

the Participants section. 

If users do not have the Crewing Module, they must use the 

Crewing Interface in order to populate Participants tab. 

Right click the Add on the Participants sub-tab. Enter the Start 

Date and End Date. 

 

The Crew List window opens. Tick the check box preceding the 

seaman to select.  Continue selecting seamen until all that are 

needed for the safety analysis are selected. Click Select from the 

Crew List By Date window toolbar to close the window and add 

the selections to the Participants section. 

The personnel window for a seaman can be viewed by double 

clicking on a seaman listed in the Participants section. 

A seaman can be removed from the Participants section by 

repeating the steps for adding a seaman and unchecking the 

selected seaman.   

 

Furthermore, user can add any external visitor who were 

involved in the Job Safety Analysis activity, by following the 

same steps in adding a crew member as participant, but this time 

selecting the Visitor radio button. 

 

Position Title The Position Title field is completed by the system when 

participants are added.  

Name The Name field is completed by the system when participants 

are added.   

Task Click on the Task column to type the task that the seaman will 

perform. 
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Section Field Description 

Qualification 

check box 

Click the Qualification check box to indicate that the seaman’s 

qualifications have been verified. 

 Participant 

Type 

Indicates the type of participant the crew/visitor is.  

Others sub-tab Required 

Personal 

Protective 

Equipment 

(PPE) 

Click the dropdown menu at the end of the field to select any 

personal protective equipment needed. The PPE Selection 

window opens.  

Double click on a selection on the left side of the window to 

move it to the right side. Continue making selections until all 

equipment needed are listed on the right side of the window. 

Click OK to close the PPE Selection window and add the 

selections to the Required Personal Protective Equipment 

field.  

Personal Protective Equipment is defined as index terms. 

Required 

Endorsements 

Click the dropdown menu at the end of the Required 

Endorsements field to select any endorsements that are needed. 

The List of Endorsements window opens.  

Double click on a selection on the left side of the window to 

move it to the right side. Continue making selections until all 

endorsements needed are listed on the right side of the window. 

Click OK to close the List of Endorsements window and add 

the selections to the Required Endorsements field. 

Required Work 

Permits 

Click the dropdown menu at the end of the Required Work 

Permits field to select any certificates that are needed. The 

Work Permit Selection window opens.  

Double click on a selection on the left side of the window to 

move it to the right side. Continue making selections until all 

certificates needed are listed on the right side of the window. 

Click OK to close the Work Permit Selection window and add 

the selections to the Required Work Permits field. 

Others sub-tab Required Other 

Qualifications 

Click the dropdown menu at the end of the Required Other 

Qualifications field to select any qualifications or skill sets that 

are needed. The Skill Selection window opens.  

Double click on a selection on the left side of the window to 

move it to the right side. Continue making selections until all 

qualifications or skill sets needed are listed on the right side of 

the window. 

Click OK to close the Skill Selection window and add the 

selections to the Required Other Qualifications field. 
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Section Field Description 

Required 

Certification 

Click the dropdown menu at the end of the Required 

Certification field to select any required certificates. The List 

of Certificates window opens.  

Double click on a selection on the left side of the window to 

move it to the right side. Continue making selections until all 

required certificates are listed on the right side of the window. 

Click OK to close the List of Certificates window and add the 

selections to the Required Certification field. 

Required 

Training 

Click the dropdown menu at the end of the Required Training 

field to select any required training. The List of Training 

window opens.  

Double click on a selection on the left side of the window to 

move it to the right side. Continue making selections until all 

required training is listed on the right side of the window. 

Click OK to close the List of Training window and add the 

selections to the Required Training field. 

   Safeguard Checklist 

The Safeguard Checklist tab shows the Task, Hazard and Safeguard details found in the Safety Analysis tab. 

 

 

   DMS Link 

Refer to Item 21.8 DMS Link Tab section of this manual. 

   File Attachments Tab 

Refer to Item 21.2 File Attachment Tab section of this manual 



  Nautical Systems Enterprise Maintenance User Manual 

©2020 American Bureau of Shipping and affiliated companies. All rights reserved. This document contains proprietary and confidential information for review and discussion 

purposes only. No part of this document may be used, disclosed, copied, or distributed, by any form or any means, without the express written consent of the American Bureau 

of Shipping.   

       PROPRIETARY AND STRICTLY CONFIDENTIAL. DISTRIBUTION TO THIRD PARTIES IS STRICTLY PROHIBITED.          P a g e  | 303 

   Status Tab 

The Status tab is system populated as the JSA document progresses through its lifecycle. 

   Remarks Tab 

The Remarks tab is a free for text field. 

   Message Tab 

Refer to Item 21.5 Messages Tab section of this manual. 

   WO’s/SR’s Tab 

The WO’s/SR’s tab allows the user to link/unlink any related work orders, service requisitions or service 

orders to the JSA document. 

1. Right-click on the WO’s/SR’s field and select the action OR click WO’s/SR’s from the menu bar and 

select the action. 

 

2. To Link/Unlink Work Order, select Link/Unlink Work Order from the options. The Work Order 

Selection window will be shown on screen. Tick the box preceding the WO and click Select icon from 

the toolbar. 

 

3. To Unlink, follow the steps in Linking WO’s/SR’s, but this time, Untick the box preceding the WO. 

4. To Open Work Order, select the Work Order from the options. Right-click and select Open Work 

Order. 
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5. The Work Order will be shown on screen. 

 

  Equipment/Spaces Tab 

See Item #21.6 Equipment/Space/Structure Tab under Section 21 Miscellaneous part of this manual for the 

equipment/space/structure tab details. 

  CARs Tab 

The CAR’s tab is used to link any related CARs to the JSA document or create a new corrective action request 

for the JSA. NS can assign CARs to specific personnel and / or auto generate messages to responsible 

personnel. 

1. Click Link / Unlink CAR button on the JSA window toolbar to link or unlink existing CARs to the 

incident. The All Corrective Action Requests (CAR’s) window opens.  

2. Complete fields on the Search tab of the All Corrective Action Requests (CAR’s) window to find 

the CAR’s associated with the JSA.  

3. Click the check box next to the CAR(s) associated with the JSA on the All Corrective Action 

Requests (CARs) window to select. More than one selection can be made. 

4. Click Select on the All Corrective Action Requests (CARs) window to close this window and add 

the selections to the CAR’s tab. 
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5. Double click on any corrective action request listed on the CAR’s tab to open the Corrective Action 

Request (CAR) window for that selection. 

 

Create a New CAR from the JSA Document 

1. Click New CAR on the JSA window toolbar.  The Corrective Action Request (CAR) New window 

opens 

2. See Creating Corrective Action Requests Manually in this manual for details on completing this 

window.  

NOTE:  Any CAR created from the JSA window is automatically linked to the JSA. It is displayed 

on the CAR’s tab as soon as Save is clicked on the Corrective Action Request (CAR) 

window. 

 Permit To Work 

Permit To Work is used to provide controlled process for documentation and approval of necessary 

preparations before maintenance activities can be performed where applicable. It is considered an integrated 

part of the JSA workflow. 

1. Right-click on the Permit To Work field and select the action OR click PTWs from the menu bar 

and select the action. 

 

2. To Create Permit To Work, follow the steps in Section 18.3 Item #2 onwards. 

3. To Link/Unlink Permit To Work, select Link/Unlink Permit To Work from the actions. The Permit 

to Work List window will be shown on screen. Tick the box preceding the PTW and then click the 

Select icon from the toolbar. 

 

4. To Unlink, follow the steps in Linking Permit To Work, but this time, Untick the box preceding the 

Permit To Work. 
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 Custom Forms Tab 

Refer to Item 21.3 Custom Forms Tab section of this manual. 

 Submit a Job Safety Analysis for Approval 

1. Click Submit for Approval from the JSA window toolbar. 

 

 

 

 

  

 

 

 

2. A message box opens. Click Yes to close the message box and complete the submission for approval 

or rejection process.  

 

 

 

 

 

 

3. If approving the JSA, then the Submit button is grayed out, the Approve button is activated on the 

toolbar and the status of the document is changed to “Submitted”.   

If user rejects the approval, the JSA reverts to “Created” status. 

  Approve / Un-approve a Job Safety Analysis Document 

1. Click Approve on the JSA window toolbar. A message box opens. 
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2. Click Yes to close the message box and complete the approval process. 

The Approve button is grayed out, the Un-Approve and Complete JSA buttons are activated on the toolbar 

and the status of the document is changed to “Approved”. 

NOTE: JSA documents that have been approved can be unapproved. 

3. Click Un-approve on the JSA window toolbar.  A message box opens. 

 

4. Click Yes to close the message box and complete the un-approval process. 

The Un-approve button is grayed out, the Approve button is activated on the toolbar and the status of the 

document is changed to “Un-Approved”. 

5. The Remarks icon at the end of the Un-Approved row on the Status tab can be clicked to open the 

Remarks window. A reason must be given for the un-approval.  

       Complete a Job Safety Analysis Document 

1. Click Process and select Complete JSA from the Menu bar or click Complete JSA icon on the JSA 

window toolbar.  A message box opens. 

            

 

2. Click Yes to close the message box and complete the document. 

All process buttons are grayed out on the toolbar and the status of the document is changed to “Completed”. 

 

 

NOTE:  A system preference can be set to restrict editing or rejected JSA.  Contact your System 

Administrator to set this preference. 
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 Close Job Safety Analysis Document 

1. Closing a JSA Document means the JSA has been verified / completed. 

2. Search for completed JSAs on the JSA Search Navigator Pane. 

 

 

3. Open the JSA to be closed. Click Process from the menu bar and select Close JSA. 

 

 

4. Click Yes to close the message box and complete/close the document. 
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 Cancel Job Safety Analysis Document 

1. Search for JSAs on the JSA Search Navigator Pane. 

2. Open the JSA to be cancelled.  From the Process menu on the JSA document, select Cancel.   A 

message box opens.  

 

 

3. Click Yes to close the message box and cancel the document. 

 

 

 

 

 

 

 

 Hide a Job Safety Analysis Document 

JSA documents can be hidden from the JSA window or from any of the JSA list windows.  

1. Click Hide on the JSA window toolbar.  A message box opens. 

 

2. Click OK to hide the document. 
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All buttons are grayed out on the toolbar, all fields are disabled, a red box with the “Hidden” label is in the 

upper right corner of the document and the status of the document is changed to “Hidden”. 

NOTE:    Multiple JSA documents can be hidden at one time from the JSA Query window. 

3. Run a query on the JSA Query window. A list of JSA documents is listed on the right side of the 

window. 

4. Click the check box preceding all the documents to be hidden. 

5. Click Hide on the list window toolbar.  A message box opens. 

 

 

 

 

 

 

 

6. Click Yes. The selected documents are removed from the window. 

 
 

  View Hidden Job Safety Analysis Documents 

Hidden JSA documents can be viewed once they have been hidden.  

1. Click Toggle Hidden Record Display Mode from the Navigator pane toolbar in the HQSE module. 

 

2. Select Documents → Job Safety Analysis → Search from the HSQE gadget on the Navigator pane 

of the HSQE module.  The JSA Query window opens. 
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3. Complete the fields on the Search tab of the JSA Query window to find the JSA documents that are 

hidden.  

4. Click Search (bottom of the Query window) to initiate a search.  A list of documents meeting the 

search criteria opens on the right side of the window.  The hidden documents are indicated with the 

Hide symbol preceding the document. 
 

 Unhide Job Safety Analysis Documents 

Previously hidden JSA documents can be unhidden. Unhiding a document is different from viewing a hidden 

one as unhiding replaces the document in the list window without using the toggle process. 

1. Click Toggle Hidden Record Display Mode from the Navigator pane toolbar in the HSQE module. 

 

2. Select Documents → Job Safety Analysis → Search from the HSQE gadget on the Navigator pane 

of the HSQE module.  The JSA Query window opens. 

3. Click Search button at the bottom of the Search Query screen. 

4. Click the check box preceding the document to be unhidden. More than one selection can be made. 

5. Click the Hide/Un-Hide button on the JSA Query window toolbar.   A hide/un-hide message box 

opens. 

 

 

6. Click Yes to close the message box and unhide the selected hidden documents. The Hide symbol is 

removed from the hidden documents and they are restored. 
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Section 18 Project Management 

Projects are a way of grouping financially related documents.  A project has its own budget and account codes. 

Companies typically use projects for capital improvements that have a separate budget and to capture 

information related to insurance claims.   

Projects can be linked to various documents on the Admin Info tab of the document. Please see the Purchasing 

User Manual for more information on Projects.  
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Section 19 Maintenance Reports 

There are many types of reports throughout the Maintenance and Purchasing module associated with different 

windows. These reports are explained in the sections regarding those windows. The maintenance reports 

explained in this section are the ones generated from the Maintenance module. The maintenance report listings 

in the Reports gadget for both Fleet level and Ship level include – Maintenance Reports, RCM Reports and 

Other Reports. 

This section focuses on both those categories. The Purchasing Reports and the Inventory Reports are 

discussed in the NS Enterprise Purchasing module manual. 

All Maintenance and Financial reports have the following options available: 

• Screen – displays the formatted report on the screen. Click the OK button to generate the report. 

The report displays on the monitor when it is complete. 

• Printer/Fax – sends the report to the assigned printer. The Print window opens when the report 

is complete to select the printer. 

• File – the field next to the File radio button opens when this option is selected. Click on the 

dropdown menu to select the type of format for the saved report. Click the OK button. The Save 

As window opens to select the directory where the report is to be saved. 

• Email - The Email option allows the user to attach the report to a MS Outlook message. 

 Fleet Level Reports 

The maintenance reports available at the fleet level include information for all ships listed within the NS 

Enterprise system for this organization. All reports are generated from a Reports gadget from both the ship 

and fleet level.  

Select a report from the Reports gadget on the Navigator pane in the Maintenance module. The Report 

Options window opens for user to select report parameters.  

 Standard Job Descriptions Report 

Select Maintenance & Purchasing module → Reports → Maintenance Reports → Standard Job 

Descriptions to open the Report Option window for the Standard Job Descriptions report. 
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The Standard Job Descriptions report provides a complete listing of all job description text in the system. The 

descriptions are listed in alphabetical order by their Job Description Index Term. The text is listed followed 

by a list of the preventive maintenance standard jobs where the text is used.  

Click the radio button to select where the report is to be sent. The options are: Screen, Printer/Fax, File or 

Email. 

 PM Job Statistics Report 

Select Maintenance & Purchasing module → Reports → Maintenance Reports → PM Job Statistics to 

open the Report Option window for the PM Job Statistics report. 
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The PM Job Statistics report provides an analysis of the total number of preventive maintenance jobs, the 

number of those that are overdue and the percentage of the total jobs that are overdue by ship or by fleet within 

a specified time. The ships and time period are selected by the user on the Report Option window. 

This report also includes the ability to exclude the Survey Certificate jobs.  The scheduled date calculation for 

Work orders (if any were rescheduled) will use the scheduled date of the Work Order than the system 

scheduled date. 

1. Click the radio button to select which ships are to be included in the report. “All” is selected by default. 

The Ships field becomes available when the Ships radio button is selected. The dropdown menu on the 

Ship Fleet/Trade field becomes available when the Ship Fleet / Trade radio button is selected.  

 Click the dropdown menu to select the ships or fleets to be included in the report. 

2.  Select the dates to be included in the report by clicking on the dropdown menu on the From Month 

and To Month fields to select the months and clicking the fields following the months to select the 

year. 

3. Click the Include Jobs related to Critical Equipment check box to include the standard jobs that have 

equipment with critical parts. 

4. Click the radio button to select where the report is to be sent. The options are: 

Screen, Printer/Fax, File or Email. 

 

 Fleet Cost Details by Project 

Select Maintenance & Purchasing module → Reports → Other Reports → Fleet Cost Details By Project 

to open the Report Option window for the Fleet Cost Details By Project report. 
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The Fleet Cost Details by Project report provides an analysis of all project costs for the entire fleet by ship. 

Projects are associated with purchasing. See Fleet Cost Details by Project in the Other Reports portion of the 

Reports section of the NS Enterprise Purchasing module manual for details on this report.  

 Warranty Coverage Listing Report 

Select Maintenance & Purchasing module → Reports → Other Reports → Warranty Coverage Listing 

to open the Report Option window for the Warranty Coverage Listing report. 

          

The Warranty Coverage Listing report lists all equipment covered under warranty as of the specified date. 

The report also includes a warranty expiration date.  

Click the radio button to select where the report is to be sent. The options are: 

Screen, Printer/Fax, File or Email. 

 Warranty Expiration Listing Report 

Select Maintenance & Purchasing module → Reports → Other Reports → Warranty Expiration Listing 

to open the Report Option window for the Warranty Expiration Listing report. 



  Nautical Systems Enterprise Maintenance User Manual 

©2020 American Bureau of Shipping and affiliated companies. All rights reserved. This document contains proprietary and confidential information for review and discussion 

purposes only. No part of this document may be used, disclosed, copied, or distributed, by any form or any means, without the express written consent of the American Bureau 

of Shipping.   

       PROPRIETARY AND STRICTLY CONFIDENTIAL. DISTRIBUTION TO THIRD PARTIES IS STRICTLY PROHIBITED.          P a g e  | 317 

            

The Warranty Expiration Listing report lists all equipment whose warranties are in effect as of a specified 

start date but will expire as of the specified end date. The default value for the start date is the current date and 

the default value for the end date is six months from that date.  

Click the radio button to select where the report is to be sent. The options are: Screen, Printer/Fax, File or 

Email. 

 Vendor Certifications Report 

Select Maintenance & Purchasing module → Reports → Other Reports → Vendor Certifications to open 

the Report Option window for the Vendor Certifications report. 
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The Vendor Certifications report displays the certifications of the vendors listed in NS Enterprise. Some 

organizations are required to collect certifications of their vendors, such as “Minority owned”. These 

certifications are listed on the Certificates tab of the Company window for each vendor.  

Click the radio button to select where the report is to be sent. The options are: Screen, Printer/Fax, File or 

Email. 

 Ship Level Reports 

The maintenance reports available at the ship level only include information for that ship. There are two sets of 

reports for maintenance at the ship level. Some are listed under the Maintenance Reports option on the 

Reports gadget on the Navigator pane in the Maintenance module and more are listed under Other Reports.  

All the reports are created from a Reports Option window. This window looks a little different from report to 

report, but the basic procedure is the same.  

Select a report from the Reports gadget on the Navigator pane in the Maintenance module. The Report 

Options window opens.   

Click the radio button to select where this report should be sent. The options are: Screen, Printer/Fax, File or 

Email. 

 Purchasing Reports 

See the Purchasing Manual for more details concerning these reports. 

 Maintenance Reports 

Units with Running Hour Maintenance Report 

Select Maintenance & Purchasing module → Reports → Maintenance Reports → Units with Running 

Hour Maintenance to open the Report Option window for the Units with Running Hour Maintenance 

report. 
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The Units with Running Hour Maintenance report is a listing of all equipment currently included in the 

running hour log.  

Click the radio button to select where the report is to be sent. The options are: Screen, Printer/Fax, File or 

Email. 

 

Surveys by Category Report 

Select Maintenance & Purchasing module → Reports → Maintenance Reports → Surveys by Category 

to open the Report Option window for the Surveys by Category report. 
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The Surveys by Category report lists all the surveys for the ship. It is basically the Update Surveys and 

Certificates window in report form. 

Click the radio button to select where the report is to be sent. The options are: Screen, Printer/Fax, File or 

Email. 

Standard Job Descriptions Report 

Select Maintenance & Purchasing module → Reports → Maintenance Reports → Standard Job 

Descriptions to open the Report Option window for the Standard Job Descriptions report. 

The Standard Job Descriptions report at the ship level is the same as the Standard Job Descriptions report 

at the fleet level except it only provides a listing of job description text for this ship. The descriptions are listed 

in alphabetical order by their Job Description Index Term. The text is listed followed by a list of the preventive 

maintenance standard jobs where the text is used.  

Click the radio button to select where the report is to be sent. The options are: Screen, Printer/Fax, File or 

Email. 

Overdue Jobs Report 

Select Maintenance & Purchasing module → Reports → Maintenance Reports → Overdue Jobs to open 

the Report Option window for the Overdue Jobs report. 

            

On the overdue jobs report at ship level the Deferred status 'D' will display if there is at least one accepted 

deferral. 

The Overdue Jobs report lists the selected job types that are overdue as of a selected date.  

1. Click the check box to select the type of standard jobs to be included on the report. The default selection 

is “All”. Uncheck the check box preceding “All” to open the other check boxes for selection. 
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 Click the check box preceding the jobs to be included on the report. The All check box following the 

selection is checked by default. Uncheck this check box to click the dropdown menu at the end of the field 

to select which types of the selected job type are to be included on the report. 

 Continue making selections until all job types that are to be included on the report are selected. 

2. Click the Calendar button at the end of the Due Cutoff Date field to select the due date of the jobs to 

be included on the report. 

3. Click the radio button to select where the report is to be sent. The options are: Screen, Printer/Fax, 

File or Email. 

 Financial Reports 

See the Financial Report section of this document for more details on these reports. 

Ship Cost Details by 

Account 

The Ship Cost Details by Account report is based on purchase 

orders and service purchase orders and the Ship Actual Cost 

Details report is based on actual costs (invoices). 

Ship Actual Cost Details The Ship Actual Cost Details report is based on the fiscal 

effective dates of the invoices not of the purchase orders and 

includes Invoices, Transfer Orders and Payroll (Overtime) 

information. 

Complete Vessel Cost 

Report 

This report is generated from the Ship view of the Maintenance 

and Purchasing module. The Complete Vessel Cost report is 

used to manage the current workload and material purchases. 

Ship Cost Summary by 

System 

The Ship Cost Summary by System report is a breakdown of the 

actual, estimated, committed and total costs of the purchase 

orders, transfer orders, requisitions, and service requisitions 

within a specified time frame by machinery system 

Open Project Status The Open Project Status report is available at the fleet level with 

the name “Fleet Open Project Status” and at ship level with the 

name “Open Project Status”. 

Accruals as of Date  

 Other Reports 

Ship Cost Details by Project Report 

Select Maintenance & Purchasing module → Reports → Other Reports → Ship Cost Details by Project 

to open the Report Option window for the Ship Cost Details by Project report. 
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The Ship Cost Details by Project report provides an analysis of all project costs for a ship. Projects are 

associated with purchasing. See Ship Cost Details by Project in the Other Reports portion of the Reports 

section of the NS Enterprise Purchasing module manual for details on this report. 

Warranty Coverage Listing Report 

Select Maintenance & Purchasing module → Reports → Other Reports → Warranty Coverage Listing 

to open the Report Option window for the Warranty Coverage Listing report.             

The Warranty Coverage Listing report at the ship level is the same as the one at the fleet level except the 

information only applies to this ship. It lists all equipment covered under warranty as of the specified date. The 

report also includes a warranty expiration date.  

Click the radio button to select where the report is to be sent. The options are: Screen, Printer/Fax, File or 

Email. 

Warranty Expiration Listing Report 

Select Maintenance & Purchasing module → Reports → Other Reports → Warranty Expiration Listing 

to open the Report Option window for the Warranty Expiration Listing report. 

The Warranty Expiration Listing report at the ship level is the same as the one at the fleet level except the 

information only applies to this ship. It lists equipment whose warranties are in effect as of a specified start date 

but will expire as of the specified end date. The default value for the start date is the current date and the default 

value for the end date is six months from that date.   

Click the radio button to select where the report is to be sent. The options are: Screen, Printer/Fax, File or 

Email. 
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 Reliability Centered Maintenance Reports 

The Reliability Centered Maintenance reports are generated from two separate areas: 

• RCM Reports option from the Reports gadget on the Navigator pane at the fleet level in the 

Maintenance module 

• Work Order Search window 

All the reports are created from a Reports Option window. This window looks a little different from report to 

report, but the basic procedure is the same.  

Click the radio button to select where this report should be sent. The options are: Screen, Printer/Fax, File or 

Email. 

 Failure Count by Vessel  

The RCM report created from the Reports gadget on the Navigator pane in the Maintenance module at the 

fleet level is the Failure Count by Vessel report.   

Select Maintenance & Purchasing module → Reports → RCM Reports → Failure Count by Vessel to 

open the Report Option window for the Failure Count by Vessel report.  

                        

The Failure Count by Vessel report displays the number of failures at the selected criticality per fleet within 

the specified dates. The header on the report contains the name of the fleet and the dates included on the report. 

The columns on the report are ship name, ship code, number of failures and total number of failures.  

1. Click the dropdown menu at the end of the Ship Fleet / Trade field to select the fleet or trade to be 

included on the report. 

2. Click on the dropdown menu at the end of the Minimum Criticality field to select the minimum level 

of criticality to be included on the report.  
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3. Click the Calendar buttons in the Date Offline From and To fields to select the date range that the 

vessels were offline for the report. 

4. Click the radio button to select where the report is to be sent. The options are: Screen, Printer/Fax, 

File or Email. 

 RCM Reports from the Work Order Search Window 

There are only two RCM reports on the Work Order Search window and one option to export the failure data. 

RCM reports are only created from work orders, service requisitions or no action jobs that are created because 

of failures. The Failure check box MUST be checked on the work order, service requisition or no action job 

for it to be classified as a failure.  

Select Documents →Search → Work Orders from the Maintenance gadget on the Navigator pane in the 

Maintenance module at either the fleet or ship levels.  

 
NOTE: The RCM reports accessed from the fleet level contain information 

regarding all ships within the fleet. The reports accessed from the ship level 

contain only the information regarding the ship it is accessed from. 

 

The Work Order Search window opens.  

 
NOTE:  The RCM reports generated from the Work Order Search window use the 

results from a work order query to create the reports. A query MUST be run 

before any information is available for the reports.  

 Only the work orders, service requisitions and no action reports with the 

Failure check box checked in the header are used to create the reports. 

 

Click Reports from the Work Order Search window menu bar to view menu options.  

 

 

 

 



  Nautical Systems Enterprise Maintenance User Manual 

©2020 American Bureau of Shipping and affiliated companies. All rights reserved. This document contains proprietary and confidential information for review and discussion 

purposes only. No part of this document may be used, disclosed, copied, or distributed, by any form or any means, without the express written consent of the American Bureau 

of Shipping.   

       PROPRIETARY AND STRICTLY CONFIDENTIAL. DISTRIBUTION TO THIRD PARTIES IS STRICTLY PROHIBITED.          P a g e  | 325 

Equipment Failure Report 

The Equipment Failure report displays work orders and service requisitions created because of an equipment 

failure listed in the work order query results. The report columns include the ship name, work order / service 

requisition number, system and equipment that failed, failure cause, failure mode, date offline and when it was 

back in service.   

 

Click the radio button to select where the report is to be sent. The options are: Screen, Printer/Fax, File or 

Email. 

 

Export Failure Data 

The Export Failure Data option is not a report. It offers the option to export failure data from the work order 

query to an Excel spreadsheet. An Export window opens when this option is selected from the Work Order 

Search window. 

Click the dropdown menu at the end of the Select Output File field to open the Save window.  

 

Type the path/file name of the .xls file where the information is to be exported in the File Name field on the 

Save window. 
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Click the Save button to close the Save window and copy the name of the file to the Select Output File field 

on the Export window. 

Click the OK button on the Export window to start the export process. An Export Progress window opens 

displaying the progression of the export process.  

 

A Notepad window opens when the process is complete displaying the Export_Failure_Data.log. This log 

describes whether the export process was successful and what problems, if any, were encountered. 

Locate the .xls or .xlsx file from where it was saved to open the Excel spreadsheet with the failure data.  

 

Mean Time to Repair Report 

The Mean Time to Repair report displays the mean time to repair a failure on systems and equipment from the 

work order query results. The mean time to repair is defined as the ratio between the cumulative time to repair 

and the number of failures over the period of time selected by the user. This period of time is selected on the 

Failure Data tab of the Work Order window.  
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The report columns include the ship name, system and equipment that failed, failure cause, criticality, and mean 

time to repair. 

Click the radio button to select where the report is to be sent. The options are: Screen, Printer/Fax, File or 

Email. 

 

WO/NAJ/SR Form 

Perform the WO search and tag a workorder in order to obtain a report for this. The report simply shows the 

Workorder/Service Requisition Form. 

 

Click the radio button to select where the report is to be sent. The options are: Screen, Printer/Fax, File or 

Email. 
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 Maintenance Plan Reports 

There are several maintenance-related reports found in the Maintenance Plan window. These are found in 

Reports from the menu bar. This is at Ship Level and will only show report information related to the ship. 

 

Menu option: 

Reports→ 

The Reports menu contains options to generate different types of reports.  

Any report selected opens the Report Options window. Click the radio button 

to select where this report should be sent. The options are: 

• Screen – displays the formatted report on the screen. Click the OK 

button to generate the report. The report displays on the monitor when 

it is complete. 

• Printer/Fax – sends the report to the assigned printer. The Print 

window opens when the report is complete to select the printer. 

• File – the field next to the File radio button opens when this option is 

selected. Click on the dropdown menu to select the type of format for 

the saved report. Click the OK button. The Save As window opens to 

select the directory where the report is to be saved. 

• Email - The Email option allows the user to attach the report to a MS 

Outlook message 

        Summary The Summary option is a report that displays the information on the 

Maintenance Plan window in report form for all tagged jobs. 

        Work    

        Specifications 

The Work Specifications option is a report displaying specifics about each 

tagged job. These specifics include the job category and job title. 

        Detail Format The Detail Format option is a detailed report on all tagged jobs. 

 Materials  

 Requirements 
 

The Materials Requirements option is a summary report of all the materials 

required for the tagged jobs.  

        Material     

        Shortages 

The Material Shortages option is a summary report of material shortages of 

the tagged jobs. The shortages are calculated by compiling the job material 

requirements and then subtracting the available inventory levels.  
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        Materials Usage The Materials Usage option is a summary report of all the materials used in 

the tagged jobs.  

        Monthly  

        Maintenance 

The Monthly Maintenance option is a report displaying the maintenance that 

is due for the next month.  

Cost Report – Labor 

Cost Actual/Forecast 

On the Maintenance Plan:  This report displays the crew labor cost, vendor 

cost, and the total cost for various documents like SO, SR, WO, SJ for both the 

actual labor cost and forecasted costs 

Cost Report – Parts 

Cost Actual/Forecast 

On the Maintenance Plan:  This report allows users to more efficiently forecast 

parts requirements for upcoming maintenance or report the cost of parts 

consumed for completed maintenance. 

 Inventory Reports 

The following Inventory reports are at ship level.  See the Purchasing User Manual for more details on these 

reports. 

Equipment Particulars 
The Equipment Particulars report prints the details about each piece of 

equipment listed in the hierarchy. This report also includes the names of the 

systems with all equipment within that system listed below it. 

Equipment Hierarchy 
The Equipment Hierarchy report is a condensed version of the Equipment 

Particulars report. This report only lists the systems, the equipment in those 

systems, descriptions, bar code, ID code, model number, serial number, and 

manufacturer. 

Spares List by 

Equipment 

The Spares List by Equipment report lists the total inventory of the ship. 

Spares List by Location 
The Spares List by Location report is the same as the Spares List by 

Equipment report except that the report is divided by storage locations instead 

of equipment. 

Ship’s Storage Locations 
The Ship’s Storage Locations report lists all the defined storage locations on 

the ship and their ID codes 

Inventory Adjustment 
The Inventory Adjustment report lists all adjustments to inventory, additions, 

and usage, between specified dates. This includes reconciliations, work orders, 

transfer orders and purchase orders. 

Inventory Cost 
The Inventory Cost report lists the ship inventory with the available cost data. 

This includes the part name, description, location, unit price and extended 

price. 

Quick Inventory Cost 
The Quick Inventory Cost report is the summary that is provided on the 

Inventory Cost report. This is a summary of the total cost of all items on the 

Inventory Cost report, number of items on that report, the date the Quick 

Inventory Cost report was created, and the inventory valuation method used 
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Inventory Items with no 

Price 

The Inventory Items with no Price report lists all the parts that contain no 

price data 

Shelf Life Expiration 

Listing 

The Shelf Life Expiration Listing report lists the maintained parts whose 

expiration dates are reached as of the specified date on the Report Options 

window 

SI Inventory Cost 
 

Parts Manual by 

Equipment (in standard, 

barcode, or extended 

format) 

The Parts Manual by Equipment report lists all parts and/or consumable 

items included in the ship’s hierarchy regardless of whether they have 

inventory records 
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Section 20 Financial Reports for Budgeting Purposes 

NS Enterprise has the capability to create financial reports for budgeting purposes. This analysis provides 

management with a real time view of expenditures over any user-specified time period. It also allows budgets 

to be established for each applicable combination of vessel and account. These reports relate to the development 

and analysis of data for the purpose of evaluating performance, internal planning and decision making.  

Most of the financial reports are on the fleet level for a financial “snapshot” of all vessels; however, there are a 

few that are at the ship level. All these reports are generated from the Maintenance and Purchasing modules. 

There are two types of financial reports on the fleet level – Accounts Payable reports and Financial reports.  

See the Purchasing User Manual for more details on these reports. 
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Section 21 Miscellaneous Items 

 Reports – Machinery Health 

Below tables explain the items/fields found in the Equipment View and Report View tabs in Section 7.2 – 

Machinery Health 

Reports→ The Reports menu is available at ship level and contains reports that are 

associated with condition monitoring. 

Any report selected opens the Report Options window. Click the radio button 

to select where this report should be sent. The options are: 

• Screen – displays the formatted report on the screen. Click the OK 

button to generate the report. The report displays on the monitor when 

it is complete. 

• Printer/Fax – sends the report to the assigned printer. The Print 

window opens when the report is complete to select the printer. 

• File – the field next to the File radio button opens when this option is 

selected. Click on the dropdown menu to select the type of format for 

the saved report. Click the OK button. The Save As window opens to 

select the directory where the report is to be saved. 

• Email -- The Email option allows the user to attach the report to a MS 

Outlook message 
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Planned 

Maintenance 
 

The Planned Maintenance report lists standard jobs that were completed, 

unscheduled work orders and failure work orders for all equipment for a 

specified time frame.  

The other fields on this Report Option window are: 

• Options – click on the dropdown menu to select a pre-defined time 

frame for the report. The Last Year option has the current date in the 

End Date field and the same date from the previous year in the Start 

Date field. The Last Report option displays the date of the last report 

in the Start Date and End Date fields. Select the Custom Date option 

to select the time frame of the report.  

• Start Date / End Date – click the Calendar buttons at the end of these 

fields to select a custom date for the report. The Options field changes 

depending on the dates selected. 

• Detail Report check box – click the Detail Report check box to include 

more detailed information from the documents included on this report. 

This information includes the document number, date completed, 

description of the maintenance and information from the Findings tab.   

• Summary Report check box – click the Summary Report check box 

to only include a summary of the maintenance completed for the 

specified time frame. This information includes only the number of 

standard jobs completed, unscheduled work orders and failure work 

orders.  

• Class Item 

• Non-Class Item 

• All CM Equipment checkbox – click the All CM Equipment 

checkbox to include all equipment for the vessel within the selected time 

frame in the report.  
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Condition 

Monitoring 

The Condition Monitoring report is a summary of all condition monitoring 

reports for a specified time frame. The other fields on this Report Option 

window are: 

• Options – refer to the Planned Maintenance description in the previous 

page. 

• Start Date / End Date – refer to the Planned Maintenance description 

in the previous page. 

• Detail Report check box – refer to the Planned Maintenance 

description in the previous page. 

• Summary Report check box – refer to the Planned Maintenance 

description in the previous page. 

• Class Item checkbox 

• Non-Class item checkbox 

• All checkbox - refer to the Planned Maintenance description in the 

previous page. 

• CM Equipment - refer to the Planned Maintenance description in the 

previous page. 

 



  Nautical Systems Enterprise Maintenance User Manual 

©2020 American Bureau of Shipping and affiliated companies. All rights reserved. This document contains proprietary and confidential information for review and discussion 

purposes only. No part of this document may be used, disclosed, copied, or distributed, by any form or any means, without the express written consent of the American Bureau 

of Shipping.   

       PROPRIETARY AND STRICTLY CONFIDENTIAL. DISTRIBUTION TO THIRD PARTIES IS STRICTLY PROHIBITED.          P a g e  | 335 

 CBM Summary The CBM Summary report contains the same information as the Condition 

Monitoring report except that the CBM Summary report can be customized. 

The fields on this Report Option window are: 

• Source options – click the radio button to include the condition reports 

from vendors, crew members or both.  

• Class Item checkbox 

• Non-Class Item checkbox 

CM Vendor – The All check box preceding the CM Vendor field is clicked 

by default to include reports from all condition monitoring analysts in the 

report. The CM Vendor field becomes available when the All check box is 

unchecked. Click the dropdown menu at the end of the field to select the 

vendors to be included on the report. The Companies List window opens. 

Click the Search tab. The condition monitoring company type is 

automatically listed in the Company Type field.  Click the Search button. 

Companies with that company type are listed in the query results. Click the 

check box preceding the vendors to be included on the report. Click the 

Select button on the company list toolbar to close the list window and add 

the selections to the CM Vendor field.  

CM Type - The All check box preceding the CM Type field is clicked by 

default to include all condition monitoring types in the report. The CM Type 

field becomes available when the All check box is unchecked. Click the 

dropdown menu at the end of the field to select the monitoring types to be 

included on the report. The Condition Monitoring Type Selection window 

opens with a list of monitoring types. Double click on a type to move it from 

the left side of the window to the right. More than one selection can be made. 

Click the OK button to close the Condition Monitoring Type Selection 

window and add the selections to the CM Type field.  
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CBM Summary  

continued 

CM Report - The All check box preceding the CM Report field is clicked 

by default to include all condition monitoring reports in the report. The CM 

Report field becomes available when the All check box is unchecked. Click 

the dropdown menu at the end of the field to select the report to be included 

on the report. The Condition Monitoring Report window opens with a list 

of monitoring reports. Double click on a report to close the list window and 

add the selection to the CM Report field.  

CM Equipment - The All check box preceding the CM Equipment field 

is clicked by default to include all condition monitoring equipment in the 

report. The CM Equipment field becomes available when the All check 

box is unchecked. Click the dropdown menu at the end of the field to select 

the monitoring equipment to be included on the report. The Equipment 

Explorer window opens.  

 
NOTE:  Only equipment that is set up as condition monitored is 

available from this window. under the Equipment Window in the 

Add or Edit Equipment in the Equipment Explorer portion of 

the Hierarchy section of this manual for details.    

Click the plus sign (+) preceding each system to display the equipment 

under the system. Click the check box for all equipment to be included 

in the query. Click the Select button to close the Equipment Explorer 

window and add the selections to the CM Equipment field. 

Period Options – click on the dropdown menu to select a pre-defined time 

frame for the report.  

 

The current date is entered in the End Date field and the date in the Start Date 

field is determined by the selection made in the field. Select the Custom Date 

option to select the time frame of the report.  Start Date / End Date – click the 

Calendar buttons at the end of these fields to select a custom date for the report. 

The Options field changes depending on the dates selected.  
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CBM Summary  

continued 

 

 File Attachments Tab 

The File Attachments tab is used to add attachments to any NS document. Attachments can be any type of file 

including documentation, drawings, or spreadsheets. The File Attachments label on the tab turns blue and an 

icon is present when entries are made on the tab. 

The File Attachments tab is universal to most NS Documents. Any kind of file can be attached to the 

documents in NS application through the File Attachments tab. 

1. Right-click on the File Attachment field and select the action OR click Attachment from the menu bar 

and select the action. 

 

• To Attach, select Attach from the actions. A folder where the user can select a file will be shown on 

screen. Select the file and click Link button. 
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• To Open, select the file from the File Attachment tab, right-click on the file and select Open. 

 

• To Delete, select the file from the File Attachment tab, right-click on the file and select Delete. 

 

• A Proceed to delete attachment confirmation message will be shown on screen, select Yes. 
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 Custom Forms Tab 

The Custom Forms tab allows users to Open, Import, Export and Open in Adobe, import, link/unlink a Custom 

Form template to the document. 

1. Right-click on the Custom Forms field and select the action OR click Custom Forms from the menu bar 

and select Link Template. 

 

2. The Custom Forms window will appear on screen. Tick the box preceding the template and click Select 

icon from the toolbar. 

 

3. A confirmation message will appear, click Ok. 

 

4. To Unlink, follow the steps in Linking Template, but this time, Untick the box preceding the template. 

5. To Open, select the template from the Custom Forms tab. Right-click and select Open to open the file. 
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2. To Export, select the template from the Custom Forms tab. Right-click and select Export. 

 

a. The Export window will appear on screen. Select Output File from the dropdown menu. 

 

b. The Select Location window will appear on screen. Select the location where the file to export will 

be saved. Click Save to close the window. 
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c. Click Ok. 

 

3. To Import, select the template from the Custom Forms tab. Right-click and select Import. 

a. The Import window will appear on screen. Select Input File from the dropdown menu. 
 

 

b. The Select Location window will appear on screen. Select the location where the file to import is 

located. Click Open to close the window. 

 

c. Click Ok. 
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4. To Relog, select the template from the Custom Forms tab. Right-click and select Relog. 

 

 Resources Tab 

The Resources tab on the Standard Job window has the information from the Resources Required tab when 

the standard job was created. This information can be changed by authorized users. 

Click the Resources tab.  Enter the man hours actually used for this work.  Users can add additional resources 

or deselect resources that were originally designated. 

It is important to enter the man hours used, as this helps in planning future work, provides more valuable 

maintenance history, and allows for better budget forecasting. 
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 Messages Tab 

The Messages tab is a type of email system. It provides a way to send messages between users in reference to 

the piece of equipment. It is different from a regular email system because it is specific to NS Enterprise and 

the section from which the message is created. A message from this equipment Message tab can only be 

retrieved from the same equipment Message tab by the recipient. 

1. Right-click on the Message field and select the action OR click Messages from the menu bar and select 

the action. 

 

2. For New Message, select New Message from the options. Message-New window will be shown on screen.  

a. Click To button. User/User Role window will appear on screen. Tick the box preceding the name 

of the recipient and click Select button. 

 

b. Enter the Subject. Enter the body of the message in the space provided. 
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c. Click Send icon. 

 

 

3. To Open Message, select the message from the Message tab. Right-click and select Open Message. 
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4. To Print Msg List, select Print Msg List. 

 

a. The Report Option window will appear. Tick the radio button of the preferred option, then click 

Ok. 

 

5. To Print Msg, select Print Msg. 

 

a. The Report Option window will appear. Tick the radio button of the preferred option, then click 

Ok. 
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 Miscellaneous Work Tab 

The Miscellaneous Work tab lists all miscellaneous standard jobs. The miscellaneous standard job is a type of 

standard job. It is work of a general nature such as painting, sandblasting or anode replacement that is not 

associated with a specifically identifiable item on the ship like a piece of equipment or space. However, 

miscellaneous work can be cross-referenced with multiple items such as equipment or space so that when the 

standard job is completed, these areas are automatically updated with maintenance history. The job schedule 

can only be based on calendar interval.  

 

The fields on the Miscellaneous Work tab are: 

• Ship Name – The name of the ship  

• Job Name – The job title on the miscellaneous standard job 

• Dormant – The job status. A “No” indicates that the job is active. 

• Last Done – The date of the last time the job was performed 

• Interval – The time frame between when the job was last performed until the next time it needs to 

be performed. 

Double click the standard job in the Miscellaneous Work tab and it opens. Only authorized users can enter or 

change information on the Standard Job window. 

 Materials Tab 

b. On the Materials tab, right-click on the field and choose New Required Item. 

• This opens an Equipment Explorer window in the Purchasing view.  The Purchasing View 

displays the spares for that equipment if there is equipment connected. The list starts at the top 

of the hierarchy if no equipment is connected. 

c. Update the quantity of the spares required to complete the job. 

• The item the user linked is listed in the Required/Used section of the Materials tab, as well as 

the current inventory level. 

If necessary, create a requisition linked to the WO from the Materials tab for any missing items. See Creating 

a Requisition from a Work Order in the Purchasing User Manual. 
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 DMS Link Tab 

The DMS Link tab is used to attach documents from the Document Management System (DMS) module to 

any document in NS that requires it. The Document Management System module is one of the web-based 

modules in NS Enterprise. It is used to store, organize, and track electronic documents and images. These 

documents can then be linked to equipment and documents within NS Enterprise. 

 

It is important to ensure that the DMS web app configuration has the correct server and IP address. 

1. To attach a document from the DMS Module, click DMS Link from the Menu bar and select Link DMS 

or right-click on the DMS Link tab and select Link DMS. 

 

           

 

NOTE: The DMS Link tab is only available if the Document Management System module is   part 

of your company's NS suite of modules. 
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2. The DMS Document Hierarchy window will be shown on screen. 

 

3. Navigate through the folders until the document to be linked is located. 

4. Click the check box preceding the documents to be linked. 

5. Click the Select button to close the Document Management System window and add the  

      selections to the DMS Link tab. 

 

Unlink a Document 

1. Highlight a document on the DMS Link tab.  

2. Click Unlink button from the Menu bar and select Unlink. User may also right-click on the DMS Link 

and select Unlink. Process is the same as in linking a document, but this time, user will uncheck the box 

to unlink the document. 

 

 

 
 
 

 


